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1 Introduction
1.1 What is Ham Radio Deluxe
Ham Radio Deluxe (HRD) is an integrated suite of software products for amateur radio. The five modules in the suite provide rig control,
logging, digital communications, satellite tracking, and rotator control.

1.1.1 Rig Control

Ham Radio Deluxe Rig Control provides rig control through a richly featured full screen interface and other products in the Ham Radio
Deluxe Suite via a direct connection or TCP/IP remote access.

1.1.2 Logbook

Ham Radio Deluxe Logbook provides QSO logging, DX cluster connectivity, callsign lookup, awards tracking (with integration to LoTW,
eQSL, and Ham Radio Deluxelog.net), and contesting. Microsoft Access and MySQL are support with strong features for backup and
recovery.

1.1.3 Digital Master (DM-780)

DM-780 provides most popular sound card digital modes with direct integration to Ham Radio Deluxe Logbook.

1.1.4 Satellite Tracking

Ham Radio Deluxe Satellite Tracking provides satellite operations with rig control and Google Earth integration.

1.1.5 Rotor Control

Ham Radio Deluxe Rotator provides control for 15 popular models of antenna rotators.

1.2 How it all began
In early 2003 Peter Halpin (PH1PH) and Simon Brown (HB9DRV) talked about developing a simple program to control the soon to be
released ICOM IC-703.

Maybe it was the beer, maybe the desire to give something back to the radio amateur community, however on June 6th, 2003 the first
line of code was written, Ham Radio Deluxe (Ham Radio Deluxe) was born.

By late 2005 the number of registered users stood at 20,006 ? quite an achievement in such a short time.

1.3 This Guide
If you are only going to read one more section, then now go to Getting Started.

Please report errors and omissions in the Ham Radio Deluxe forums:

https://forums.ham-radio-deluxe.com

When you get there, select Headquarters>Documentaton.

As this guide matures further it may flow differently than it currently does. Please check the table of contents for the new evolving layout.
Note that this document has some sections that are still in DRAFT mode which means that it can have lots of old or wrong information.

1.4 System Requirements
1.4.1 Computer

Ham Radio Deluxe will run on any version of Windows supported by Microsoft that meet the minimum hardware specifications provided
by Microsoft.

A link to that information can be found here:

https://www.ham-radio-deluxe.com/support/requirements

1.4.2 Supported Radios

The list of supported radios for Ham Radio Deluxe can be found here:

https://www.ham-radio-deluxe.com/features/rigcontrol/radios.html

1.4.3 Internet Connection

Not absolutely required but really is essential to fully utilize all the features. The best connection is a full time connection such as cable
or DSL. Registering the program is much easier when done online.
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1.4.4 Radio Interfacing

Ham Radio Deluxe is designed to be used with one of the rigs listed above. Some modules, however, can be used without a connection
to a rig. Logging will work but will not be as automated. Satellite tracking is still fun without a rig connected. In fact, there are only a few
of the above listed rigs that ?really? work fully with the satellite module.

Some of the rigs listed above do not fully avail themselves to all the features of Ham Radio Deluxe. A number of the rigs do not provide
Tx control easily. That is the limit of the rig, not Ham Radio Deluxe.

For CAT control, all radios require some sort of SERIAL connection between the radio and the computer. Some of the newer model
radios are equipped with a USB port on the back of the radio. All that is needed there is a USB cable from the radio to a USB port on the
computer.

Other radios have a standard DB9 serial port on the back which either connects directly to a DB9 Serial port connector on the back of
the computer or through a Serial/USB converter to a USB connector the computer, while others connect from an ACC or DATA plug on
the back of the radio through a Serial/USB converter to the computer.

Many of these cables use the serial port. If you don?t have a serial port all is not lost ? USB serial converters are widely available. Also,
there are options available that are USB based.

One of these is HamLinkUSB from Timewave. This will allow rig control with most of the radios listed above.

Note: If you need a Serial/USB converter be specially aware of the type of chips and drivers that are in the converter you
choose. We recommend ONLY converters with FTDI or SI Labs chipsets and drivers. We have found these to preform
exceptionally well with HRD and other radio related software.

Beware of Prolific chipsets and drivers. There are many of these on the market which are counterfeit and the chipsets are of
poor quality. The drivers are also poorly written and will not work properly with HRD, especially if trying to use them on a
Windows 7 or 8 system.

Some of the problems you may experience with these chipsets and drivers are system crashes, BSOD, program lock-ups,
drivers won't install properly, comports disappear for no reason, just to name a few.

If in doubt as to what you need to connect your radio to the computer running Ham Radio Deluxe, contact
support@hrdsoftwarellc.com or Timewave either through their website at www.timewave.com or phone them at
1-651-489-5080. They can provide you with cables and connectors to meet your needs.

The future trend in radio control and interfacing is the USB connection. More and more radios will only have USB ports and not Serial or
Parallel ports. The USB port will even pass audio as rig control with a few of the radios.

For the majority of the radios listed above, you will need to have a more robust interface if you need to send or receive audio. The audio
recorder and PSK31 are two examples of this need.

For more interfacing information visit the Downloads page at https://www.ham-radio-deluxe.com for A basic guide to CAT and Audio
interfacing which contains many designs for both CAT and audio interfaces for use with Ham Radio Deluxe.

Check out the cable and interface solutions from:

Timewave http://www.timewave.com• 
Tigertronics http://www.tigertronics.com• 
ZLP Electronics http://g4zlp.ham-radio.ch• 
West Mountain Radio http://www.westmountainradio.com• 

1.4.5 Public Interfaces

Other (non-Ham Radio Deluxe) programs are supported via a DDE interface (see DDE Support) and a serial port (see 3rd-Party
Programs).

Logbooks typically use these interfaces; for example - contest-oriented logbooks.

1.5 Installation
Ham Radio Deluxe is designed to run on the 32-bit or 64-bit versions of Windows Vista, Windows 7, Windows 8, and Windows 10.
Internet Explorer 6.0 (or higher) is required. Ham Radio Deluxe is supported on Windows versions which are supported by Microsoft.

The Logbook uses MS Access by default or you can use MySQL, see Database for more information.

Ham Radio Deluxe can be installed in under a minute. Special knowledge is not needed ? the kit does everything for you!

You will not need to reboot your computer, Ham Radio Deluxe does not update your system files or change your system?s configuration
in any way.

You may or may not see the following screen depending upon the update status of your machine.
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You will see this or an updated version of this screen to get you started with the installation.
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When you start the installation the first screen shows the release and build you are installing.
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You must accept the licensing conditions.
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Select the folder where Ham Radio Deluxe will be installed, the suggested default is usually sufficient.
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Select the folder in the Start menu where the Ham Radio Deluxe entries will be added, the suggested default is usually sufficient.
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Click Install to start the installation.
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The progress of the installation is shown while the software is being installed.
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When the software has been installed select the programs to be started, then press Finish.

1.6 First Steps
1.6.1 Product Activation

Ham Radio Deluxe has an improved registration system. The following instructions should get you up and running without any problems.

When you first start Ham Radio Deluxe you will be presented with the following welcome screen.
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Pressing Next at this screen will continue on with the registration process.
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This screen asks for your call sign. Enter ONLY your assigned call sign. Do not enter any prefix such as KR6/N4XXX or modifiers like /P
or /?.

After you have entered your call sign press Next.
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If you purchased Ham Radio Deluxe from a distributor and received a CD or if you purchased online and were sent a key, here is where
you enter the 16 character Main Activation Key. The activation key may be copied and pasted from the e-mail you received to avoid any
mistakes in entering. Just highlight the entire purchase key in the e-mail, right click and select Copy. Place your cursor in the first box of
the above screen, right click and click Paste. Once the key is entered, press Next.

If you do not have a Activation Key and would like to continue with the 30-day trial subscription, just press the Next button when you
reach this screen.

Note: If you already have a registered subscription and are installing Ham Radio Deluxe on a second computer or re-installing
Ham Radio Deluxe for any reason, entering your call sign in step 1 and just clicking next on the above screen will also bring
up the following screen. However, when you click Finish it will automatically change to a full registered version.
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If running the 30-day trial you will now see the above screen.

14

http://wiki.ham-radio-deluxe.com/index.php/File:Page-25-Image-13.png


If you entered a activation key you will now see the above screen with your callsign and activation key. Just click the Finish button to
continue to the next screen.
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Those who have purchased the software with the support will see a screen like this, showing your call sign, telling you that you have a
Subscription License and indicating the expiration date.

Those running the Trial version will see their call sign, Trial License, and an expiration date 30 days from the date installed on your
computer. At this screen, just click on the Continue button at the bottom of the screen to continue on to the Rig Control setup screen.

If you have any problems or questions about the registration please contact support either by phone at (813) 434-4667 or send an e-mail
to support@hrdsoftwarellc.com

1.6.2 Connection

You can dive into Ham Radio Deluxe using a demo radio or your radio. A good way to explore the program is with a demo radio first and
then connect your rig.

1.6.2.1 Demo-o-matic Radio

Now that you have installed Ham Radio Deluxe you can try it out using a Dem-omatic radio. This is a reasonably accurate simulation of
the real thing, designed for use during presentations and while developing Ham Radio Deluxe when a radio is not available (on the train,
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in a plane, in an airport, stuck in a hotel room in Finland etc.).

From the Start menu select Programs > Ham Radio Deluxe. Once the splash screen has closed you see the Connect window. If you do
not have the correct connection cable, select one of the Dem-o-matic radios so that you can open Ham Radio Deluxe.

1.6.2.2 Dem-o-matic

The Dem-o-matic radios do not need cables ? simply select Dem-o-matic in the Company drop down, select an option in the Radio drop
down, and then press Connect.

They are ideal for demonstrating Ham Radio Deluxe when you do not have a suitable radio available. It is also the only way that you can
open Ham Radio Deluxe if you do not have a supported radio or the correct connecting cable.

1.6.2.3 Your Radio

TIP: Read your radio's manual to find out exactly how it is supposed to be connected to a computer for CAT control. Some radios
require special drivers to be loaded in the computer to access certain model radios. These drivers can usually be downloaded from the
manufacturers website. All this information is in your radios user manual or from the radio's manufacturers tech support system.

Please refer to See ?Radio Interfacing? on page 3. to review the requirements for Ham Radio Deluxe interfacing.

1.6.3 Configuration Options

To connect your radio you will need to connect the necessary cables and install drives if needed. You must also do some configuring
within Ham Radio Deluxe. This is usually a one time exercise.

Once you have all your cables in place it's time to turn on your radio, boot up your computer and start Ham Radio Deluxe. The next
screen you should see is the radio connection setup screen. This is where you select your radio and set some parameters to allow the
Ham Radio Deluxe Rig Control software to connect to your radio.

1.6.3.1 The New Tab
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Notice there are four tabs at the top of this display. The one currently showing is the NEW tab. This is where you configure the setup for
any new radio you want to connect to the Ham Radio Deluxe software. We will continue with this setup in the next section.

This is where you actually configure how Ham Radio Deluxe connects to your radio. It also allows you to configure what modules Ham
Radio Deluxe loads, by default, on start-up.

1.6.3.2 The Preset Tab

18

http://wiki.ham-radio-deluxe.com/index.php/File:Page-28-Image-17.png


Once you have a radio configured properly and it starts from the NEW window, the configuration is saved in the Preset page. As you can
see here, there are several radios configured both real ones and demo-o-matic ones.

1.6.3.3 Serial Ports Tab
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The Serial Ports tab displays all the comports available on your computer. You will notice just below the window near the center it has
two radio buttons. One says Show All ports and the other says Only ports connected to PC. These buttons come in handy when you are
trying to figure out which ports are actually being used by the Ham Radio Deluxe Software and which are just available for use.

1.6.3.4 The Connection Process

Each radio must be on a different comm port from the computer. This allows you to actually operate two or more radios at the same time
and switch between them with a couple clicks of the mouse. We will also show that in another section of this manual.

If you have a radio configured in this screen which you no longer own or have connected to Ham Radio Deluxe, you can easily remove it
from the Presets by clicking on the setup line in the display window, to highlight the unwanted configuration, and click on the "X
Remove" located on the left just below the slider near the left center of the dialog box.

1.6.3.4.1 Manufacturer

Select your radio manufacturer from the drop-down list. The Dem-o-Matic radios do not require a COM port, they are for demonstrating
Ham Radio Deluxe when you do not have a suitable radio available.

FlexRadio: you must install the vCOM virtual serial port drivers from Philip Covington (N8VB). These are used to provide the connection
between Ham Radio Deluxe and the PowerSDR software that must be running before you try to create the connection with Ham Radio
Deluxe.

Note: It seems that vCOM will not run on Vista/Windows 7 64bit because the 64-bit version is very insistent on having signed
drivers. A signed 64 bit versions might be available for a few dollars from VSPE. More information is available from
http://www.flex- radio.com/, to install the vCOM drivers see N8VB vCOM.
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ICOM: disable the CI-V Transceive option for best performance.

Kenwood: make sure Packet communication mode is switched OFF (if supported). Most Kenwood radios require CTS and RTS to be
ON for flow control.

1.6.3.4.2 Radio

Select your radio model from the drop-down list.
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If your radio does not appear in this drop-down list there is a chance it can be supported by the commands of a different model from the
same manufacturer. Contact HRD Support or the manufacturer of your radio for information on about compatibility with another models
firmware CAT command set.

1.6.3.4.3 COM Port
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The COM port on this computer where you have connected the radio interface cable. Make sure that you do not have other programs
using the same port, for example mobile phones and personal organizers. It is recommended you NOT use the Auto-Detect. The
Auto-Detect can sometimes fail to detect the port. To see the COM ports on your computer select the Serial Port tab to see a display.

1.6.3.4.4 COM Port Speed

The speed used for communicating with the radio, check the speed setting via the radio's configuration menu. Again, it?s not
recommended to use the Auto-Detect. Also remember that ?FASTER IS NOT ALWAYS BETTER?. Sometimes faster speeds can cause
timing problems when sending commands back and forth between Ham Radio Deluxe and the radio. The important thing is that you set
the speed in Ham Radio Deluxe and the port speed in the radio the same. Check your radio manual to find out how to set the com port
speed. A 4800 baud connect speed is normally plenty fast enough to support most radios.

1.6.3.4.5 CI-V Address

ICOM only: the address assigned to the radio, consult the radio's documentation for the default address. This can also be configured via
the radio's configuration menu.

1.6.3.4.6 CTS

Enables the CTS flow control, required for Kenwood radios.

1.6.3.4.7 DTR

Enables the DTR line when the COM Port is opened and leaves it on, usually to provide power for an interface cable. For Yaesu CT-62
and ICOM CT-17 interfaces this can be left unchecked (off).

1.6.3.4.8 RTS

Enables the RTS line when the COM Port is opened and leaves it on, usually to provide power for an interface cable. For Yaesu CT-62
and ICOM CT-17 interfaces this can be left unchecked (off).

Next, put a check in the boxes for DTR and RTS. Some radios don?t require both of these settings checked so they can be unchecked if
there is a failure to connect to the radio.
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Note: If you will be connecting more than one radio to Ham Radio Deluxe and you would like the current one to be the default
radio, place a check in the box where it says ?Always connect to this radio when starting HRD Rig Control?.

1.6.3.5 Connecting

Press Connect to connect to the radio. If you see the error below then the COM port is currently held open by another program or the
radio is not turned on.

Check that you have not started another radio control program. Other culprits are PDA and mobile phone connections. Even if you have
disconnected a device from a COM port you must make sure that the software is no longer running.

Once connected Ham Radio Deluxe reads the radio?s frequency to ensure that the options you selected are correct. If you see the error
below then Ham Radio Deluxe failed to read the radio?s frequency:

If Ham Radio Deluxe can read the frequency the Connect window is replaced with the main radio display ? you are now using Ham
Radio Deluxe!

If Ham Radio Deluxe cannot read the frequency then check:

Correct COM port is selected,• 
Speed on radio is the same as the speed selected in Ham Radio Deluxe,• 
Your cable ? you may have a NULL modem cable when a normal serial cable is needed,• 
Cable is connected correctly to your PC (you may have more than one COM port),• 
DTR / RTS are selected if required to power an active cable such as CT-62 or a cable from third-party provider.• 

If you still can?t get started refer to:

Command Tester, and• 
Portmon.• 

1.6.4 Icom CI-V Details

1.6.4.1 Icom's CI-V Protocol

ICOM's CI-V protocol is based on a relatively simple bi-directional, single-wire TTL level signaling system. The single wire consists of a
communications line (DATA) and a ground reference (GND). The DATA line is held high when there is no traffic. As long as the DATA
line is high, any device can initiate communication by pulling the line low and sending the Icom attention command (FEFE). When the
line goes low, the other devices see this as a BUSY indication, allowing the single DATA line to offer some amount of basic flow control.
Multiple devices may connected across the CI-V port in parallel, as long as each device is set up with a unique hex address. All in all, it's
quite elegant in it's simplicity.

1.6.4.2 Default Icom CI-V Addresses

Each Icom model has its own, distinct default address. As a general rule, Icom used only even addresses ($02, $04, $06 ...). Each
model was given a new default address when it came out. The user can change the default address if required. On older rigs this was
done by (re-) soldering some diodes, on newer rigs the address can be changed by setup through the front panel or even by CI-V
commands. Addresses can be selected from $01 to $EF, giving 239 distinct addresses. The following is a nearly complete table of all
known addresses from CI-V capable rigs, not only by Icom.

<insert table>
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1.7 What's Next
It is time to play a little Ham Radio Deluxe to see what it does. Even if you can connect to a radio, let?s start by connecting to a
Kenwood TS-2000 through Demo- matic.

1.7.1 Appearance

You should now have something that looks like the display below. The Rig Control Display (GUI) is a generic representation of an HF
radio's front panel. It contains most of the operating functions and controls of the actual radio it is connected to. This display does not in
any way and can not be made to actually depict the front control panel of your actual radio.

Below is a screen shot of the Rig Control Display representing a Kenwood TS-2000 all band, all mode radio.

This is the default appearance for Ham Radio Deluxe. For the sake of quality documentation we will change the appearance to LCD
which is a reverse of what we now see.

1.7.2 Multiple Radios

HRD has the capabilities to display an operate multiple radios from one screen. In the image below we see a Kenwood TS-480
displayed and controlled by the top pane while a Kenwood TS-2000 is being displayed and operated from the bottom pane.

Each radio can be accessed and operated with just a few clicks of the mouse button.
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Each radio must have it's own dedicated COM port on the computer. It can be either through USB/Serial connections or you can have a
multi-port serial card installed in your desktop.

To configure your setup for multiple radios, once you have your first radio installed and connected via the connection manager, adding a
second or third radio is quite simple.

In the main Rig Control screen of the first radio installed either click on Files > Connect or click on the icon that has the round green
circle with the white arrow in it. This brings up the Radio Connection screen that you have seen before when you set up your first radio.

In this screen you configure the second radio, just like you did for your first in the initial setup of Ham Radio Deluxe. You select the
Manufacturer, the radio model, the COM port and the comport speed. You also select the flow control used to communicate with this
second radio.

Note: Make sure you don't have a check mark in the Always connect to this radio when starting HRD Rig Control. This will allow you to
select which radio you would like to connect to first.

Click on the Connect button to allow Ham Radio Deluxe to connect to and control this second radio. Once in the Rig Control screen you
can click on the Windows menu option and select with radio window to display or configure the display to show both radios in the same
window, as we did earlier in this section.

After you shut Ham Radio Deluxe down, and restart it, when the Connection window opens, select the Preset tab on the window. This
shows you the radios you have connected to your computer and allows you to select which radio you would like to start first.

To change the appearance:
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1 From the View menu select Color Schemes, 2 Select the Schemes tab if it is not selected. 3 In the Schemes list locate LCD and
double click on it. 4 Your display should have changed to a white background with black text. If you want to keep the change, press OK
otherwise press Cancel and your display will revert back to the default appearance.

Congratulations. You have made your first of many modifications of Ham Radio Deluxe.

Like many features of this and other well designed programs there a several ways on doing the same task. For example, you can get to
same customize menu by any of the following methods.

From the View menu select Customize and then Radio Layout.• 
From the Toolbar select Customize.• 
Right click over most locations except the frequency display and select Customize Layout.• 
Press [Ctrl+F8]• 

You will find this to be true for most of the functions within Ham Radio Deluxe. Use whatever process that you like the most. That?s it for
the introduction. Let?s move on to learning more about Ham Radio Deluxe.

Main Page
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2 Rig Control
2.1 Getting Started
2.1.1 Rig Control Tour

The Ham Radio Deluxe program has many, many features. This section attempts to describe the essentials you need to know to get
started. Ham Radio Deluxe is designed to be intuitive; nevertheless even the most experienced user has problems remembering all the
available options!

To aid in the clarity of the screen shots the LCD Scheme is used and we will continue to use the Dem-o-matic TS-2000 so that you can
follow along if you like.

2.1.2 Tuning the Radio

OK! We know you want to find if this software works. Take a few minutes to search the bands to see if you can hear anyone. Please
come back and we will help you get more comfortable with the many features and benefits of Ham Radio Deluxe.

2.1.2.1 Frequency Selection

You can adjust or select a frequency in several different ways. The currently active digit has a bar above and below the digit. Our
example above has the active digit, which is 3, for the main band and for the MHz ?5? on the sub band. You can change the active digit
by either clicking on it or using the left or right arrow keys.

2.1.2.1.1 Mouse Wheel

When you rotate the mouse wheel in the frequency display the currently active digit is incremented / decremented depending on the
scroll direction.

If you rotate while the cursor is over an inactive digit then the digit is activated.

2.1.2.1.2 Up/Down

The up-arrow, down-arrow, - and + keys increment / decrement the active digit.

2.1.2.1.3 Mouse-click

Select a digital by clicking over the digit. To increment / decrement click above / below the center of the digit and keep the mouse button
pressed.
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2.1.2.1.4 Direct Entry

You have two ways to do direct entry of a frequency.

Choice A To enter values just press a numeric key (0-9). The active digital is updated and the next digit to the right is made active.

Choice B

1. With your cursor placed anywhere with the rig control window press Enter to display the Enter Frequency window.

2. Enter the new frequency, and then press Apply.

If you check Auto-apply then the new frequency is applied every time you make a change.

If you check Track this window is updated with changes made to the frequency display ? for example when you tune the radio manually.

Griffin etc. Support for third-party devices such as the Griffin Powermate is available ? see Keyboard Accelerators on page 46.

2.1.2.2 Tuning Dial

2.1.2.2.1 Fine Tuning

There are two fine tuning ranges ? Fine I and Fine II. In the Tuning menu select Show Fine II to show the second range. (If you are only
showing the default Fine I, then the title is Fine.)

Set the range from the Tuning menu or by clicking the  button.

To change the mouse wheel step, click the  button (also set with the Mouse Wheel pane of Program Options on page 50).

This allows you to easily make small adjustments in the frequency. To change the frequency either:

Drag the marker with the mouse (and keep on dragging ? the bar will scroll to the left or right),◊ 
Rotate the mouse wheel (press Shift to increase the mouse wheel step by a factor of 2, press Ctrl to increase by a
factor of 5),

◊ 

Click in the tuning bar or on frequency text such as 14.235.0.◊ 

2.1.2.2.2 Main Tuning

The differences between a main tuning bar and a fine tuning bar is that the main tuning bar shows the whole band range as defined by
the band layout.

2.1.2.3 Band Selection

The Band Section buttons are shown between the Fine and Main layouts.

The buttons currently displayed are:
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ALT,◊ 
BSP,◊ 
Band buttons ? 160m, 80, ? and 10m.◊ 

ALT ? only displayed if you have two VFO?s displayed (for example Kenwood TS-2000), switches between the main and alternate
(second) VFO. When highlighted you are tuning the second VFO with the tuning dial.

BSP (bandspread) ? when you press BSP a new layout is dynamically created. The current band is split into multiple segments, for
example the 20m band (14 MHz ? 14.350 MHz) can be split into 7 segments, each of 50 kHz. To restore the previous layout press BSP
and select Off.

The band buttons select the corresponding band; the last used frequency and mode for the band are restored. They also show which
bands are currently displayed. The displayed bands have the text in white while the hidden bands text is displayed in grey.

Display Scroll

 If there is not enough room to display all the frequency ranges defined in the current band layout use this button to scroll the
frequency ranges (bands) up or down.

2.1.3 Mode Selection

As you would now expect, there are several ways to select your operating mode. The most obvious method to click on the small mode
display above your displayed frequency.

A small button just above the frequency display shows the current mode. To select or change the mode click on this button. A drop-down
menu will come up where you can choose which operating mode you want to use.
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Another method of selecting an operating mode:

1. Select an operating mode is to press the Selection button in the toolbar.
2. In the drop down that opens select Mode.
3. Select the desired mode.
4. If you would like to close the selection window press the X in the top right corner of the selection window. Check the next
page for more information on the selection window.

Your rig configuration may have a list button displayed to allow to change the operating mode. This button is usually located in the upper
right corner of the button display at the top of the screen. Press the selection arrow and make your choice.

2.1.4 Controlling Your Radio's Features

One main reason you have obtained Ham Radio Deluxe is to control your radios many features from one location. You have already
seen how easy it is to tune your radio and select the operating mode without touching the radio. Let?s explore how to access the other
features.

2.1.4.1 Buttons

Located on each side of the frequency window are buttons. All kinds of buttons. The first impression is, wow this is great. Then the cold
reality hits you that you need to figure out what they all do. The good news is they are laid out with a plan. You can change the layout to
suit your needs add operating style. We will get to that later.

2.1.4.1.1 Tuning Control
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To the left of the frequency window is a group of buttons that aid in tuning your radio.

Press a button to activate the option. If it is a button where the option state can be read from the radio ? for example the selected VFO
A? the button indicates whether the option is currently selected.

The buttons displayed will depend upon the radio that is connected to Ham Radio Deluxe.

2.1.4.1.2 Radio Feature Control

To the right of the frequency window is a group of buttons that control features of your radio. This display will be different for each model
of radio. The Kenwood TS-2000 is used for this example.

We see buttons for antenna selection, noise reduction, attenuation and preamp control to mention a few.

2.1.4.2 Drop Downs

Drop downs are multiple choice buttons and are most often located in the top right portion of your screen. . When to press a drop down
button a popup menu is displayed. Select an option or press escape. If possible the drop down displays the current selected option.

The drop down buttons displayed will depend upon the radio that is connected to Ham Radio Deluxe. The layout for your radio can be
changed in the Customize Layout. More on that later.

2.1.4.3 Sliders
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If your radio has the option for slides, they can be displayed either by pressing the Sliders button on the tool bar or by clicking on View in
the menu bar and and selecting Slider controls at the bottom of the list.

Use the mouse to adjust a slider value.

To select the sliders that are displayed with the Sliders ? see Sliders: Appearance on page 44.

2.1.5 Menus and Toolbars

2.1.5.1 Menu Bar

The menu bar is very similar to any other program that you have used. You can find all the commands available somewhere in the menu
bar. This bar also shows you keyboard shortcuts when they are available. We will refer to the menu bar many times as you read through
this manual. Take a moment and look in each of the menu item by clicking on the item.

2.1.5.2 Toolbar

The toolbar hold the tools that you will need most often when using Ham Radio Deluxe. Each icon displayed is a functional button for
selection of that task.

The Connect tool, which you have already used, is for connecting your radio to Ham Radio Deluxe. You can have more than one radio
connected at a time. This could easily happen when working a satellite while working HF or during a contest.

The Selection tool toggles a menu pane along the left side of your screen that allows you to have many selections available quickly.
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1. Press the Selection Button. 2. Select Menus. You will see a list of the possible signal modes displayed. 3. Select Advanced. You see
a list that does not mean much yet partly because you can see only a small portion of the window. You need to move your cursor onto
the right edge of the selection menu. Press the left mouse button and drag the window wider.

You now see both the option and the value. For this radio, you have a set of sliders that do the same function as the slides at the bottom
of your screen.

Your screen should now low something like the image below. Place you mouse on the grey area of the slider and move it to the right.
You should see the value changing in the middle of the slider.
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The Selection menu is also available by selecting Favorites > Display from the menu bar.

Select Favorite to add a selection to your favorites list. The list is displayed from the Selection tool that we just discussed or by selecting
Favorites from the Menu Bar and choosing Display.

When you press Favorite, a dialog appears that allows you to add a new favorite.

1. Press the Favorite button.
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2. In the field labeled Title enter [WWV 10.000 MHz]
3. In the field labeled Freq: enter [10.000.000]
4. Click on the Mode box and select AM.
5. Click on OK to save your new favorite.
6. Look at the bottom of your Favorite list and you should see your latest creation.
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Quick Save button, as the name implies, is a way to rapidly save marker so you can move between the selections with a click of the
mouse. The markers are displayed above the frequency band at the designated frequency. We will discuss this more later. Please see
Quick Save on page 59.

The Full Screen button toggles Ham Radio Deluxe into an out of Full Screen Mode. Try clicking it and view the results.

The Logbook button starts the Ham Radio Deluxe Logbook application.

The Satellites button starts the Ham Radio Deluxe Satellite Tracker application. This application show the current location of many
satellites and will run without a radio attached.

The SW Data button toggles the Shortwave Database which displays at the bottom of your screen.
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The Sliders button toggles the slider controls at the bottom of the screen. This button will be grayed out for radios that do not have this
option available for controlling functions.

The Customize button opens the Customize Display dialog where you can modify you display. We touched briefly on this in the last
chapter and we will cover it in detail later. Please see Customize Layout on page 37.

The Options button opens the Options dialog where many settings can be made. The dialog is a chapter all by itself. Please refer to
Program Options on page 46.

The Add button adds an entry to the Logbook. This will open a dialog window if you have Logbook open.

The DM780 tool starts Digital Master 780 which is a Ham Radio Deluxe application for operating in the digital modes. To use this
application you must be able to pass audio to and from your radio through an interface. Please refer to Digital Master-780 on page 159
for more information.

There a few other tool in the tool bar but we will leave them for later as they are for advanced features not used to get started in Ham
Radio Deluxe.

2.1.6 Frequency Display

The image above shows the default view of the frequency display. We have the mode for the main band at the top enter of the display.
Below that is the frequency setting for the main band.

The lower right area displays the sub band if it is available. Not all radios have the sub band available. The lower left displays the meters
if the radio sends that data out.

2.1.6.1 Enhanced Display

You have the option to add additional information to the frequency display by changing your Customize Layout Options. To do that:

1. Click on the Customize button on the tool bar. This opens the Customize Layout dialog.
2. Select the Frequency tab.
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3. In the Dropdowns area of the dialog select All.

You should see additional items displayed at the top of the sample main display. The actual items that will be displayed depend upon the
radio you have connected. With the Kenwood TS-2000 that we are using for our examples we have several items that will display.

4. Click on OK to accept the change.

Your frequency display should now look something like this:

2.1.6.2 Band Layout Selection

The current band layout is displayed below the frequency display and able the fine tuning bar.
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Click here to select a different layout from the Bands menu. If you reside in the Americas, select Region 2.

2.1.6.3 Date & Time

By default the date is displayed to the left of the Band Layout and the time is displayed in local format to the right of the Band Layout.
This can be changed by clicking on each to set the clock and time format.

2.2 Configuration
2.2.1 Customize Layout

2.2.1.1 Introduction

In the previous chapter we explored the layout as delivered. We did do some small acts of customization We will now explore most of
the items that can be changed, modified, or even removed. The final layout is up to the user to define. Just because it is delivered as the
default view, it may not be what you want or desire. Before you start making wholesale changes, make sure that you have your radio
connected and working.

There are, as usual, several ways to navigate to the Customize Layout dialog window which is used to define the appearance of the
radio display. Your choices are:

From the menu bar select Tools. Near the bottom of the selection box, click on Customize Layout.◊ 
Press Ctrl+F8 keys.◊ 
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Press the  Customize button on the tool bar.

◊ 

2.2.1.2 Schemes

The first tab on the display is Schemes. Schemes are pre-defined customizations created by the Ham Radio Deluxe software creative
team and other Ham Radio Deluxe users. There are four default schemes shipped with Ham Radio Deluxe: Scheme #1 - #3 and the
System Default. You can not change the look of the default schemes.

Note: The scheme that you choose applies to all radio windows.

You can add or modify schemes displayed in the large Schemes list. The Ham Radio Deluxe team and the Ham Radio Deluxe users
have already created the schemes that are there. Special thanks to Danielle in Northallerton, UK. for his contributions.

Select a default scheme by pressing the scheme button (or select an entry and press Select);◊ 
Select one of the other schemes by double-clicking on the entry in the Schemes list.◊ 

If you have modified a layout scheme and wish to save it with a new name press Save and you will be prompted for a Scheme name.
Use Rename and Delete to organize the available schemes.

If you need to save the file to a location different than the default location press the Save as File button. This allows you to save your
options file to any location.

If you receive a options file from someone else, you can add it to your copy of Ham Radio Deluxe by pressing the Load from File button
and navigating to the options file location and selecting the file.

2.2.1.3 Layout
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The next tab is the Layout tab. This is where we can modify the screen layout for our buttons and drop downs. This is one place where
personal preference will cause you to pull your hair out because things are not where YOU want them. Re-mapping the layout is really
quite easy.

Ham Radio Deluxe is a data-driven program. For each radio there is a table of supported commands and associated button / drop down
/ slider names. The layout order is more-or-less alphabetical. Don?t be put off by the amount of information in this window ? take it
slowly and read the information here.

Note: The layout definition is saved on a per-radio basis in the registry. For your sanity only have a connection open to the
radio that you plan to modify the layout. Close any other radio connections.
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2.2.1.3.1 Clear Entry

If we click on a button above the area such as the VFO A button, we can clear the button so we can use the location for some other
function. This is done by clicking the Clear button. We can also remove an entry by dragging it into the Unassigned list on the right side
of the dialog box.

2.2.1.3.2 Moving Entries

We can move the selected entry by simply dragging it with the mouse or by using the four arrow-buttons.

2.2.1.3.3 Dropdown Button / CAT Command / Macros

You can create new buttons - for example, to create a USB button from the Mode dropdown:

1. Open the Customize Layout dialog and click on the Layout tab.
2. Select or create an empty button position ? the selected entry will start to blink (you can re-position this button later),
3. In the Define Button area of the dialog, press Select (above the Save and Load buttons), This will open the Configure
Button dialog.
4. In the Configure Button dialog window select Mode: LSB and enter the text to appear on the new button.
5. Press OK.

6. Press Apply in the lower left corner of the current screen.
7. The previously empty button position now has a new value ? LSB!

If you had previously created a macro or created a custom CAT command, you would have had the choice of applying one of them to
your button. We will cover macros and CAT commands later in this manual.

2.2.1.3.4 Hiding Dropdowns

Hide dropdowns hides the dropdown buttons on the top right edge of the layout window, releasing two columns where you can assign
new button definitions.
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Hide status texts hides the three top-left meters (-1-, -2-, -3-) and the status text area underneath, releasing two columns where you can
assign new button definitions.

2.2.1.3.5 Dropdowns

Select the dropdown menu, and then simply drag an entry to an unused location in the display.

If you drag to a location that already has a definition the current definition is removed, if a standard button it is returned to the
unassigned list.

2.2.1.3.6 Unassigned

Entries in the Unassigned list are standard buttons that are not currently displayed. Simply drag an entry to an unused location in the
display. If you drag to a location that already has a definition the current definition is removed, if a standard button it is returned to the
Unassigned list.

2.2.1.3.7 Styles

 In the Buttons tab you can define up to seven button styles, shown here in the Button
Styles group. The Buttons tab is the next tab we will visit. To assign a style to a button either:

Drag the style over the button, or• 
Click a style to apply it to the currently selected (blinking) button.• 
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2.2.1.3.8 Save / Load

To distribute your layouts with other users of your radio model use the Save and Load buttons. You can also clear the deck and start
over fresh or revert back to the default button layout.

2.2.1.4 Customizing Buttons

Within the Buttons tab you can define:

Seven button color combinations,◊ 
The font, and◊ 
The button size.◊ 

The default button size is small; this is so that users with low resolutions such as 800 x 600 still have a usable configuration. There are
no rules when using the button size; select the size which pleases you most.

For the technical readers the button size is tied to the font size of the radio display form (font is Microsoft Sans Serif, size is 8, 9, 10 or
12 point).

Changing the font size simply changes the font assigned to the form.

The button size can also be changed by selecting View on the menu bar and then selecting Layout Size. You can also [right click] on
any button on your display and select Layout Size.

2.2.1.5 Face-plate
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2.2.1.5.1 Background

These colors are applied to the background area of the display and to the transmit meters (if any) such as PWR, SWR and ALC.

2.2.1.5.2 Status Window

The status window displays information which you cannot normally change using buttons or sliders in Ham Radio Deluxe.

Typical examples are Scanning status, Split mode and Memory channels.

2.2.1.5.3 Clock Position

The clock is displayed to the left, right or both sides of the band title.

2.2.1.6 Frequency Display
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If your radio supports simultaneous access to two VFO?s (Kenwood, some Yaesu) then Ham Radio Deluxe will display two VFO?s,
otherwise just one VFO is displayed.

First select the VFO you are updating ? main or sub. The colors you can set are:

Background,◊ 
Frequency ? the digits,◊ 
Active Posn ? the bar above and below the current digit,◊ 
Inactive Posn ? the bar above and below the other digit. Default is the same as the background color.◊ 

The Font can also be set, use the Main > Sub and Sub > Main buttons to copy settings between VFO?s.

2.2.1.6.1 Dropdowns

The dropdown buttons (Mode, Filter?) can be displayed at the top of the main frequency display.

Select:

None (no dropdowns),◊ 
Mode (only the mode dropdown) or◊ 
All (all dropdowns).◊ 

If Mode or All is selected you can check Add Border to add a border around the text.

If All is selected you can check Include Title to add the Dropdown button?s title (if there is room).

2.2.1.7 Customize Meters
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The Background and Text colors should be obvious. There are three graduation colors:

Bars: Low ? the first bar color,◊ 
Bars: High ? the color at the position set by the High Position slider, and◊ 
Bars: Free ? the color for the free (empty) bars.◊ 

If you check Show peak reading the recent peak value is displayed.

When Ham Radio Deluxe is in TX mode the S Meter value is replaced by the value selected in the Main and Sub dropdowns, the value
you select must be displayed by Ham Radio Deluxe in the upper right hand corner of the display. For Kenwood radios the value to be
displayed is selected with the meter slider or the individual buttons (SWR / Comp / ALC / dB).

If you check the Always update? option then the S Meter is updated when you change frequency ? this results in slower performance.

2.2.1.8 Sliders: Appearance

If supported by your radio, sliders are displayed at the bottom of the display. Here you define the appearance of the sliders. These colors
are optionally applied to the sliders in the Advanced selection windows (select Advanced from the View menu).

2.2.1.9 Sliders: Layout

48

http://wiki.ham-radio-deluxe.com/index.php/File:Page-58-Image-81.png


Here you select the sliders to be displayed. Define up to six layouts, for example one layout for SSB and another for CW.

2.2.1.10 Tuning Dial
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Here you define the colors, fonts and band button positions.

2.2.2 Program Options

2.2.2.1 Introduction

Used to define various Ham Radio Deluxe features, Program Options can be selected in three different ways:

From the menu bar, select Tools > Program Options at the bottom of the list.◊ 
Press F8◊ 

Press the  Options icon on the toolbar.

◊ 

Most users will find that they can live with the defaults that can be modified in this dialog.

2.2.2.2 Keyboard Accelerators
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Define accelerators for use with the Keyboard or with programmable interfaces such as the Griffin Powermate.

When you press Add the definition window is displayed.

Keyboard combinations are assigned to display buttons and arrow keys. As an example, we will assume that we want tot assign the key
combination Ctrl+Alt+W to the Tune button. To do this we would do the following steps:
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1. In the Key field we would enter the letter W.
2. Place a check mark in the boxes preceding Alt and Ctrl.
3. In the text box below HRD Button enter the word Tune.
4. Press OK to save your new accelerator.

You will now see your new accelerator listed.

The Ham Radio Deluxe menu has pre-assigned accelerators; these cannot be redefined. These are listed in the Reserved window.

2.2.2.3 Comms

Normally you will not have to change the default settings.

Read timeout ? serial port timeout.◊ 
Switch off ? some radios such as the FT-817 or the Kenwood TS-2000 can be powered down using a CAT
command. If this option is selected you are prompted to switch off the radio.

◊ 

Polling ? to reduce CPU load for slower systems.◊ 
Dual VFO tracking ? if selected both VFO?s are tracked on every refresh.◊ 
Only of use with Satellite Tracking ( Satellite Tracking on page 209).
Refresh interval ? the interval between consecutive refreshes of the display.◊ 

2.2.2.4 COM Port TX
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Some early ICOM radios do not support switching between TX and RX using CAT commands. The only way to enable computer
controlled TX/RX this is by toggling a COM port pin.

You require a special CAT cable if you select this option.

2.2.2.5 ICOM Calibration

53

http://wiki.ham-radio-deluxe.com/index.php/File:Page-62-Image-89.png


ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is S1 and so on. As a S Meter unit is 6 dB the algorithm
applied is to divide the returned value by two to get dB, then divide dB by 6 to get S units.

Some radios such as the IC-706 have a different logic ? use the Offset and Scale values to adjust the returned values so that the S
Meter in Ham Radio Deluxe corresponds to the S Meter on your radio.

2.2.2.6 Internet
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Ham Radio Deluxe is able to detect whether you have an Internet connection with Internet GetConnectedState(). Uncheck this option if
you do not want Internet access.

2.2.2.7 Out of Band
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If you like to know where your band limits are when you are scrolling through a band and not watching the frequency window you can
enable the optional sound files played when you tune in / out of band. You also have the ability to use a sound file of your choosing.

2.2.2.8 Mouse Wheel

You can define the tuning step when rotating the mouse wheel over the active tuning bar here.

2.2.2.9 Selection Window
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Defines options affecting the appearance and operation of the selection window.

Single-click ? normally the Favorites tree folders are opened / closed with a double-click. Check this option to
enable single-click operation.

◊ 

Show numeric value ? the Select Windows?s Advanced slider values are optionally superimposed on the slider.◊ 
Show the Options icon ? historical support for the version 2 Advanced slider look and feel.◊ 

2.2.2.10 Themes
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Docking panes are used for optional windows such as: Bandscope, Calendar, DX Cluster, Logbook, Selection, Shortwave Database,
and WinKey.

Main Theme Select whichever visual theme you want ? Office 2003 is an acceptable default.

System Theme When you select Office 2003 or Windows XP for Menus and Toolbars you can select an optional System theme.

Main Tabs If you have more than one main window open ? for example Radio and Logbook ? then the main tabs are a useful way of
switching between windows.

Main tabs can be toggled On / Off by selecting from the Menu Bar View > Main Tabs.

2.2.2.11 Updates
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Select how frequently Ham Radio Deluxe reminds you to check for new updates.

2.2.2.12 Yaesu
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Special options for Yaesu radios. Due to firmware ?features? in the FTDX-9000 it is necessary to wait up to 250ms after writing a
command to the radio. With any luck Yaesu will fix this at some date in the future.

2.2.3 Band Layouts

2.2.3.1 Introduction

A necessary feature of a fully customizable radio program such as Ham Radio Deluxe is the definition of custom band layouts.

The IARU regions have own band plans; there is no doubt that these will change in the future. Consider also the traditionalist who has
never owned a microphone in his life and is only interested in the CW portions of the bands ? he wants his own band layouts.

With this feature you can edit any band so only the frequencies are shown which are allowed by your License class. You can then
activate the Out-Of-Band alarms to notify you when you tune outside of your allowed frequency ranges.

2.2.3.2 Manager

To start the Manager do one of the following:

Select Manager from the Bands menu. or◊ 
Press CTRL+B.◊ 

Here you see the existing definitions. In the Edit menu you have the expected New, Copy, Edit and Delete options.

2.2.3.3 Adding a Definition
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In this example a band layout is created for our CW enthusiast. Select New from the Edit menu to create a new definition using the Band
Layout Editor.

1. In the Title field enter CW Only.
2. From the Edit menu select New to define a new frequency range.
3. In the Band field enter [160m]
4. In the From field enter [01.800.000]
5. In the To field enter [01.830.000]
6. Ensure Enable is checked
7. Press OK

 When you press OK the frequency range is added to the band
layout. Repeat the steps above for 80m and 40m using the values below:

80m, 3.5MHz to 3.55MHz, (Remember the leading zero)◊ 
40m, 7.0MHz to 7.05MHz.◊ 

The band layout now looks like this:
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To rearrange the order of the frequency ranges just select a range and use the Move menu options or the Move buttons.

8. When you have finished your new layout press OK. The CW Only definition is added to the band layouts.
9. In the Band Layouts window press OK to save the definitions and close the window.
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2.2.3.4 Copying a Definition

To copy an existing band layout:

1. Start the Manager,
2. Select the entry to be copied,
3. Select Copy from the Edit menu,
4. Enter the new title,
5. Change the frequency ranges are appropriate,
6. Press OK.

2.2.3.5 Selecting
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To select a band layout either:

Open the Bands pane in the Selection window (select Display from the Bands menu) and select an entry in the list,
or

◊ 

Click on the Band Title 160m ? 10m (Region 1) in the radio display and select a new layout from the popup window.◊ 

2.2.4 Favorites

Favorites was introduced in the Getting Started chapter. We will now look at the favorites manager in detail. Favorite definitions are
selected from the Favorites pane in the Selection window.

2.2.4.1 Manager

Start the manager from the Favorites menu or the Favorites pane in the Selection window. It is designed to be easy to use ? let?s see.

The favorites manager, as the name implies, provides a means to manage your favorite frequencies. The can be grouped in Root folders
my band, mode, topic, or interest. New Root folders are created using the New Root button. Root folders can have sub folders to help
further group your favorites. These sub folders are created using the New Folder button. You add your favorite frequency using the Add
button.

Root folders and their associated sub folders can be turned on and off by checking or unchecking the box in front of the folder. If for
example you do not have an antenna for 160m, you can uncheck the box in front of the folder and 160m will no longer be listed in the
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Favorites pane of the Selection window. They will still be visible, however, in the band display above the 160m band.

New Root ? create a new top-level (root) folder. Folders are not saved if they are empty (no child folders or definitions). An example
would be a Root Folder labeled JOTA for Jamboree on the Air.

New Folder ? create a new folder as a child of the currently selected folder. An example would be to create a sub folder under JOTA
labeled SSB or CW.

Sort Folder ? sort the entries in the currently selected folder: ? By title, ? By ascending frequency, or ? By descending frequency.

Add ? add a new definition. If you have crated a new empty folder, you can not add a favorite frequency to it. You need to add the
frequency to either a higher level folder or in a folder that has favorites in it. You can then move the new favorite to the new folder that
you created earlier.
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To add a new favorite frequency to an existing folder:

1. Click on the folder that you wish to add a favorite to.
2. Click on Add.
3. Enter a title for your favorite.
4. Enter the desired frequency without the decimal point.

If you are adding a frequency that starts with a single digit before the first decimal point, place your cursor
immediately adjacent to the left side of the first digit.

If you are adding a frequency that starts with two digits before the first decimal point, place your cursor a bit further
to the left so there is a small space between the cursor and the leading zero.

For three digits place your cursor a bit more to the left.

5. Select you operating mode.
6. Click on OK and your new favorite will be saved in the selected folder.

You can also select Add from Favorites in the menu bar to add a new definition. You can also use Cntrl+A keystroke combination to
access the add function.

Del ? delete the current folder or definition (depending on which you have selected).

Move ? move an entry to another folder (alternatively drag entries between folders with your mouse).
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1. Highlight the folder or definition.
2. Click on Move.
3. Select the new folder.
4. Click on OK.

Copy ? make a copy of an existing definition.

Edit ? edit the selected folder / definition.

Arrows ? rearrange the selected folder / definition.

Load ? load a new set of definitions from a file previously created using Ham Radio Deluxe; all current definitions are discarded.

Merge - merge definitions from a file previously created using Ham Radio Deluxe. Defaults ? restore the default list (hard-coded into
Ham Radio Deluxe).

Save ? save current definitions to a file.

2.2.4.2 Favorites Markers

To display your favorite markers in the Ham Radio Deluxe display select Show Markers from the Favorites menu. The marker size is
selected from the Marker Size option in the Favorites menu.
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The popup text is displayed as you move the mouse pointer over a marker. The text is constructed from the favorite title and frequency.

2.2.5 Quick Save

2.2.5.1 Introduction

This is a simple way of marking a frequency as being interesting ? you are monitoring three QSO?s with a single radio and you want to
quickly switch between the frequencies ? for example during a 6m sporadic-E opening.

Each definition consists of the frequency in Hertz and mode; definitions are saved in the registry.

To switch between Quick Save definitions use the accelerator key combinations for the Quick Save menu options Next (Ctrl+F5) and
Previous (Ctrl+F6).

2.2.5.2 Add Entry

Select Add from the Quick Save menu or just click the Quick Save button. An entry is added to the Quick Save pane in the Selection
window.

2.2.5.3 Quick Save Markers

To display Quick Save markers in the Ham Radio Deluxe display select Show Markers from the Quick Save menu. The marker size is
selected from the Marker Size option in the Quick Save menu. This only toggles the Quick Save markers. It does not toggle the
Favorites markers.

The popup text is displayed as you move the mouse pointer over a marker. The text is constructed from the frequency and mode.

2.2.6 Macros

2.2.6.1 Introduction

Ham Radio Deluxe supports two types of custom definitions:

CAT commands◊ 
User defined macros which are a combination of standard Ham Radio Deluxe input fields◊ 

Macros are selected from the Macros pane in the Selection window.
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2.2.6.2 CAT Commands

A CAT command macro is a command that you define yourself, containing one CAT commands as describer in your radio?s handbook.
The commands you enter must be supported by your radio.

Use CAT commands to add support not provided by the Ham Radio Deluxe interface.

Manager

To open the CAT Command macro manager do one of the following:

Press Manager in the Macros> CAT Commands selection pane◊ 
Select CAT Command Manager from the Macros menu◊ 

1. Press New to create a new command definition.

In this example a Kenwood command is defined for the TS-2000. The mode is set to USB and the frequency to
50.150 MHz.

2. In the Title field enter [50.150 MHz USB].
3. In the CAT Command field enter the following commands:

# Set mode to USB.
MD2
# Set frequency to 50.150 MHz
FA00050150000

4. In the Description field enter [Change frequency to 50.150 MHz, mode to USB].
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5. Click on OK. The new definition is added to the list in the Manager window.

Protocols Reference
Each brand of radio has a slightly different protocol for their CAT commands. Below is are examples of the differences. For complete
information, please refer to the operating manual for your radio.

ELECRAFT AND KENWOOD
Each command consists of two alphabetical characters (lower or upper case) and optional parameters.

The terminating semicolon (;) is not necessary, it is added automatically.

TS-480, TS-2000

Set mode to LSB .....: MD1
Set mode to USB .....: MD2
Set AF gain to 0 ....: AG0000
Set AF gain to 100 ..: AG0100
Select VFO-B ........: FT1

You can define more than one command; to do this start each command on a new line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250

ICOM ICOM radios use the CI-V format to communicate with the radio. Please read your operating manual for command information.

Each entry defined here consists of:

[1] command,◊ 
[2] optional sub-command and◊ 
[3] optional data.◊ 
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You must add a - between each byte (each byte is two hexadecimal characters).

IC-7800

Set mode to LSB ..........: 06-00
Set mode to USB ..........: 06-01
Set AF to 0 ..............: 14-01-00
Select preamp 2 ..........: 16-02-02
MOD I/P (data off) MIC ...: 1A-05-00-31-00
MOD I/P (data off) SPDIF .: 1A-05-00-31-07

You can define more than one command; to do this start each command on a new line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250

TEN-TEC
In general Ten-Tec commands are two character commands followed by data and a carriage return <cr> or <0x0d>. Do NOT add the
carriage return - this is added automatically.

Some data must be sent in binary format, hexadecimal is used to represent binary data. To set Split mode on for the Argonaut the
documented command is *O<0x01><0x0d> which is entered here as *Ox01, that is *O (Split mode) + x (switch to binary) + 01 (Split On).
The carriage return <0x0d> is not added. Please read your operating manual for command information.

When you enter x the format switches to binary mode - two hexadecimal characters per byte. Only enter x once, even if entering more
than one byte of data.

Argonaut

Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set split mode on ...: *Ox01
Set split mode off ..: *Ox00

Jupiter

Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set AF gain to 32 ...: *Ux20
Set filter to 450Hz .: *Wx1D

You can define more than one command; to do this start each command on a new line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250

YAESU
Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very similar to that used by Kenwood. So if you are fortunate
enough to have the FTDX-9000 please use the Kenwood commands ? See ?ELECRAFT AND KENWOOD? on page 61.

Each Yaesu command consists of five bytes. The bytes are defined in the order in which they are sent to the radio. You must add a -
between each byte.

Each command consists of four bytes of data and an OpCode. The order in which P1-P4 are shown in your operating manual does not
matter here - there are difference between Yaesu radios, just remember that the bytes are defined in the order in which they are sent to
the radio.

FT-817

Set mode to LSB ..: 00-00-00-00-07
Set mode to USB ..: 01-00-00-00-07
Split on .........: 00-00-00-00-02

FT-1000MP

Set mode to LSB ..: 00-00-00-00-0C
Set mode to USB ..: 00-00-00-01-0C
Split on .........: 00-00-00-01-01

You can define more than one command; to do this start each command on a new line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250
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2.2.6.3 User Defined Macros

User created macros are combinations of fields on the Ham Radio Deluxe radio display. Users of Microsoft Office will be familiar with the
concept supported here. When you start out you will see a Macros: Default sub tab in the Selection window. This name will / can change
depending on how you define your macros. You can also add more sub tabs allowing you to sort your macros in a manner convenient to
your operating style. Let?s do a couple of examples.

Manager Select Manager from the Macros: Default menu, and then press New to create our first new macro. This macro will switch your
radio to 50.150 MHz in USB. We will put it in a new sub folder called ?Simple?.

First we will name the macro and where it will reside. We can then set the mode to USB:

1. In the Title field enter [50.150 MHz USB].
2. In the Group field enter [Macros: Simple].
3. In the Description field enter [Change frequency to 50.150 MHz, mode to USB].
4. Press Add to open the Macro Editor.
5. Click on Dropdown Button
6. Select Mode: USB

7. Press OK.
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Now we need to set the frequency to 50.150.000:
8. Press Add again to open Macro Editor
9. Click on Frequency button
10. Enter [50.150.000 MHz].

11. Press OK. Your definition now contains two entries:

12. Press Save, this returns you to the Macros Manager.
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13. Press OK. The window closes.

Another Example

This macro will switch your radio to 14.070 MHz in USB.We will put it in a new sub folder called ?PSK?.

1. Reopen the Macro Manager which now can be found in the Macro: Simple sub-folder.
2. In the Title field enter [20M PSK].
3. In the Group field enter [Macros: PSK].
4. In the Description field enter [Tune radio to 20M PSK].
5. Press Add to open the Macro Editor.
6. Click on Dropdown Button
7. Select Mode: USB
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8. Press OK.

Now we need to set the frequency to 14.070.000:
9. Press Add again to open Macro Editor
10. Click on Frequency button
11. Enter [14.070.000 MHz].
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12. Press OK. Your definition now contains two entries:
13. Press Save, this returns you to the Macros Manager.
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14. Press OK. The window closes.

You now have two sub-folders of macros displayed in the Selection window. You can create more to match your operating needs.

Snapshots

The snapshot button creates a definition that contains the state of all input fields. This is an easy way of preserving a known state of
your radio once you have set it up exactly the way you want. You can add functions as you did previously to further enhance your
snapshot.
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Your snapshots will be found in their own sub-folder of macros.

2.3 Remote Radio Control
2.3.1 Remote Station Support

2.3.1.1 Introduction

A popular feature found in Ham Radio Deluxe that is not found in many other ham radio software packages is the ability to operate your
station via HRD?s builtin remote server software.

There are places, however, where you may not be able to operate your base system from remote. These places are, for example, your
work environment where the computers you use are behind a firewall or router that are not under your direct control. Certain ports need
to be available through the firewall and routers in order for you to connect remotely to your base station and these may be blocked in a
corporate environment due to various reasons. Ham Radio Deluxe is evolving into a program that supports all the serial port-enabled
devices that you control at your remote station.

For radio control you use the Ham Radio Deluxe Remote Server. For other devices such as keyers and rotators you use the Ham Radio
Deluxe Serial Port server. Note that the Ham Radio Deluxe Remote Server is highly optimized or use with Ham Radio Deluxe and
should be used to control the radio.

The Ham Radio Deluxe Serial Port Server enables a connection between Ham Radio Deluxe and serial port-enabled devices (keyers,
rotators) connected to a remote computer that can be contacted via TCP/IP.

Note: The process of setting up these remote servers is not something an inexperienced computer user should attempt. Find
a friend who makes his living setting up and maintaining computer networks. Be kind to them and reward them so they will
come again and help when something stops working.

Requirements
The remote computer must be running Windows 7 or later.

Technology
A Windows service is installed on the remote service. This listens on a port (usually 7805) for incoming connections from Ham Radio
Deluxe (the client). For more technical information see Ham Radio Deluxe Remote Server on page 70.

External IP Address
When setting up your remote server there is one important thing you need to take into consideration. If you plan to use the remote server
and connect from within your home network, lets say between the shack and your laptop on the patio out back, there will be no problem.
You will use the ?localhost? or 127.0.0.1 address to connect from the remote computer to the host system.
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However, if you are planning on connecting to your system via the internet from outside your home network you are going to have to
know the exact internet IP address of the computer you are connecting to. This connection must be a full time connection.

ISPs assign a Dynamic IP Address to your computer system. For example, your dynamic IP address may be 68.74.165.227. This would
be the address you would use to connect from your remote computer to your base system over the internet. The problem comes in when
most ISPs change that address from time to time without you knowing it. Some change the IP address at random times, others change
your IP address each time you disconnect and reconnect your modem to the internet while others change your IP address each day.

There are two solutions to this problem. The first is to contact your ISP and request a STATIC IP address for the system where the
remote server is running, (your shack computer). This is usually inexpensive, around $5.00 or so a month added to your internet bill.

The second solution would be to use a service such as NO-IP, DYNDNS or any one of many such services which provide a free solution
to the problem of not having a static IP address. These services monitor your IP address and track any changes while providing you with
a constant connection through their DNS servers so any change in your IP address will not effect the address you use to connect to your
remote system.If you are installing on a remote computer then the computer must have a static (non-changing) public IP address. If you
have a public IP address which is not static then visit http://www.no-ip.com/ and use the free IP redirection option.

Internal IP Address
There is another IP address that also requires attention if you plan to run the HRD Remote server on a computer in your shack.

If you have only one computer in your shack and it is connected directly to the internet via a modem there isn't much problem. A problem
arises if you have more than one computer in your house and they each connect to the internet through a router, wireless or hard wired.

When connected to the internet via a router, each computer connected to the router has it's own INTERNAL IP Address. Just like with
your Internet IP address, this internal IP address can change depending on the sequence the different computers are booted up and
access the router.

It is advised you set an internal STATIC IP address for the computer running HRD's Remote Server software. You will find instructions to
do this in the next section of this documentation.

Firewall
Make sure you open up ports 7805 (Ham Radio Deluxe Remote Server) and 7806 (Ham Radio Deluxe Serial Port server) for incoming
TCP traffic. This will probably will need to be done on your router where your internet service enters your home. The port assignments
can be changed in the configuration files.

2.3.1.2 Example
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In this example the remote station uses serial ports as follows:

COM1 --> IC-7800,◊ 
COM4 --> WinKey keyer,◊ 
COM6 --> AlfaSpid rotator.◊ 

Two virtual null modem ?cables? are installed (pure software, no hardware involved). The vCOM driver from N8VB is highly
recommended;

See http://www.philcovington.com/SDR.html. To install the vCOM drivers see N8VB vCOM on page 243.

In this example the ?cables? map ports as follows:

COM20 <-> COM21, and◊ 
COM22 <-> COM23.◊ 

The local station connects as follows:

IC-7800
Remote port selected, TCP/IP connection made with the Ham Radio Deluxe Remote Server running on the remote computer (port
7805).

The Ham Radio Deluxe Remote Server connects to the IC-7800 using COM1.

Keyer
The Ham Radio Deluxe Winkey interface connects to the Ham Radio Deluxe Serial Port client on the local computer using the COM20
<-> COM21 virtual cable.
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The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe Serial Port server on the remote computer using TCP/IP
(port 7806).

The Ham Radio Deluxe Serial Port server connects to the K1EL WinKey using COM4.

Rotator
The Ham Radio Deluxe Rotator interface connects to the Ham Radio Deluxe Serial Port client on the local computer using the COM22 <
- > COM23 virtual cable.

The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe Serial Port server on the remote computer using TCP/IP
(port 7806).

The Ham Radio Deluxe Serial Port server connects to the AlfaSpid rotator using COM6.

2.3.1.3 Virtual Null Modem Software

The vCOM driver from N8VB is highly recommended; see http://www.philcovington.com/SDR.html.

This is the same as a null modem cable except it is made using software. The vCOM software supports up to 10 cables. Each cable is
allocated two COM ports.

You simply connect Ham Radio Deluxe to one end and the Ham Radio Deluxe Serial Port Client to the other.

To install the vCOM drivers see N8VB vCOM on page 243.

2.3.2 Ham Radio Deluxe Remote Server

2.3.2.1 Gathering Necessary Information

It is very important to setup a static ip address, if you are going to use port forwarding. When you have port forwarding setup, your router
forwards ports to an ip address that you specify. This will probably work when you initially set it up, but after restarting your computer it
may get a different ip address. When this happens the ports will no longer be forwarded to your computer's ip address. So the port
forwarding configuration will not work.

What is an IP Address?
IP addresses are four sets of numbers separated by periods that allow computers to identify each other. Every computer has at least
one ip address, and two computers should never have the same ip address. If they do, neither of them will be able to connect to the
internet.

Dynamic vs Static IPs
Most routers assign dynamic IP addresses by default. They do this because dynamic ip address networks require no configuration. The
end user can simply plug their computer in, and their network will work. When ip addresses are assigned dynamically, the router is the
one that assigns them. Every time a computer reboots it asks the router for an ip address. The router then hands it an ip address that
has not already been handed out to another computer. This is important to note. When you set your computer to a static ip address, the
router does not know that a computer is using that ip address. So the very same ip address may be handed to another computer later,
and that will prevent both computers from connecting to the internet. So when you assign a static IP addresses, it's important to assign
an IP address that will not be handed out to other computers by the dynamic IP address server. The dynamic IP address server is
generally referred to as the DHCP server.

2.3.2.2 Setting up a Static IP for Windows

Supported versions of Microsoft Windows set up in a similar manner. If you can, print out these pages of instructions as you will have
difficulty viewing them online while you preform the config task.

1. Open up the start menu, and look for the Search programs and files box.

2. Type cmd in the Search programs and files box, and press Enter on your keyboard. This will bring up a black command
prompt window.
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3. The command prompt may look different on your screen, but it doesn't really matter. Type ipconfig/all in that window, and
then press the enter key. This will display a lot of information. If it scrolls off the top you may need to enlarge the window.

4. Record the following information:

IP address ____.____.____.____
Subnet Mask ____.____.____.____
Default Gateway ____.____.____.____
DNS Servers ____.____.____.____

____.____.____.____
____.____.____.____

You may not have three DNS Servers. Just leave the unused blank. We are only concerned with IPv4 entries, you can ignore the IPv6
stuff.

The name server entries are a bit complicated. Name Server is just another name for DNS (domain name server). Some router's act as
a proxy between the actual name servers and your computer. You will know when this is the case, because the Default Gateway will list
the same ip address as the Name Servers entry.

We need to have the correct Name Server IP addresses. If we do not, you will not be able to browse the web. There are a couple ways
to get these. The first way is to log into your router's web interface, and look at your router's status page. On that page you should see
an entry for DNS Servers, or Name Servers. Write down the ip addresses of your Name Servers.

Another way to get the correct Name Servers to use, is to give your ISP a call. They should know the ip addresses of your Name
Servers right off. If they ask you why you need them, you can tell them you are trying to setup a static IP address on your computer.

5. Type exit in this window, then press the enter key to close it.
6. Once again open the start menu. This time click Control Panel.
7. Click on Network and Sharing Center.
8. Single click Change adapter settings on the left side of your screen.
9. You might have more than one Internet connection listed here. You will need to determine which adapter is your connection
to the Internet if this is the case. If you have a choice of a wired or wireless connection, choose the wired connection.
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10. You can either right click or double click on your network adapter and choose properties to open up the properties window
of this internet connection.

11. Click on Internet Protocol Version 4(TCP/IPv4) and then the Properties button.
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12. You will see the following screen:
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13. Before you make any changes, write down the settings that you see on this page. If something goes wrong you can
always change the settings back to what they were! You should see a dot in the Obtain an IP address automatically box. If you
do not, your connection is already setup for a static ip. Just close all these windows and you are done.

Pick an ip address and enter it into the IP Address box. The ip address you choose should be very similar to the router's ip address.
Only the last number of the ip address should be different. If the router's ip address is 192.168.1.1, I might choose 192.168.1.10. The ip
address you choose should end with a number between 1 and 254, and should not be the same as the router's ip address. Every device
that connects to your network needs to have it's own IP address.

Put the subnet mask we previously found in the subnet mask section. The default gateway should go into the Default gateway box. Enter
the DNS Servers we previously found into the two DNS Server boxes. Click okay all the way out of this menu.

If you find that you can not pull up web pages, the problem is most likely the DNS numbers you entered. Give your ISP a call, and they
will be able to tell you which DNS servers to use.

That's it you should be done! If you can't connect to the internet go back and change your configuration back to what it originally was.

2.3.2.3 Installing

The Ham Radio Deluxe Remote Server files are:

Ham Radio DeluxeRemoteSvr.exe ? the executable, and◊ 
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Ham Radio DeluxeRemoteSvr.cfg ? configuration file.◊ 

To install the service select Remote Service from the Tools > Programs menu.

1. Press Ham Radio Deluxe Remote Server to select this server.
2. Press Install to install the service, and then press Start to start the service.

You can start the Windows Services applet (Start > Settings > Control Panel > Administrative Tools > Services) to modify the properties
of the service, for example disabling automatic startup.
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Firewall
Allow incoming connections on port 7805.

Configuring
Press Configure to edit the file that contains the service configuration. Lines needing configuration are highlighted in the configuration file
below. Each user who accesses the system must have a username and password. A pound sigh (#) as the first character of a line
indicates the line is a comment and the # must be removed from the line before it is recognized by the software.
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The contents of this file should be obvious. After changing the configuration, save the changes and you should restart the service.

Restricting TX
One special note ? to restrict a user?s ability to switch the radio to transmit there are now optional tokens added with the username and
password to disable access to the TX and any Tune buttons. Add no_tx after the password.

In addition you will want to disable macros as a knowledgeable user can define a CAT command to enable TX. Add no_macros after the
password.

Enable Restart
The RESTART token enables the Restart button on the connection window. Restarting the service will close all COM ports opened by
the service and drop all connections by Ham Radio Deluxe users.

This should only be allocated to yourself and your friends!
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2.3.2.4 Connecting to a Remote Server

Connecting to the host computer from remote is almost like connecting to the radio while on the base computer system.

If you don?t already have it done, you will need to:

1. Install Ham Radio Deluxe, if you have not done so, on the computer you plan to use for the remote connection.
2. Once installed, run Ham Radio Deluxe.
3. When the Rig Connection screen appears, you will need to set this up EXACTLY as it appears on your HOST system, with
ONE exception. Instead of entering a comport number you select REMOTE from the drop down box as indicated by the red
arrow in the image below.

4. Press Connect and the Remote Connection window will display.
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5 In the New Connection area of this window enter the IP address or the domain name of the HOST system. If you are working from
inside your home through a router, enter the address of 127.0.0.1. The port is the default port of 7805. 6 Now you enter a valid user
name and password that was configured in the Rig Control Configuration file. You can check the Save Settings box so next time you
connect you just select the connection from the list on the left side of the display. The user name and password are not case sensitive. 7
To save these values make sure the Save settings option is checked [X]. 8 Press the Connect button. The display will change showing
the Com Ports in the lower right half of the screen. 9 Select the com port from the drop down box that connects to the radio at the HOST
location. You can also uncheck the box for the optional PTT COM port. 10 Press the OK button at the bottom of the window and the next
screen you see should be the rig display from the remote server.

At this point if you have problems connecting to the host machine, you need to double check all your settings. Check to make sure the
firewall or router are not blocking the ports required. If you are still having problems and can?t find the answer, feel free to contact HRD
Customer support for help.

Load connection information from a file.

Save connection information to a file.

Press Connect.

If the connection is successful you will see the confirmation window and the text Username / password authenticated. Select a remote
COM port, then press ?OK? is displayed below the Connect button.
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Now select the COM port, and then press OK to connect to the remote COM port and start the Ham Radio Deluxe radio display.

When the connection with the radio has been confirmed a Remote Connection display window shows you the data throughput and
average round-trip time.

Remote Connection
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Use the Remote Connection window to show the status of the remote connection.

Round-trip time: the time required to send a message from Ham Radio Deluxe to the remote server and get a
response. This will be very similar to the value shown when you use Ping to interrogate a remote host. Typically
values of 50 milliseconds or less are very usable.

◊ 

Refresh interval: the interval between refreshes of the selected Regularly Read options.◊ 
Send frequency: when the frequency is updated over a link with a high round trip time (> 100ms) the performance
will be less than optimal with Sync selected so if the round trip is high select Async, otherwise just select Sync. The
disadvantage of using Async is an 'elastic band' effect while tuning by dragging Ham Radio Deluxe's small tuning
marker.

◊ 

Regularly Read: the options that are regularly updated. If you are using a fast link - for example to a local station
with a low round- trip time then you can safely select all options. The disadvantage of selecting options such as
Buttons, Dropdowns, Sliders and Status Texts is that it may take a second or two before Ham Radio Deluxe detects
that you are changing the frequency by dragging the tuning marker and the current refresh operation cannot be
interrupted.

◊ 

Slow Link
If you have a slow link - a round-trip time > 100 ms - then select only Meters. As this is a remote station it is unlikely that anyone else will
be adjusting the radio's controls so you will not need to refresh buttons and dropdowns as you would with a locally connected radio.

The disadvantage of not selecting Buttons and Dropdowns is that inter-button dependencies will not be shown - for example you may
have 4 AGC buttons Off, Fast, Medium and Slow, only one of which will be active at any one time. If Buttons is not enabled for regular
refreshes then pressing Fast will not update the other AGC buttons. In this case you must press the small refresh button to the right of
the Buttons check box.

To refresh all display options click Refresh All.

Problem Solving
The following steps are recommended to solve problems using the remote server.

1. Run Ham Radio Deluxe on the remote computer to check that you can actually connect to your radio.
2. When you connect to the remote server make sure you have closed Ham Radio Deluxe on the remote computer. If you get
the error ?Access is Denied? then the COM port is held open by another program.

2.4 Ham Radio Deluxe Serial Port Client
2.4.1 Starting

Select Port Client from the from the Tools> Programs menu.
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You must define the serial port mappings before you connect to the serial port server running on the remote computer.

2.4.1.1 Mappings

Press Add to define a new mapping.

Each mapping consists of:

Title ? whatever makes sense to you. In this case we?re mapping to a K1EL WinKey on Simon?s remote station in
the south pacific.

◊ 

The local port ? one of the virtual null modem ports. Here the two ports are COM20 and COM21.◊ 
The remote port ? Simon has connected the WinKey to COM1 on the remote computer.◊ 
Remote port settings ? WinKey uses 1200,8,none,1.◊ 
[X] Enable DTR and [_] Enable RTS ? usually checked to provide power to a special powered cable or device. For
Winkey you must check DTR to provide power to WinKey!

◊ 

Remote Port Settings
Some useful remote port settings are:

WinKey ? 1200,8,none,1 and [X] Enable DTR.◊ 
AlfaSpid RAS rotator ? 600,8,none,1.◊ 

93

http://wiki.ham-radio-deluxe.com/index.php/File:Page-94-Image-147.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-94-Image-148.png


AlfaSpid RAS rotator ? 1200,8,none.◊ 
Idiom Press rotator ? 4800,8,none,1.◊ 

2.4.1.2 Connecting

Press Connect to connect to the serial port server on the remote computer.

In the Connect to field enter the remote address, for example 201.42.12.246. If you are not using the default port (7806) then append a
colon and the port number, for example 201.42.12.246:7808 to connect to port 7808 on 201.42.12.246.

In the Username and Password fields enter the username and password you have been given; these must also be entered in the
configuration file.

When you have finished just press Connect.

Assuming everything works correctly the client will display log information similar to that below:

The client makes two connections; one to send data, the other to receive data. The remote server returns a list of known serial ports
after the first connection is established, in this case COM1, COM3, COM4, COM5 and COM6.

Now check the Simon?s WinKey mapping and you see logfile messages as the local (COM20) and remote (COM1) serial ports are
opened.
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Now you can connect to the remote WinKey using COM21 (the other half of the COM20 <-> COM21 virtual cable).

If you enable Tracing you see the data sent and received as the WinKey code runs through the initialization and performs an echoback
test.

Congratulations ? you can now use your remote WinKey.
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2.4.2 Ham Radio Deluxe Serial Port Server

2.4.2.1 Installing

The Ham Radio Deluxe Serial Port files are:

Ham Radio DeluxeSerialPortSvr.exe ? the executable, and◊ 
Ham Radio DeluxeSerialPortSvr.cfg ? configuration file.◊ 

To install the service select Remote Service from the Tools> Programs menu.

1. Press Ham Radio Deluxe Serial Port Server to select this server.
2. Press Install to install the service.
3. Press Start to start the service.

You can start the Windows Services applet (Start > Settings > Control Panel > Administrative Tools > Services) to modify the properties
of the service, for example disabling automatic startup.
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Firewall

Allow incoming connections on port 7806.

2.4.2.2 Configuring

Press Configure to edit Ham Radio DeluxeSerialPortSvr.cfg that contains the service configuration.
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2.4.3 Passing Audio

After the completing of the rig control portion of a remote station you will need to setup the ability to pass audio to and from the remote
station. If you are only working the digital modes like PSK31 you will not need to worry about this. CW was discussed previously in this
chapter.

Skype has been a traditional method of passing audio in both directions. A great new option has been added to DM-780 in Ham Radio
Deluxe Version 6.2. This new option brings us one step closer to being able to provide fully integrated audio within the Ham Radio
Deluxe suite of programs for remote operation, without having to rely on 3rd party software such as Skype.

HRD has added an option which allows you can operate voice communications using a standard, inexpensive computer headset.

Voice

Before you begin...
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NOTE: This option will not work on all radios.

This option will not work on some radios due to the following conditions.

This failure to work is not a defect in Ham Radio Deluxe, but rather caused by variations in the implementation of PTT on different
radios. VOX will not work on some radios. PTT won't work via rig control on some radios. There may be no audio out if an external PTT
foot switch is used with a back-panel ACC connection. Some radios have at least six different methods of PTT and each PTT input has it
own foibles. This makes it almost impossible for Ham Radio Deluxe to cover ALL the different ways in which PTT is handled. Some
radios will have to be programmed via their menus and there are a variety of other possibilities. Therefore, this option is available only
for those radios that can handle it.

Configuration

The Ham Radio Deluxe Voice option is easily activated from within the DM?780 module.

1. Open DM-780.
2. Click on Program Options and open the sound card dialog as indicated below.

3. You will notice on the right side of the dialog a new section has been added.

You will also notice the note that states the enable function will be "GRAYED OUT IF UNAVAILABLE". To activate
this function, place a check-mark in the enable box.

4. Next, select the Microphone you intend to use, which is normally the default microphone for the computer sound card.
5. Next, select the Headphone, again normally the default. Once these are set your almost ready to go.
6. The next step is to select the VOICE mode from the modes listing as shown to the right.
7. Once this step is complete you will notice a change n the Transmit Toolbar.

Instead of seeing the normal "SEND (F4)" you will see instead "PTT (F4)" This is your PTT button for the
microphone. Just click the PTT button and start talking and click the "STOP" button to return the radio to the
Receive mode.
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This new function has been tested with the FT-857D using the Timewave Navigator interface. It seems to work great on Upper Side
Band, however, on this particular radio, if you plan on using the function to communicate on any 2-meter FM repeaters, you MUST put
the radio into the PKT mode. The reason for this is the FT-857D can only accept audio through the DATA plug on the back of the radio
with the rig set to USB or PKT and not set to any other mode.

Good audio reports can be obtained using an inexpensive computer headset.

2.5 Advanced Features
2.5.1 Audio

2.5.1.1 Introduction

Ham Radio Deluxe has a built-in audio grabber and audio playback. This feature requires a connection from your radio the your sound
card in your computer or an external sound card interface.

2.5.1.2 Audio Grabber

The audio grabber stores incoming audio in MP3 files using the MP3 tags to store information about the radio settings (or any other
information you feel to be important).

An alternative to MP3 would be Windows Media format (WMA) but the programming of WMA files is rather complex.

To display the audio grabber select Audio Grabber from the Tools menu. By default the Audio Grabber is docked at the bottom of your
Ham Radio Deluxe Screen. By grabbing the top bar o the Audio Grabber you can undock it and make it a separate window. To redock
the wind grab the top bar of the Audio Grabber and start moving it into your Ham Radio Deluxe window. You will see arrows at the four
edges plus four arrows in the middle of the screen. Move the Audio Grabber over the desired arrow and it will dock in that location.

Record
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Here you have the standard recording buttons. From left to right:

Record,◊ 
Stop,◊ 
Reset current recording,◊ 
Restart (close current file first),◊ 
Browse for MP3 files.◊ 

You also set a file limit ? a downside of MP3 is that the tags are written at the end of the file when it is closed, so to avoid losing
information in the event of an unexpected event it is best to use more, smaller files.

Folder

Here you select the folder where the MP3 files are stored.

Quality

Here you select the bandwidth and quality. Modern computers have more than enough CPU power to support a very high quality. A
bandwidth of 4.5 kHz is usually acceptable unless you are recording a WFM broadcast.

Soundcard
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Select the soundcard that you are recording from.

Tags

Here you see the values stored in the MP3 tags. To change the values just add the new text and then press Apply.

2.5.1.3 Audio Browser

Use the audio browser to playback MP3 files. To open the Audio Browser, select Audio Browser from the Tools menu. You can also
start the Audio Browser by clicking on Browser in the Folder tab within Audio Grabber.

Peter PH1PH came across IrfanView ? an excellent freeware utility.
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2.5.1.3.1 MP3 Player Options

Player

Select MP3 player ? a basic MP3 player is built into Ham Radio Deluxe, however you can select an alternate player such as the
excellent Windows Media Player. Press Default to select the default player.

Folder

Select the folder to browse

Select default folder

Refresh the current folder

Audio File

Select a file to play from the list at the bottom of the window.

Play currently selected file

Pause

Start again

Stop

From

Start at beginning of file

Set From at the current position

To

To end of file

Set To at the current position

Use the From and To slider positions to select the part of the file to repeated over and over and over again. This is useful for determining
exactly what the station was sending.

2.5.1.4 Other Options

The other options are:

Copy ? copy the selected files to another folder.◊ 
Delete ? delete the selected files.◊ 
Move ? move the selected files to another folder.◊ 
Rename ? rename the selected file.◊ 
Artist / Album / Title / Description ? change the MP3 tags.◊ 

2.5.2 DDE Support

2.5.2.1 Introduction

Ham Radio Deluxe uses dynamic data exchange (DDE) for inter-process communication. DDE allows two or more applications running
simultaneously to exchange data and commands.

For more information See ?3rd-Party Programs? on page 94.

2.5.2.2 Available Support

Select DDE Monitor from the Tools menu to display the supported DDE items.
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2.5.2.3 Commands

The commands below are supported by Ham Radio Deluxe.

Add ADIF Record

ADIF
Adds a record to the logbook; the record is supplied in ADIF format. Used by PSK31 Deluxe.

Refresh

REFR button_status
Refreshes all buttons.

REFR dropdown_list
Refreshes all dropdown.

Set Button

BUTN button_title=value
Sets a button state. For normal buttons the value is either on or off.
If title starts with @ then it?s a dropdown, the value must be a dropdown value.

Set Dropdown

DROP button _title=value
Selects a dropdown value.

Set Frequency

FREQ <hertz>
Sets the frequency to the value supplied in Hertz.

Set Mode

MODE <mode>
Sets the mode to the supplied value.

Top Window

TOPW
Makes the Ham Radio Deluxe the top-most window in the Z-order, in other words brings Ham Radio Deluxe to the front of
your monitor.

2.5.3 Synchronizer
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2.5.3.1 Introduction

The synchronizer is used to control two or more radios where a common frequency is shared by using the Dynamic Data Exchange
(DDE) mechanism. For each radio you are using you start an instance of Ham Radio Deluxe, one instance is the Master, the rest are the
Slaves, the slaves receive frequency and mode information from the master.

2.5.3.2 Starting

Start the Synchroniser from the Tools> Programs menu, then press Scan to find the active Ham Radio Deluxe instances.
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Select the master instance (supplied the frequency and mode), and then press Start.
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In the Frequency and Mode dropdowns you select the corresponding source from the Ham Radio Deluxe master instance:

Radio ? as seen on the main Ham Radio Deluxe display,◊ 
Transverter ? frequency is taken from the Transverter window (selected from the Tools menu).◊ 
Satellite uplink ? the uplink frequency and mode (see Ground Control on page 213).◊ 
Satellite downlink ? the downlink frequency and mode (see Ground Control on page 213).◊ 

In the Ham Radio Deluxe Slaves group box check the instances to be controlled by the Synchroniser.

As soon as you check a slave the slave?s frequency and mode are updated with the current values from the master; every time the
master frequency and / or mode change they are sent to the slave for so long as the slave option remains checked.

2.5.3.3 Dual Radio Satellite Tracking

Refer to Satellite Tracking on page 209, specifically Ground Control on page 213.

If you are using two radios for satellite tracking (for example two FT-817 or IC-7000):

1. Start an instance of Ham Radio Deluxe for each radio; connect to the radios.
2. Select an instance to use as the master, in this example the radio used for receive.
3. In the master (receive) instance:

Start the display.• 
Enter transmit and receive frequency information for the satellite you are tracking.• 
Check the RX VFO, do not check a TX VFO as this instance will not be used for transmit.• 

4. Start the Synchroniser:
Master is the receive instance,• 
Slave is the transmit instance,• 
Select the Satellite uplink option for Frequency and Mode so that the slave receives the frequency and
mode used for transmit as computer by the Master instance.

• 
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The slave will now be updated with the transmit frequency and mode for transmit every time it changes in the master instance.

2.5.4 3rd Party Programs

2.5.4.1 Introduction

Ham Radio Deluxe supports 3rd-party programs such as logbooks via a virtual serial port. See also DDE Support on page 90.

An example of a virtual serial port is available from Phil Covington N8VB. His homepage is http://www.philcovington.com/SDR.html look
for the N8VB vCOM Virtual Serial Ports Driver download.

To install the vCOM drivers see N8VB vCOM on page 243. The N8VB driver works with Windows 2000, XP and higher.

N8VB's solution creates a pair of virtual COM ports (virtual because there is no hardware associated with a virtual COM port). The ports
are effectively connected back-to-back ? just like a normal serial cable.

In the description that follows two ports are created during the installation, COM7 (used by Ham Radio Deluxe) and COM8 (used by the
3rd-party program).

Ham Radio Deluxe opens and listens on COM7 port for incoming requests.◊ 
The other program opens COM8 in exactly the same way it would connect to a radio using a hardware serial port.◊ 

The connection parameters used by the 3rd-party program to connect with COM8 are:

Speed ? any (9600 by default but this really doesn't matter),◊ 
Stop bits ? 2,◊ 
Parity ? none.◊ 

The protocol supported is Kenwood, the command set current supported is:

FA ? Get / set VFO-A.◊ 
FB ? Get / set VFO-B.◊ 
MD ? Get / set mode.◊ 
IF ? Read status, currently frequency, TX status, and mode are supported,◊ 
SM ? Read the S-Meter.◊ 

To use this option Ham Radio Deluxe must be connected to a radio, otherwise the standard Kenwood error response?; will be returned.
The radio does not have to support the Kenwood protocol as Ham Radio Deluxe makes the necessary conversions.

2.5.4.2 Configuring

Select 3rd-Party Serial Port from the Tools menu.
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1. Enable opens the connection on the selected port ? in this case COM7.
2. Check Connect to automatically open the connected everything Ham Radio Deluxe starts.
3. In the Port dropdown you select the COM port to use
4. The Mode dropdown is reserved for future use. The only option is Default.
5. Press OK

And that?s all there is to it.

2.5.4.3 Testing

To test the connection:

1. Start HyperTerminal (supplied with Windows thru XP. If you are using Vista or Win7 download TeraTerm which is a free app
and is better than HyperTerminal).
2. Connect to COM8 (the virtual serial port used by the 3rd party programs).
3. Enter FA; you will see a value such as FA00050100000; returned (50.1 MHz).

2.5.4.4 Command Detail

FA Reads and sets the VFO A frequency in Hz

Set FA<11 digit frequency>;
Read FA;
Answer FA<11 digit frequency>;

FB Reads and sets the VFO B frequency in Hz

Set FB<11 digit frequency>;
Read FB;
Answer FB<11 digit frequency>;

IF Retrieves the transceiver status

Read IF;
Answer IFP1P2P3P4p5P6P7P8P9P10P11P12P13P14P15;
Where:

P1 = 11 digits, frequency in Hz
P2 = 5 digits, not used
P3 = 5 digits, not used
P4 = 1 digit, not used
P5 = 1 digit, not used
P6 = 1 digit, not used
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P7 = 2 digits, not used
P8 = 1 digit, 0: RX, 1: TX
P9 = 1 digit, see MD above
P10 = 1 digit, not used
P11 = 1 digit, not used
P12 = 1 digit, not used
P13 = 1 digit, not used
P14 = 2 digits, not used
P15 = 1 digit, not used

MD Recalls or reads the operating mode status

Set MD<mode>;
Read MD;
Answer MD<mode>;
Where mode is one of:

0: None
1: LSB
2: USB
3: CW
4: FM
5: AM
6: FSK
7: CWR (CW Reverse)
8: Tune
9: FSR (FSK Reverse)

SM Retrieves the S-Meter value

Read SM;
Answer IF<4 digit value>;
Where the returned value range is from 0000 to 0030. Each unit is 1/2 an S-unit. S5 is 0010, S9 is 0018.

Main Page
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3 Logbook
3.1 Introduction
It is time to be impressed! Ham Radio Deluxe Logbook is probably the best logbook program and it keeps getting better. As you will see
later, the awards tracking capability is second to none.

In the Logbook section, we'll begin with describing what the operator will see on the screen. We'll follow with how to fully configure
Logbook. Then the feature and functionality will be described.

3.2 Screen Layout
In this section, the default layout of the Logbook screen will be described so that the Operator is familiar with the application's layout.
The configuration and use of these features will be described later.

Application Ribbon - This provides an easy way to change layouts, flip between Ham Radio Deluxe applications, Main and
Sub band tuning sliders, Add Logbook Entry, databases Manager, and configuration. The ribbon will show the user's call and
the main and sub band VFO readings.

Left Pane - This has three functions. Favorites is a quick way to access saved frequencies for quick band and mode changes.
Lookup pane provides a quick way to invoke the callsign lookup function and get information based on what is in the
operator's logbook or lookup source, details about the operator (by callsign), country information. Radio Pane provides a quick
way to access rig control features without flipping over to the Rig Control application.

Audio Recorder - This gives the operator the ability to record audio from the radio's AF source.

Logbook - This tab gives the user the ability to view the recent contents of the log.

DX Cluster - This shows DX spotter information from the DX spotting network.

Clock - This shows the current time.

Grayline Map - This shows the grayline map, with regards to the operator's location.

Band Map - This shows all collected spots for a selected band.

3.3 Setup & Configuration
You will need to go through a few steps to configure logbook.

The setup options for Logbook can be found under the Tools > Configure menu. This section of this manual will review each of these
items in the Configure menu.
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3.3.1 Appearance

There are three options for changing the appearance of Logbook.

Logbook Window
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In this tab, it is possible to configure the application's Font (style and size), colors, and default Time.

It is worth experimenting with these. For example, it is possible to alternate the colors in the logbook pane, making it easier to
read. Those who wish to change the default time between UTC (GMT) and Local time can do so here.

Frequency Display
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In this tab, it is possible to configure the background and text color of the frequency display, as well as the font style of the
frequency.

Rotator Dial
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In this tab, it is possible to configure the colors of the face, markings, and rim of the rotator display.

3.3.2 Backups

IMPORTANT: This is one of the most important sections of this manual. Failure to properly configure Logbook to automatically create
backup copies of your log could lead to very unfortunate circumstances of lost data - up to and including your entire log.

115

http://wiki.ham-radio-deluxe.com/index.php/File:LogbookSetup-Appearance-RotatorDial.PNG


There are a few different backup types as options. All these backups are stored in a file referred to as an "XML file." The main
thing to know about this XML file is that it is a file type that has been optimized to backup or restore the Logbook database.
These options will be discussed first, followed by strategies regarding the storage type and location.

Backup file is an option that creates a stand-alone backup copy of the log. This is a very common method. But because these
files are not compressed, they can take up a lot of disk space if old copies are not managed.

Archives is an option that comes in two styles.

Compress to folder is an option that uses standard Windows file compression techniques to reduce the size of the
backup and put it in a specific folder.

Add to Archive is an option that places an uncompressed copy of the file into a compressed folder (known as a
Windows archive folder).

In all, it is possible to place a backup of the logbook in five different file locations. It is our recommendation that all of them are
used. Further, given that there are so many free cloud storage options available, it is possible to place a backup copy of the
log on Dropbox, Google Drive, Microsoft OneDrive, Box, Apple iCloud... and others. These are generally free services and far
more secure than any disk attached to your computer.

The following video on our YouTube channel demonstrates how to configure backup options "in-the-cloud."

Logbook Backup and Recovery on HRD Software YouTube channel

Backup Databases configures the timing or events that cause a backup to be created automatically. The choices are:

On opening - this causes a backup to be created when the Logbook application launches (In our opinion,
this is the least desirable time to make a backup.)

• 

On closing - this causes a backup to be created when the Logbook application closes (In our opinion, this
is highly desirable.)

• 

Every x changes - this is useful when the operator desires to create a backup after adding a certain
number of QSOs into the logbook. There are a number of standard options to chose from.

• 

Every x hours - this is useful when the operator desires to let Logbook create the backup on a timed
basis.

• 

Because these files are created frequently, it is recommended that a strategy be used for deleting very old backup copies to
avoid taking up excessive storage space.

Guidance about restoring a logbook from backup will be discussed in a different section of this manual.
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3.3.3 Bands

This is where it is possible to add custom band ranges. This may be useful for SWL or MARS operation. It is recommended that the
standard bands included with Logbook remain unchanged.

To add a band, click on the Add button and the following dialog box appears:
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Simply add the band in the format of "75m" in the first box. The ADIF field refers to the standard name given to the modes in
the Amateur Data Interchange Format (www.adif.org). A comment is optional.

Bands can be shared and imported using the Load function.

3.3.4 Callsign Lookups

This is a very useful and popular option. It has many choices (methods) for free and subscription-based access to callsign databases.
This feature enables users to lookup a callsign in various callsign databases to obtain information about that callsign's owner such as -
name, address/QTH, email address, locator/grid, age, ham club membership, CQ and ITU zones.

3.3.4.1 Enabling Callsign Lookup Methods
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NOTE: It's important to understand the way this feature works.

The Enabled (selected) methods are shown on the left. The Disabled (unselected) methods are on the right.

The Enabled methods work in the order in which they are displayed. Using the example above as a point of reference, when
the Add Logbook Entry (ALE) form is displayed and a callsign is entered in the ALE, the user may then invoke the callsign
lookup process by using the TAB key or by clicking the Lookup button. Then, the process would work as follows:

The callsign will be looked up in the active logbook. If that call exists in the log, all empty fields will be
populated with the data from the data from that QSO.

• 

Regardless if found by a previous method, the callsign will then be looked up in QRZ.com. All remaining
empty fields will be populated with the data from that QSO.

• 

Regardless if found by a previous method, the callsign will then be looked up in the HRD Country File. All
remaining empty fields will be populated with the data from that QSO. (Though the HRD Country List will
only populate the Country field.)

• 

This process continues through as many selected methods that are included.

CAVEAT: The HRD Country File includes a list of unique calls in a Unique Callsign Database (UCSDB). That information
takes priority over all the enabled methods by design.

RECOMMENDATION: We strongly recommend using the logbook as the first enabled method and the HRD Country List as
the last enabled method. In other words - use them in the order from most specific content to less specific content.

Using the logbook as the first enabled method enables the log to become a de facto UCSDB. Once the user gets a
callsign correctly entered into their log, that same information will be used for subsequent callsign lookups. This is
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helpful for cases where a DXpedition announces a callsign on the first day of operation and is active before the call
is available in the UCSDB or on QRZ.com.
Because the HRD Country List will only populate the Country field based on the callsign's prefix, it should be used
as a last resort. All other sources of information will be more specific and accurate.

3.3.4.2 Lookup Options

This form is used for (a) entering the username and password for enabled methods, (b) configuring Logbook to use data from
a CD, and (c) testing these methods.

The entry of username and password for these methods is self-explanatory.

Data from a CD can be used from the CDROM drive or the data can be copied to a local disk and specified there for faster
access.

The testing mechanism is a very useful tool for investigating cases where the callsign lookup is either not working or rendering
odd results. Simply put a call into the field and click Lookup and the enabled methods will be used to bring back an XML file
with the data in it. That information can be used to investigate the results.

3.3.5 ClubLog
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Club Log users enter their username and password in this form. Users can choose to upload QSOs as they are added to the
log.

NOTE: This is for upload only. There is no download function in Club Log.

3.3.6 DX Cluster

There are 11 tabs that are useful in configuring the DX cluster options.

A DX cluster is a server, usually on the Internet, where hams around the world participate in a form of "crowd-sourcing." That is - hams
around the world share information about where they hear active DX stations on-the-air with other hams connected to this network.
Using the functionality in Logbook, the operator can select a DX spot and the radio will automatically tune to that frequency and mode,
the rotator will direct the antenna in the direction of the DX station, callsign lookup features populate information about the DX station's
licensee, and the computers date and time are populated in the QSO. All the operator needs to do is work the station, save the QSO,
and move on to the next one.

3.3.6.1 Connection

The first step in using the DX cluster feature is to configure the connection.
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This tab provides a list of DX cluster nodes around the world.

NOTE: We recommend using the WA9PIE-2 node because it has the most complete country data that is automatically
updated and it has the best uptime availability of any DX cluster node in the world. WA9PIE-2 is normally connected to as
many as 30 peer cluster nodes around the world. This enables WA9PIE-2 to provide the most complete list of spots to the
operator without the need to surf around to other cluster nodes.

In the upper left, the user can select:
Connect on startup - this makes the DX cluster connection when Logbook starts
Reconnect if connection lost - this causes Logbook to automatically attempt a reconnect, if the connection to the
cluster node is lost (generally due to local network connectivity issues)
Reset Spots on Connect" - this option provides a choice for whether or not the list of spots is discarded when a
connection is made to a different DX cluster node. This is useful when the operator desires to collect some spots
from a standard DX cluster node, then also collect some spots from a skimmer node, and display both or clear
them.

Operators can also add a DX cluster node by clicking the Add button and then entering a Title, (IP) Address (or DNS name),
an IP port, and a username and password where applicable.
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3.3.6.2 Appearance
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This tab provides the ability to change the fonts and row colors in the DX cluster pane.

3.3.6.3 Layout

The layout options are a very important component of the DX cluster pane. This enables the operator to select the fields that will be
included as columns in the DX cluster display.
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The left hand side of this tab shows the available information fields that can be included as columns in the DX cluster display.
The right hand side shows the selected fields that will be included in the DX cluster display.

The selected fields can be arranged in the display by using the up/down buttons above the selected fields.

NOTE: The following guidelines define the source of the data that is being displayed.

Fields that begin with "Spot" display data just as it was received by the DX cluster node without
modification. Logbook is not the source for this information.

• 

Fields that begin with "HRD" display data that is derived by Logbook, based on data in the DX spot and
information available within Logbook. The DX cluster is not the direct source for this information.

• 

Fields that begin with "WSI" provide an indication about whether that country or station has been worked
or confirmed in the past. (WSI, or Worked Status Indicators, will be explained in more detail in a section to
follow.)

• 

Fields that begin with "Member" provide information about whether or not that station is known to
participate in LOTW or eQSL. (QSL Member will be explained in more detail in a section to follow.)

• 

Fields that begin with "Worked" displays information from the log regarding what bands or modes the
spotted station's country has been worked in the past.

• 

There are lots of options here for obtaining rich content from the DX cluster network and displaying it so the operator can
make decisions in real-time about what DX to chase and what pile-ups to jump into.
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3.3.6.4 Selection

The Selection tab defines the behavior of Logbook when DX spots are selected from the DX cluster pane.

Selecting a Spot

There are two choices for mouse click behavior in DX cluster.

When Single-click is selected, Logbook will (a) invoke the callsign lookup for the Lookup Pane (b)
populate the open ALE with information about that spot, and (c) tune the radio to the frequency and mode
of the spot, based on the options selected in the lower right of this dialog box when the operator clicks
once on a DX spot.

• 

When Double-click is selected, Logbook will (a) invoke the callsign lookup for the Lookup Pane (b)
populate the open ALE with information about that spot, and (c) tune the radio to the frequency and mode
of the spot, based on the options selected in the lower right of this dialog box when the operator
double-clicks once on a DX spot. With Double-click selected, a single-click will only invoke the callsign
lookup for the Lookup Pane.

• 

NOTE: We recommend using the "Double-click" because this enables the operator to use a single-click to quickly populate the
Lookup Pane.

ALE Window
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This option defines whether or not Logbook is allows to open multiple ALE windows.

Spider and CC Cluster Options

This is a very important, but often over-looked, feature.

DX cluster nodes have the ability to filter spots before they are sent to you. This is a good idea, given that there's not a real
good reason to receive 160m spots from Greece at 3pm in Chicago. So operators can setup DX cluster filters - on the DX
cluster node itself (not within Logbook) - keep reduce the "noise" of irrelevant spots. For DX Spider and CC cluster nodes, the
command "sh/dx" sends the first "lot" of spots (quantity specified in the Connection tab) unfiltered. The "sh/mydx" causes the
initial "lot" of spots to honor the filter options that the operator has set directly on the DX cluster node. Given that - in the
absence of filters - these two commands have the exact same behavior, we strongly recommend using the "sh/mydx" option.

Region is where you select your ITU region. This invokes the appropriate "band plan" for your location.

The option boxes on the right enable you to turn on or off the automatic rig tuning for frequency, mode, and QSX (and reset
split, which are strongly recommended except for DX station).

"Limit Comment to 30 Letters" causes the comment field in the spot to be truncated at 30 characters.

3.3.6.5 Spot Filters

NOTE: Before continuing, it's important to distinguish the difference between "server-side" filters and "client-side" filters.

"Server-side" filters are created by the operator, outside of Logbook, on the DX cluster node itself. These filters prevent spots
from being sent to Logbook. These are most useful when the operator desires prevent spots from a geographically irrelevant
part of the world to come to Logbook. These types of filters will not be discussed in this manual. The following resources are
online and available to explain "server-side" filters in more detail:

DX Spider Filtering Manual: http://wiki.dxcluster.org/index.php/DXSpider_Filtering_Manual (including
WA9PIE-2)

• 

CC Cluster Filtering Manual: http://bcdxc.org/ve7cc/ccc/CCC_Commands.htm• 
AR Cluster Filtering Manaul: http://www.73.ru/help/cluster/ArcFilters.htm• 

"Client-side" filters; The spot filters in Logbook are "client side" filters. They work by "hiding" spots that have been received
from the DX cluster node (server) into the DX cluster pane in Logbook. This guide will focus on how these filters work in
Logbook.

The Spot Filters tab enables the operator to create filters for the data being delivered to the DX Cluster window (ie. after the application
of server?side filters). These filters are displayed in the dropdown menu in the DX Cluster window.
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Logbook contains the most common filters. Operators can create additional filters on their own using default filters as their
guide.

One useful filter to create is a filter that combines HF frequencies with 6m (given that many modern HF rigs include 6m). To
create this one either click Add or select the HF filter and Copy, then Modify:
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Name the filter "HF + 6m", enter the "Freq min" and "Freq max" values (in MHz) of 1.800 and 54.000. Set the "Max entries" to
a desirable number. Then click "Ok".

The Up/Down buttons enable the operator to arrange them in the desired order in the dropdown list (which will be covered in
more detail in the DX cluster section of this guide):

3.3.6.6 WSI

WSI stands for "Worked Status Indicators" and it is a very important tool for DX award-seekers. This feature was dramatically improved
over the Ham Radio Deluxe 5.x versions. The WSI will now indicate whether the country has been worked at all, worked - but not
confirmed, or worked - and confirmed. Using WSI properly will absolutely accelerate your progress in the DXCC awards program.

There is also a WSI that will indicate whether or not the specific callsign ("station") has been previously added to your log.
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As indicated in the reference information in the WSI tab above:

Country

Indicates that the spotted country has been Confirmed on that band or mode.

Indicates that the spotted country has been Worked, but not Confirmed on that band or mode. This is very
important to DX awards enthusiasts, because most awards require some proof of confirmation.

 Indicates that the spotted country has not been Worked on that band or mode.
Station (callsign)

 Indicates that the spotted station has been Worked previously and is in the log (regardless of band or mode).

 Indicates that the spotted station has not been Worked previously and is in the log (regardless of band or
mode).
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The Light Pole option allows operators who have connected a light pole to their computer to use it to indicate these same
colors for incoming spots.

"User ONLY open logbook for WSI" causes the active logbook to be the only database queried for WSI.

On the right hand side of the WSI tab, it is possible to configure the WSI to color-code the rows in the DX cluster for needed
bands and modes. It should be noted, however, that (a) the colors may be difficult for those who have color-blindness issues
and (b) the granularity of the colors does not provide as much information as the symbols on the left. Use sparingly.

WSI examples will be discussed in the DX cluster section of this guide.

3.3.6.7 Alarms

The operator can setup alarms that will alert them by E-Mail (including a text message to a cellphone), Text to Speech, or with the
Lightpole.

The example above shows how to create a number of alarms for needed countries and zones. To build an alarm, click Add to
bring up the following Add/Modify Alarm Definition dialog box.
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As an example, we'll build an alarm for a callsign that will be operating from Kerguelen.

Give the alarm a name in the Title field, we'll use "Kerguelen"• 
Enter the specific callsign we want an alarm for in the Callsign field.• 
Enter the interval in minutes for which alarms can be sent.• 
Select the delivery options from the Options below• 
Click on the box to the left of "Enable"• 
Then click "OK"• 

The new alarm is now active.

3.3.6.8 Alarm E-Mail

This tab enables the operator to configure Logbook to send alerts via email (per the alarms enabled in the Alarms tab).
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There are a number of pre-populated options for sending email. They include - AOL, Gmail, Hotmail, Yahoo!, MSN, Lycos,
Mail.com, and Netscape. The dropdown box populates the required information.

NOTE: If using Gmail, Google requires that you change a setting in your email account to allow "Access for less secure apps".
Google this phrase for additional information.

You will need to enter the username and password for your selected email account in the fields provided.• 
Add your email address into the "Outgoing e-mail address (from)" field.• 
Add your destination email address in the "Outgoing e-mail address (to)"• 

TIP: It is possible to send directly as a text message to your smartphone. For example, Verizon Wireless smartphones would
be addressed at <your phone number>@vzwpix.com. Check your carrier for your specific details.

You can test this by clicking the "Send Test" button.

Click "OK" to complete the setup.

3.3.6.9 Alarms:Speech

This table enables the operator to configure speech alarms from your computer speakers.
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Select the desired options and click "Speak" to test them.

3.3.6.10 QSL Members

When viewing the DX cluster, it's desirable to know whether the spotted station participates in Logbook of the World or eQSL (explained
further in the DX cluster section of this user guide).
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The eQSL and LOTW import URL fields are shown with Reset buttons.

NOTE: We strongly recommend that you do not change these URLs unless instructed to do so by HRD Software, LLC. In
case they are accidentally changed, the Reset button will set them back to their original URLs.

The two rows show the number of callsigns in the eQSL and LOTW files that have been downloaded.

The Update button forces an immediate update.

NOTE: We recommend using both the eQSL and LOTW boxes for "Auto" and that you do not check the "Ask before doing
automatic updates" box. This will ensure that Logbook will check for updates each time you launch Logbook without being
prompted.

3.3.6.11 Your Information

This tap provides information about the Locator (gridsquare) and Region with a display on the Greyline map for reference.
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NOTE: It is strongly recommended that this page be used only for reference. Changes to Locator (gridsquare) are best made
on the "My Station" form.

3.3.7 eQSL.cc
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eQSL users enter their username and password in this form. Users can choose to upload QSOs as they are added to the log.

3.3.8 Favorites

The operator can setup frequently visited frequencies and modes as Favorites".
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3.3.9 HRDLog.net

HRDLog users enter their username and password in this form. They can choose to upload QSOs as they are added to the log.
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NOTE: This is for upload only. There is no download function in HRDLog.

The On Air function enables Logbook to report your frequency, mode, and radio for display on HRDLog.net in real-time.

3.3.10 Modes

This is where it is possible to add custom modes. This may be useful when new modes are created before we can update them in the
software. Otherwise, it is recommended that the standard bands included with Logbook remain unchanged.
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To add a band, click on the Add button and the following dialog box appears:

Simply add the mode in the format of "FT8" in the first box. The ADIF field refers to the standard name given to the modes in
the Amateur Data Interchange Format (www.adif.org). A comment is optional.

Modes can be shared and imported using the Load function.

3.3.11 My Station

If you have not already set up the necessary information within my station you will need to do that now. This will prove to be critical later
so best do it now.
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1. From within Logbook select from the Tools menu, Tools > Configure > My Station.◊ 

2. Information in the My Station screen is used by Ham Radio Deluxe Logbook◊ 

and DM-780.

Note: If you have already set up the DM-780 portion of the suite, this screen should be populated with the required
information and you can just close it out and continue with the set up.
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My Station Set Up
Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you to have a Home location as well as other locations such
as a vacation home or favorite portable locations.

Multiple Callsigns

If your License Manager shows more than one callsign such as for parent and child or husband and wife, you are able to enter station
set up information for each callsign. You can also set up ?Guest? accounts for club or special event stations.

If you haven?t already set up the My Station data, in the Description field you see the word HOME for a profile of your Home QTH. This
generates your main location. Then go ahead and fill in all the rest of the information for this location. Please note which fields are
required if you use one of the DX Clusters.

Most of the fields are self-explanatory. A couple of the fields do need a little explanation. The field SIG stands for Special Interest Group.
This could be a club or any organization you belong to. The SIG Info field could be a website address for a group. You could leave these
fields blank if you like.

142

http://wiki.ham-radio-deluxe.com/index.php/File:Page-115-Image-186.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-115-Image-185.png


Another spot you might need help is once you enter your Locator, for example EN36QR, if you hit the little arrow that points downward,
that will automatically fill in your Latitude and Longitude fields.

If you operate from mobile or maybe have a vacation home, you can generate My Station profiles for those locations as well by clicking
on the Add Location button. You can copy the data from the Home location to be placed in an additional location then just edit anything
that is to be different for that profile. Each profile is auto-saved when you exit the screen by clicking the red X in the upper right corner.

THIS SECTION NEEDS UPDATING

3.3.12 Network Server

Network Server is the feature in the application that allows other programs to make a connection to HRD Logbook. Normally, it is
recommended to leave these settings as-is to enable DM-780 to connect to Logbook without issues.
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Startup

Autostart causes the server to be active when HRD Logbook is running (default is checked).
Same PC connections only determines whether connections are made from the local computer (localhost) or across
a LAN or WAN (default is checked).

Database

The target logbook is selected here.

A connection logfile is available.

3.3.13 QRZ.com

This is the setup page for QRZ.com Logbook (not callsign lookups).

144

http://wiki.ham-radio-deluxe.com/index.php/File:NetworkServer.PNG


It's necessary to login to QRZ.com Logbook and obtain an API key from QRZ.com first. Enter that key here. Then choose
whether or not to upload QSOs automatically.

3.3.14 QSO Forwarding

This option provides an application programming interface (API) in and out of HRD Logbook.
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UDP

Forward logbook changes using UDP to other logging programs
Receive logbook changes using UDP from other logging programs (TR4W, N1MM, etc)

Send Address (localport, the internal IP address to the machine, is the default)
Send Port should be configured for the port that the 3rd party software will connect to
Receive Port will be the port configured for receiving data

NOTE: These ports must be different.

Fill in missing fields on Receive (checked by default)

Lookup missing fields on Receive (unchecked by default)

3.3.15 Radio Pane

There are two configuration tabs for configuring the rig settings into Logbook.

3.3.15.1 Connection

This tab configures the radio connection to Logbook. Generally, the defaults should be left as-is.
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Address is the IP address that Logbook is making a rig control connection to (localhost by default)
Port is the IP port being used (cannot be the same as other used ports; 7809 by default).

Automatically connect is checked by default with "Normal" Update Speed.

Operator can choose to connect to the last radio when Logbook launches. This is used when multiple radios are configured.

3.3.15.2 Default Layout

This enables the operator to add or remove buttons in the rig control pane. This is useful when it's faster to get to the radio pane in
Logbook than to switch over to the Rig Control application.
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3.3.16 Rotator
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In this tab, it is possible to configure the colors of the face, markings, and rim of the rotator display in Logbook.

3.3.17 RST Options

All modes have default values for RST loaded into Logbook. This data will be maintained through future software releases. Therefore,
generally, these should not be changed.
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The default items are shown in the image above.

150

http://wiki.ham-radio-deluxe.com/index.php/File:Logbook-RST-Options.PNG


In the RST Definition, all the modes included are on the left. They can be included (selected) into this definition. The RST
values are on the right. These will be listed in the ALE for these modes. The default values are shown below.

3.3.18 Sharing

This dialog box provides polling when an Access database is shared between multiple computers running HRD Logbook.
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When using MySQL or similar variants (MariaDB, etc).

3.3.19 Tuning Dial

This dialog box enables the operator to configure the rig control tuning dials within Logbook.
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Bands are created an enabled in the Bands tab.

153

http://wiki.ham-radio-deluxe.com/index.php/File:Logbook-Tuning-Bands.PNG


For information on configuring Favorites, visit the following Rig Control description of this same option -
http://wiki.ham-radio-deluxe.com/index.php/Main_Page#Favorites
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The colors and fonts can be changed in the Dial tab.

3.4 Managing Logbook Databases
Database
Ham Radio Deluxe Logbook is built on Microsoft Access. The driver normally used is the Microsoft Access Driver (*.mdb)ODBC driver.
You do not need a license to use Access databases - the runtime DLLs are included in Windows 7 or newer.

You can create and manage additional databases for use within Logbook. You can, if you desire, create a separate database
for contest work or a special event. Beware that this can create issues if you are interested in awards tracking.

To manage your database(s), select Manager from the Toolbar.

This opens the Logbook Databases window.
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Within this window you can add new or modify existing databases.

Other Databases

Logbook can be built on MySQL if you choose. Support for MySQL is beyond the scope of this document.

Other (non-Ham Radio Deluxe) logbooks are supported via a DDE interface (see DDE Support on page 90) and a serial port
(see 3rd-Party Programs on page 94). So you can use the logbook of your choice with Ham Radio Deluxe provided it supports
DDE or the Kenwood protocol via a COM port.

3.5 Creating & Managing QSOs
3.5.1 Add Logbook Entry (ALE)

Ham Radio Deluxe Logbook has a number of powerful features for tracking QSO data. This information is contained within the Add
Logbook Entry (ALE) window and its fifteen tabs. This section will describe these areas. The ALE window is opened by clicking on the
Add button in the toolbar.

3.5.1.1 Menu Bar

But first, it?s necessary to understand the options for the ALE. The ALE?s menu bar has a number of menu items.

Options

Clicking the Options menu renders the following choices:
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The Times option can be selected for UTC or Local time.

The Start and End times can be set according to the operator?s operating style.

Recommendations

DXers and Contesters should use Current Time in the Times selection. This uses the time of the
computer clock when the QSO is logged. Because DX and Contest exchanges are so short ? lasting for
only a few seconds ? there?s an increased likelihood of making a QSL match to services like LOTW if the
QSO is set to Current Time.

• 

Rag-chewers may want to use Set by user. This accommodates QSOs of longer durations.• 

Font Option

This enables the operator to change the fonts used in the dialog ALE.

QSL Defaults

This enables the operator to choose the initial values for the three QSL fields. This is helpful when using a value like Queued
to set the LOTW value so that it?s easy to do a search for QSLs that need to be uploaded to LOTW.

RST Rcvd / Sent

This provides options for canned values of RST.

Button Position

The operator can select from bottom, middle, and right side location of the Update, Cancel, Reset, and Add Spot buttons. This
is useful when vertical or horizontal space is restrained.

Menu Position

The choices of positioning the menu on top or bottom are provided.

Other options
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Toggle on/off options

Show Tooltips• 
Save VFO B in database• 
Keep Propagation Mode• 
Mirror Locator on Location Tab• 

Show Worked Status

This option enables a W icon to display for Call, Country, and Locator fields. This lets the operator know that these items have
been worked before.

Tracking

The Tracking menu enables the ALE to use the data coming from the rid for frequency or mode and automatically populated
into the ALE. (Default is ON for both.)

Show:Fields

This option enables the operator to choose which of the thirteen fields will be displayed in the ALE. (Default is all ON.)

Show:Tabs

This option enables the operator to choose which of the fifteen tabs will be displayed in the ALE. (Default is all ON.)

3.5.1.2 Logbook Tab

The Logbook tab which is the first of many tabs at the bottom of the ALE window provides detail on previous QSOs with the station
being logged. Partial and Exact matches are options.
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3.5.1.3 Worked Tab

The Worked tab provides detail about previous QSOs with that callsign, country, continent, zone, IOTA, or locator? by band and/or
mode.

3.5.1.4 Country Tab

The country tab contains the DXCC information about the country being logged. This data is ?display only? and is not saved in the QSO
record. As such, it's dynamically displayed.

3.5.1.5 Contact Tab

The Contact tab provides a place to store information about the station operator?s age, Special Interest Group (SIG, or club), SIG
website, email address, website URL 10-10 number, equipment, and biography. Callsign Lookup sources often provide much of this
information.

3.5.1.6 Location Tab

The Location tab provides a place to store information about the station operator?s location ? including State/province, City (QTH),
County, ARRL Section, postal address, CQ and ITU Zone, continent, distance, and polar coordinates. Callsign Lookup sources often
provide much of this information.

3.5.1.7 IOTA Tab

The IOTA tab provides a place to store information about the IOTA reference number and Island name.
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3.5.1.8 Antenna/Satellite Tab

The Ant/Sat tab provides a place to store beam heading and satellite information.

3.5.1.9 Award Tab

The Award tab is for tracking the award credits within the various awards programs. A QSO record cannot have both Submitted and
Granted status for a given award. Selecting one de-selects the other. More information about the use of this tab can be found in the
Awards Tracking section of this manual. These values are determinants of what is displayed in the Not Submitted, Submitted, and
Granted columns in the Awards Tracking tab.

3.5.1.10 Contest Tab

The Contest tab provides a place to store data related to contest exchanges.

3.5.1.11 Custom Tab

Six Custom fields can be defined and used by the operator. This is useful for tracking awards that are not hard-coded within Ham Radio
Deluxe such as Summits on the Air (SOTA). Clicking on the Configure button enables the operator to rename these fields.
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3.5.1.12 My Station Tab

The My Station tab is particularly useful when the operator has multiple operating locations. The operator can select from profiles
(stations) created in Ham Radio Deluxe Logbook.

3.5.1.13 Propagation Tab

The propagation tab saves solar data into the QSO record. Be sure to check the Track box to turn this feature on. The information
comes from the most recent WWV or WCY information.

3.5.1.14 QSL, eQSL.cc, and LOTW Tabs

The QSL tab is for tracking paper and electronic QSLs. QSL Sent and Rcvd have the following values:

QSL Rcvd:

Y yes (confirmed); an incoming QSL card has been received, or the QSO has been confirmed by the online service

N no; an incoming QSL card has not been received, or the QSO has not been confirmed by the online service

R requested; the logging station has requested a QSL card, or the logging station has requested the QSO be uploaded to the online
service

I ignore or invalid

V (deprecated) verified

QSL Sent:

Y yes; an outgoing QSL card has been sent, or the QSO has been uploaded to, and accepted by, the online service

N no; do not send an outgoing QSL card; do not upload the QSO to the online service

R requested; the contacted station has requested a QSL card, or the contacted station has requested the QSO be uploaded to the
online service

Q queued; an outgoing QSL card has been selected to be sent, or a QSO has been selected to be uploaded to the online service

I ignore or invalid
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Note: These values are determinants of what is displayed in the Confirmed and Need QSL columns in the Awards
Tracking tab.

3.5.1.15 Logbook Search

The Filter button enables the operator to perform a logbook search, based on selected field criteria.

Once selected, the operator can find QSOs based on Callsign, Date range, and a combination of any three additional fields.
This is helpful when trying to find something unique in the log. These types of database queries are also used in displaying
awards totals.

QSL Filter

The QSL filter button enables the operator to search and update QSL Status in bulk. This is helpful when printing a significant
number of QSL cards over a given date range.

Award Filter
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The Award filter button enables the operator to search and update award tracking status in?bulk. This is helpful when making
an award application.

3.5.2 Bulk Editing QSOs

The bulk-editor is a powerful tool for making mass changes to the data in the logbook. It is highly recommended that a logbook back be
made prior to using this tool.

To use the bulk-editor, first select a number of QSO records where the same change is desired by using the ?Filter? (search)
or by selecting some number of records manually within the log.

There are a number of places to find the Bulk Editor menu option. To use one as an example, right-click on any of the
highlighted QSO records, and select one of the provided options.

Any Fields is a very powerful choice, as it enables the operator to change anything in the database in mass (use with care).
For this example, Any Fields is selected and the option to backup the logbook is provided.
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1. Select Any Fields.
2. Next, select the ?Add Field? button.
3. Select the desired field (CQ Zone, in this example)
4. Enter the desired value (10, in this example)
5. Click ?Ok?

All the selected QSO record will be updated with the desired value.

3.5.3 Importing Log Files

Logs can be easily imported from other logging programs. To import a log from another logging program, follow these steps:

1. Export the log into ADIF format from the other logging program. Make sure that it is configured to provide all
available fields.
2. From the menu in Logbook, select Logbook >File > Import, and then choose the relevant option from the list of
five shown. Most often, ADIF 2 is used.

164

http://wiki.ham-radio-deluxe.com/index.php/File:Page-141-Image-275.png


3. Then select the ADIF file for input by clicking the button to the right of ?DIF Filename. The recommended options
are shown here:

NOTE: It is strongly recommended that the top two boxes are always checked. This will ensure that the country
stands the best chance of being converted correctly. Use the "Insert Local Station Information on Import" with care.
If you have older QSOs in your log, and a newer QTH, you may not want to have the old QSOs show up in your log
under the net QTH.

4. Once the file has been analyzed, the results will be shown. select Save to Database?.
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If there are errors in the source ADIF, the operator will see this in the results displayed below. Make note of them. It may be
necessary to clean up the source data - using the errors as your guide - and attempt the import again.

NOTE: Be aware of the ?garbage-in/garbage-out? scenario. The information provided in Ham Radio Deluxe
Logbook (for awards and QSO fields) is only as good as the data that comes from the other logbook source. There
will always be some anomalies that the operator will have to sort out. This is generally because other programs may
not have country data that is up-to-date.

3.5.4 Exporting Log Files

Logs can be easily exported for import into other logging programs. To export a log from Ham Radio Deluxe Logbook, follow these
steps:

1. From the menu in Logbook, select Logbook > File > Export, and then choose the relevant option from the list of five shown.
Most often, ADIF 2 is used.
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2. Provide the export filename by clicking the button to the right of ?ADIF Filename?.

3. Options are provided to select the field set for exporting.
4. The operator can export All or Selected logbook entries.
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Tip: Exporting selected logbook entries is a great way to update standalone logbook databases located on
multiple computers.

• 

3.5.5 Backup and Restore

Operators are encouraged to allow the automatic log backup to keep their log data safe.

The ?Automatic Backups? is found in the file menu under Tools, Configure, Backups. Backup files are saved in a proprietary
XML format that ensures that information that is unique to Ham Radio Deluxe Logbook (like user-defined fields) are safely
backed up. Some, but not necessarily all, of the backup locations should be used.

Note: For this reason, making copies of ADIF files is not considered a backup method. Using an ADIF as a backup
method could result in data loss. ADIF is an ?amateur radio interface format? and was intended to interface logs
between dissimilar systems by defining common fields.

The Backup file field is the folder where the native XML file is created. This is the most commonly utilized backup file.

The configuration of the backup function is described in more detail in the Configuration section of this guide.

3.5.6 Country Data

Ham Radio Deluxe utilizes a country and prefix database that is roughly equivalent to the AD1C list (http://www.country-files.com). The
country data itself doesn?t require constant maintenance. It is updated when new countries are added or removed from the DXCC list or
when unique callsigns are in use that do not easily map to standard prefix parsing algorithms. The prefix masks contained within this
data is rather complex and it is recommended that operators do not modify it. Updates will be made as frequently as necessary.
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The countries information can be seen by clicking on Countries and then Manager within the Logbook main menu.

From here, users can also access the Unique Callsign Database by clicking on the ?Unique Calls? button.

This prompts the operator for the Public or Private UCSDB.

It is recommended that operators do not add or modify the entries in the Public UCSDB. These will be maintained and
updated as frequently as necessary by Ham Radio Deluxe Software. Operators can create entries in the UCSDB by clicking
Private and entering specific information about a callsign.

Clicking the Add button provides a dialog box that the operator can use to enter the information.
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NOTE: While this method can be very effective, the operator should consider that using the Logbook as a callsign
lookup source provide the same capability in real-time. That is ? if the operator gets a call logged to the correct
country on the first QSO, then the need to maintain a Private USCDB is unnecessary.

Hint: The lookup methods already use the Public UCSDB to assist the operator in logging the QSO to the correct
country on the first try.

3.5.7 External Log Interfaces

Ham Radio Deluxe Logbook has the ability to interface with a number of external online logging and awards systems. Presently the
following systems are supported - LOTW, eQSL, HRDLog.net, and ClubLog.

Logbook of the World (LOTW) is supported when the Trusted QSL application is installed (required). Configuring LOTW is as follows:

LOTW Download

Click the LOTW Download button, or access the download function through the Ham Radio Deluxe Logbook menu by
selecting Logbook, File, LOTW, Download. The following dialog box will be displayed.

NOTE: Trusted QSL is not used or required for LOTW Download.
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1. The LOTW URLs should not be changed or the download will not work correctly.
2. The operator adds the Username and Password for the LOTW account.
3. The ADIF field will populate automatically and it?s rarely necessary to change it.
4. Select a date range.

Hint: By default, the download will begin where the last one left off.
5. Then click the Download button and the results will be shown after the file is downloaded.
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If there are any errors in the downloaded file, they will be described in the above dialog box. Most commonly, there is a
mismatch between the mode or band for the data previously uploaded to LOTW and the data in Ham Radio Deluxe Logbook.
This will tell the operator what needs to be resolved. Then a repeated upload will be successful.

6. Click Save To Database
7. Click Finish

Hint: This is the method that updates the QSL and (some) Award status fields in the Awards Tracking
module. You will have to hit the Refresh button in the Awards Tracking tab in order to update the totals.

LOTW Upload

Begin by selecting the QSOs that the operator wants to upload. From within Logbook, this is done by using the Ctrl button and
either left-click or shift-click to select records.

Then click the LOTW Upload button, or access the download function through the Ham Radio Deluxe Logbook menu by
selecting Logbook > File > LOTW > Upload.

NOTE: TrustedQSL is required for LOTW Upload. The following dialog box will appear:
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1. The LOTW URLs should not be changed or the upload will not work correctly.
2. The operator adds the Username and Password for the LOTW account.
3. The operator must tell Ham Radio Deluxe Logbook what folder TrustedQSL is installed.
4. If a Private password is used in TrustedQSL, it must be entered into the provided field.
5. The Station location must match exactly to the station location created and listed in the TQSL application under Add/Edit
Stations.

HINT: This is the most frequent cause of upload failures. The file fields will populate automatically and it?s rarely
necessary to change them.

6. Then click the Upload button and the results will be shown after the file is uploaded.

Tip: In order to know which QSOs to upload, it is quite helpful to add the LOTW sent field to the logbook layout (by
clicking the Layout button and adding LOTW sent). Select the QSOs where LOTW sent is No before clicking the
LOTW Upload button.
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3.6 DX Cluster
The configuration of the DX cluster is discussed in the Logbook Configuration section. This section will discuss the use of DX cluster
features.

DX Cluster Status Bar

DX Cluster connection status bar shows four things (using the information in the above image as an example to describe it):

The operator's station (WA9PIE-10),• 
is connected to a DX cluster node (WA9PIE-2),• 
which is a DXSpider type node, and• 
there is one active DX alarm.• 

Connect or Close a DX cluster connection with the button on the far left.

The Show menu is very important and it does five things:

Spots - Displays the DX spots received from the connected DX cluster node; or submit an DX spot on the
DX cluster system or node

• 

Announcements - Displays announcements that have sent to stations connected to the DX cluster system
or node; or submit an announcement on the DX cluster system or node

• 

WCY - Displays solar weather from DK0WCY solar weather bulletins• 
WWV - Displays solar weather from WWV solar weather bulletins from NIST• 
Console - Displays the raw data sent and received between Logbook and the connected DX cluster node.
This is very important for troubleshooting.

• 

NOTE: Many users are unaware of this feature. It can be very useful. Remember to change back to Spots after looking at
these selections. The dropdown menu will always simply display "Show".

Cluster Filters are changed using this dropdown.

WSI Filters are changed by using this dropdown. Generally, this is a very important feature. It will hide spots based on what
you have not yet Worked or Confirmed by Band, Mode, or both (Band+Mode).

Copy the contents of the DX cluster to the Windows clipboard.

View the contents of the DX cluster in a Notepad text file.

Cluster Alarms Manager is a shortcut to enable, create, or manage DX cluster alarms within Logbook.

DX Cluster Options is a shortcut to access configuration options for DX cluster.

Silence Alarms quiets active audio alarms.

QRZ.com opens the QRZ.com information page for a selected DX spot.

Spot is a shortcut for submitting a DX spot .

The number of spots displayed or updating with the current filter settings are shown at the right of the Spot button. This is
useful when changing filters, as the operator is able to see the status of spots being updated in the display.

The information in the DX cluster is displayed in the following tabular format:
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This is rather self-explanatory. The operator can add, remove, or rearrange the columns displayed here using the "Layouts"
tab in DX Cluster Options. The meaning of the columns are best found in description section of that Layout tab.

The operator can right-click on a spot in the display and the following shortcut options are displayed:

New ALE Window opens a new logbook entry form for the selected spotted call• 
QRZ.com opens the QRZ.com information page for a selected DX spot.• 
Copy Line copies the contents of the DX cluster to the Windows clipboard.• 
Copy Raw Spot opens the contents of the DX cluster in a Notepad text file.• 

3.7 Awards Tracking
The Awards Tracking module in Ham Radio Deluxe Logbook provides the most complete award tracking features of any software
available on the market. It tracks over 200 awards and endorsements in sixteen awards programs. Additionally, users have the ability to
create and track additional awards of the operators choosing.

3.7.1 Introduction

To open the Awards Tracking tab, click on the Awards Tracking icon in Logbook.

The Awards Tracking tab will be displayed. On the left of your screen you will see a list of sixteen Award Programs that are
currently supported by Ham Radio Deluxe.

To the right of the list of awards programs, you will see the awards totals for the selected awards program (DXCC, in this
example). When the award name is followed by ?(Ham Radio Deluxe)?, this signifies that the award is hard-coded into the
program and cannot be modified. It is possible to copy these hard-coded awards and customize them to suit the user?s liking
(this will be covered later). The awards totals panel consists of ?rows, columns, and cells? ? similar to a spreadsheet.
Understanding the meaning of the rows, columns, and cells is an easy but important step in using the awards feature. All
awards programs conform to this format.

The rows represent awards or endorsements within the selected awards program.

Endorsements are listed beginning with an asterisk below the related award.
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The columns represent QSO, QSL, and Award credits within the selected awards program.

Column descriptions are as follows:

Worked - This is the total number of entities within the awards program that have been worked,
regardless of QSL or award credits. This is a QSO status column.

• 

Confirmed - This is the total number of entities within the awards program that have qualifying QSL
confirmations. Each awards program accepts different QSLs (for example, QSL cards, eQSL, and LOTW
confirmations may not be accepted for all awards). The award is created to only include the QSL types
relevant for that award. This is a QSL status column.

• 

Need QSL - This is the number of entities within the awards program that have been worked but not
confirmed. The information directs the operator to the QSOs that can be pursued for confirmation. This is
a QSL status column.

• 

Entities Needed - This is the number of entities within the awards program that have not been worked.
This is a QSO status column.

• 

Not Submitted - This is the number of entities within the awards program that have been confirmed, but
not yet included in an awards application. This information will be used by the operator to make an
awards application. QSOs are not included in this total once they have been included in an application
and appear in the Submitted column. This is an awards status column.

• 

Submitted - This is the number of entities within the awards program that are part of a current application
and awaiting approval. QSOs are not included in this total once they have been granted award credit
within the program and appear in the Granted column. LOTW download provides this data for
confirmations obtained through LOTW. This is an awards status column.

• 

Granted - This is the number of entities within the awards program that have been included and approved
for award credit. LOTW download provides this data for confirmations obtained through LOTW. (Cards
included in applications prior to LOTW are not included in the LOTW download information and must be
added manually.) This is an awards status column.

• 

Note: The ?Not Submitted?, ?Submitted?, and ?Granted? awards status columns are ?transitional?
columns. That is ? a given QSO can be in only one of these columns.

3.7.2 Award Reports

The awards feature in Logbook acts like a calculator that counts things. It would count things in Logbook where the entity selected match
to the awards and QSO and QSL statuses indicated in the report.

The data that rolls-up to the totals in these columns come from information contained within the QSO records in the logbook
as follows:
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The Worked, Confirmed, Need QSL, and Entities Needed data comes from the QSL, eQSL, and LOTW tabs in the ALE. The
Not Submitted, Submitted, and Granted data comes from the Award tab in the ALE. When the Award tab is not populated
automatically from the online system (like LOTW), the information should be populated manually when applications are made.
(Again, a given QSO cannot have both Submitted and Granted values. Selecting one de-selects the other.)

The cells provide the totals for the column within the selected award. When you double-click on a cell, it will produce a list of
the entities that represent that total. For example, the following image indicates that there are ten entities worked for the
DXCC Digital award where QSLs are needed:

Double-clicking on the ?10? provides a list of those entities:

There are three choices for displaying the QSOs represented by this list. These three choices are available in the Filter icon in
the icon bar above the list. Clicking this button ?toggles? the filter between the three values.
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The Filter [Off] condition assumes that the operator wants to see all the QSOs among the list of entities shown. This is most helpful for
chasing QSL cards (Need QSL column), where the operator wants to see all the QSOs with the displayed list of entities.

The Filter [Oldest] assumes the operator wants to see only one QSO among the list of entities shown. This is most helpful for making
award submissions (Not Submitted column) where only one qualifying QSO is needed.

 The Filter [Newest] assumes the operator wants to see only one QSO among the list of entities shown. This is most
helpful for making award submissions (Not Submitted column) where only one qualifying QSO is needed.

Once the desired filter is selected, the operator can display the results by clicking the View All button.

3.7.2.1 Example 1

What QSOs do I need to obtain cards from to increase my DXCC Digital Awards confirmation?

Going back to the ten entities in the Need QSL column, the operator would want to select Filter [Off] and View All. This would
render a complete list of QSOs with those ten entities where a QSL could be obtained.

Notice that, for the 10 entities where a QSL is needed, there are fourteen QSOs. This gives the operator the ability to decide
which QSOs to pursue. The operator can select QSOs in this view and print QSL cards or labels from this list.

Hint: Select Ctrl + A will select all the QSO. Press the Ctrl button, while clicking individual QSOs, will select a number of
individual QSOs as desired.
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3.7.2.2 Example 2

What QSLs do I need to submit to include in my next awards application for the DXCC Phone Award?

The awards totals indicate that five QSLs are ready for to be submitted in an award application:

Double-clicking on the ?5? generates a list of the entities that will be submitted:

Because there may be more than one QSL for some of these entities in this list, I will select Filter [Oldest] and View All. This
provides the list needed for submission:
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The operator can print this list by clicking File/Print in the Ham Radio Deluxe Logbook menu. Additionally, the operator can
save this list as an Excel or delimited text file so that the information can be combined into a single award application.

Clicking on the Matrix button generates a matrix report for the selected awards program. This is very similar to the style of
report that is provided by the ARRL for DXCC awards. But this report shows Granted (G), Confirmed (C), and Worked (W)
countries by award.
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3.7.2.3 Creating Custom Awards

Operators can create (define) their own awards by selecting the Definitions button in the Awards Tracking tab.
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The operator can create a new award based on one of the hard-coded (Locked) awards by selecting one and clicking Copy,
or build a new award from scratch by selecting Add.

Because the awards definition builder is very flexible, it would be hard to describe a specific example. It is recommended that
the operator tinker with this by creating a copy of a hard-coded (Locked) award and learning it through trial-and-error.

Main Page
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4 Digital Master DM780
4.1 Introduction
DM-780 is a very sophisticated, feature packed, program that allows you to send and receive many of the popular amateur radio digital
modes, including SSTV and several PSK versions using a computer sound card. It supports AFSK modes as well as FSK RTTY.

The program integrates with the Ham Radio Deluxe Rig Control program to control band and frequency changes without exiting the
program. It?s also integrates with the Ham Radio Deluxe Logbook to allow easy callsign look-ups and logging of your digital contacts
through its built-in Add Log Entry (ALE) screen.

DM-780 has features not found in any other program on the market today. The SuperSweeper gives you the ability to view and decode
multiple signals using CW, BPSK and RTTY in single window. You can also enable the SuperSweeper History file to keep track of and
display information about callsigns you have heard from your location.

The SSTV module has a built-in editor for creating templates for your outgoing messages on background pictures from your own photo
collections. It can also place an incoming picture within one of your outgoing pictures so your contact can see just exactly how his
transmission looked when you received it. These are just a few of the many great features of DM-780.

4.2 Getting Started

Start DM780 from within your Ham Radio Deluxe application by clicking on the DM780 button in the toolbar. For now continue to use the
Dem-o-matic TS-2000 rig if you do not have a data interface with your radio.

When you first open the DM780 for the first time you will see a Getting started dialog that you must complete. The first item of
business is entering your callsign.

1 Click where is says Click here. This will open the Programs Options window.◊ 
In the first dialog line your callsign should auto-populate with the callsign listed in License Manager.◊ 
Enter you name in the line below labeled Name. We will come back and enter more information later in this chapter.◊ 
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In the Programs Options window, select Soundcard in the first window on the left side.◊ 
Verify that correct sound card is selected. If it is not... well you know what to do. We will save calibration for a bit
later.

◊ 

Close the Program Options dialog window.◊ 

On the Toolbar click on Radio if it is not open.◊ 
Click on the Configure button in the Radio tool bar. This will open the Radio Configure dialog window.◊ 

The Configure Radio window is where you layout your display. This is similar to what you can do in Ham Radio
Deluxe Rig Control. If you do not see any radio functions, click on the Connect button.

◊ 
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You can close the Configure Radio window.◊ 

4.3 Interfaces
4.3.1 Rig Control

Before you really use the DM-780 program you must make some connections to your rig for CAT control and audio input/output.

Rig/CAT Control Rig/CAT control provides software control of your rigs receive and transmit features via a cable connected from the rig
to either a serial port or USB port on your computer.

Some rigs, like the Kenwood TS-2000 only need a serial cable connection between the rig and the computer for rig control. Others
require a CAT interface product of which there are several good ones on the market. Keep reading and we will discuss some of them.
Some do rig control only while others interface rig control and audio.

4.3.2 Audio In/Out

You also need an audio interface to send and receive the data (Audio tones) to and from your rig and this is done by connecting your
rigs audio output and input to your computers sound card.

DM-780 requires the use of a sound card some type of interface from the sound card to the radio. Although the computers
built-in sound card can be used it is recommended you either install a second sound card. The second sound card can be
either internal or external. The advantage of having the second sound card it can be used for your digital communications
while eliminating the possibility of transmitting unwanted computer sounds. You would also be able to listen to music on your
computer while still operating in the digital modes.

Next we need to interface the sound card to the radio. Interfacing can be done in so many ways that it would take days to plow
through all the available information. You can do a Google search and find hundreds of articles on the subject. It is possible to
connect your radio directly to your sound card without any form of isolation but it is not recommended. We?ll assume that you
want to do things properly, so here is a home brew circuit that has proved its worth many times.
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This solution will work with any Icom or Yaesu rig that has a 6-pin mini-DIN connector for external audio. It will work on just
about any other rig but you will have to modify the connections to your radio. If you plan to use the circuit below, please check
the actual connections to the mini-DIN connection of your rig.

Note: HRD Software LLC does not accept responsibility for damage to your rig should things go wrong.

A proven audio interface: Cheap and easy to build

You should always use the rig?s high-impedance audio output if there is one available this supplies a constant signal level to
the sound card. Most rigs also have a TX audio connector independent to the microphone input: you are advised to use this
input. Some commercial interfaces don?t allow this: It is recommended that you avoid any interface requiring use of the
microphone connector and speaker output of your radio unless there is no other option for getting the audio signals to and
from the radio.

Commercial Interface Solutions

There are also some very nice commercial solutions available for interfacing the radio?s audio to the computer.

Timewave Technology has a very good reasonably priced CAT rig control product called the HamLink USB which allows rig
control. As with all CAT rig control interfaces, the level of rig control is controlled by the capabilities of the rig.

Timewave also offers the PK232SC - which has a built in sound card and CAT rig control. This unit has many other useful
features such as Digital Signal Processing which helps clean up the audio signal. More information can be found at their
website: http://www.timewave.com

Tigertronics provides two different interfaces. One has a built-in sound card and one does not. The advantage of having an
interface with a built-in sound card is it frees up the computer?s internal sound card for computer audio, such as listening to
CDs, while using the external sound card for the digital modes.

 SignaLink Model SL-1+

The SL-1+ connects to your computer's sound card and to your radio's Mic, Data or Accessory Port. It is designed to work with
ALL computer sound cards, and with ALL radios. The SignaLink SL-1+ is compact, low powered and fully isolated for optimum
performance. It supports ALL sound card Digital and Voice modes, and does NOT use a serial or USB port!
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 SignaLink USB

Note: Neither SignalLink product interfaces with the radio for CAT control. These are soundcard only interfaces.

The SignaLink? USB combines the legendary performance of their SignaLink SL-1+ with a state of the art ?built-in? low-noise
sound card. The SignaLink USB has only one USB connection to the computer, and in most cases, only one connection to the
radio. Convenient front panel controls make setup and operation very easy. The SignaLink USB is fully isolated and is
compatible with ALL radio Mic, Data, and Accessory Ports, and supports virtually ALL sound card Digital and Voice modes.
Both of the above interfaces are available from on the Tigertronics website at http://www.tigertronics.com

Another commercial solution to interfacing the radio?s audio to the computer is the Navigator.

 Timewave Navigator

The Timewave Navigator interface is available on the web from Timewave. The website is at
https://timewave.com/product/navigator-sound-card-modem/ The Timewave Navigator is a high quality interface between the
rig and the computer, for use in running the digital modes such as PSK31, Olivia, MFSK, Hellschreiber, MT-63, etc. It also
works fine for SSTV.

The Navigator interfaces to the rig using a USB port, thus it does not require a serial port on the computer. The Navigator has
a built-in sound card for audio from the radio to the computer. It also provides CAT control to the rig via a serial connection
from the Navigator to the rig. The Navigator is completely configured and defined in software, and future updates are expected
to be flash-ROM updates that can be installed by the user.

The Navigator is also directly supported by DM-780 by clicking on Program Options and then selecting Navigator from the list
of options on the left side of the window.

 microKEYER II

The microKEYER II? is the most powerful single radio All-In-One USB interface and the only USB interface to fully support
voice operation including microphone switching. With an single USB port, micro KEYER II? works with any Windows based
logging or control program for CW, voice, FSK and digital (RTTY, PSK31, SSTV, OLIVIA, MFSK, WSJT, etc.) operation. micro
KEYER II? includes a radio control interface that supports all standards (RS-232, CI-V, Kenwood and Yaesu TTL), a powerful
CW memory keyer using K1EL's WinKey, a Digital Voice Keyer, two channel audio for transceivers with dual receivers,
automatic microphone selection, and a buffer/sequencer for amplifier or LNA control. microKeyer II is available from the
MicroHam website at http://www.microham.com.

West Mountain Radio offers several RIGblaster products with various features. Visit their website at
http://www.westmountainradio.com for more information.

Note: Because West Mountain Radio control the radio in a slightly different manner we had to add special support
for these interfaces. Please visit the Options in Ham Radio Deluxe and select the COM Port TX tab then click the
West Mountain - RIGblaster support box (See image below)
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Other companies who provide audio interfacing solutions that work well are:

ZLP Electronics: http://www.g4zlp.co.uk• 
Rig Expert: http://www.rigexpert.com/index?s=standard• 

If you choose to use one of the commercial audio interfaces, make certain you follow the manufacturer?s instructions carefully
for installation and set up.

4.4 Program Options Overview

Clicking on the Program Options icon brings up the menu where you can configure the appearance and many options found in
DM-780. Below is a brief description of each option.
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Program Options Menu

Appearance: Select the theme and skins used for the main display• 
Callsign (My Info): Enter information about your station used in macro tags and the My Station screens.• 
Clock: Configure appearance and time format of the tool bar clock• 
Logbook: Configures and connects DM-780 to Ham Radio Deluxe Logbook.• 
Modes + IDs: Configure CW and RTTY Ports and setup RSID and Video ID• 
PTT: Configure transmit Push To Talk options• 
Radio: Configure appearance of the radio pane• 
QSO: Configure appearance of the receive and transmit panes• 
Soundcard: Configuration of the soundcard used by DM-780• 
Sounds: Enable warning sounds used by DM-780• 
Storage: Configure program and storage directories for DM-780• 
SuperSweeper: Configure DM-780?s panoramic frequency monitor screen• 
Waterfall: Configure DM-780?s waterfall appearance and options• 
Alarms: Set and maintain alarms• 
Favorites: Set up and maintain frequency/mode listings• 
Macros: Access to the Macro Manager• 
Modes: Create Modes tool bar on the waterfall display• 
Navigator: Configuration for U.S. Interface Navigator• 
Audio Recorder: Configure Ham Radio Deluxe audio recorder utility• 
PSK Reporter: Configure PSK Propagation Reporter• 
Soundcard Calibration: Calibrates soundcard for use in SSTV• 
Time Synchronization: Adjust computer?s time to national time standards• 

4.5 Configuring DM-780
You should now have your audio connection made between the radio and the computer so it?s time to start configuring DM-780.

Now, let?s get started. DM-780 can be run as a standalone program, however, to take advantage of the many integrated features from
Rig Control and Logbook, we recommend running the entire Ham Radio Deluxe suite.

Your Information

Select Program Options from the Toolbar. This will bring up the Program Options window used to configure
DM-780.

◊ 

Select Callsign (MyInfo) from the menu on the left side of the screen.◊ 
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 QSO Tag
and My Station Set up

Enter any additional information that you would like displayed. The center portion of this option contains information
about you and your station used for substitution tags within DM-780 macro sets. We?ll discuss setting up the macro
sets later on in the documentation, but for now, just type in all information under the QSO Tags section. Don?t worry
about the lack of a SAVE button on this screen, your data is automatically saved when you exit this screen by
clicking the red X in the upper right corner of the display.

◊ 
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After you have entered the information in the QSO Tag portion, you will notice on the right side there is a
button Edit My Station Direct. Clicking on this brings up the My Station data screen.

• 

Information in the My Station screen is used by Ham Radio Deluxe Logbook. If you have already set up the Logbook
portion of the suite, this screen should be populated with the required information and you can just close it out and
continue with the set up.

My Station Set Up

Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you to have a ?Home? location as well as other
locations such as a vacation home or favorite portable locations.

Multiple Callsigns

If your License Manager shows more than one callsign such as for parent and child or husband and wife, you are able to enter
station set up information for each callsign. You can also set up ?Guest? accounts for club or special event stations.

If you haven?t already set up the My Station data, in the Description field you see the word HOME for a profile of your Home
QTH. This generates your main ?location?. Then go ahead and fill in all the rest of the information for this location. Please
note which fields are required if you use one of the DX Clusters.
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Most of the fields are self-explanatory. A couple of the fields do need a little explanation. The field SIG stands for Special
Interest Group. This could be a club or any organization you belong to. The SIG Info field could be a website address for a
group. You could leave these fields blank if you like.

Another spot you might need help is once you enter your Locator, for example EN36QR, if you hit the little arrow that points
downward, that will automatically fill in your Latitude and Longitude fields.

By the same token, if you know your Latitude / Longitude, enter them and hit the upward pointing arrow to fill in your Locator.

If you operate from mobile or maybe have a vacation home, you can generate My Station profiles for those locations as well
by clicking on the Add Location button. You can copy the data from the Home location to be placed in an additional location
then just edit anything that is to be different for that profile. Each profile is auto-saved when you exit the screen by clicking the
red X in the upper right corner.

Once you?ve completed configuring your Tags and My Station, your almost home. Just a couple more things before you can
go on the air live with DM-780.

Soundcard Setup

Now that we have our sound card interfaced to the radio and our personal information set up its time to start configuring
DM-780 to receive some signals. The first thing we need to do is tell our software where the sound card for our digital
operation is located.

Click on Program Options, on the toolbar.• 
Select the soundcard option.• 
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Locate the Input (Receive) device at the top of the options. There is a dropdown box where you select
the input device on the sound card that receives the audio from the radio. In this illustration we are using
the Microphone input from our USB external sound card.

• 

For the Output (Transmit) device, another drop-down box where you select to send the audio from the
sound card to the radio. In this case, the Speakers of our external sound card is selected.

• 

Everything else should be left at DEFAULT for your system at this time. Just click the ?X? in the upper
right corner to exit the Program Options and your settings will be saved automatically.

• 

You should now be back to the Getting Started Screen in DM-780. To clear this window, let?s click on the ?X? on the tab just
to the right of where it says ?Getting Started?. This tab is located just below the QSO and the SuperSweeper icons on the
menu bar. Your screen should now look like the picture below.
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4.6 DM-780 Tour
Now that we have the bawsic setup completed for DM-780 it is time to take a tour of the program. You will find this program to be both
confusing and easy at the same time. That is what happens when you have a powerful application available to use.

DM-780 Toolbar

QSO Window Click on the QSO icon, located on the left end of the toolbar. This is going to open the DM-780 main display window.

The CW Mode screen above is divided into several sections. The larger white section is the receive panel, the smaller white
section is the transmit panel.

On the left side of the screen are several tabs. The top one is for the ALE (Add Log Entry) panel. The next one is for Macros.
Both of these will be discussed in detail later in this section. The bottom tab opens the Tag window which you have already
seen.
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The receive panel and transmit panel are self-explanatory. The receive panel is where incoming text is displayed. The transmit
panel is where text is prepared for transmission. The ALE (Add Log Entry) section is just that. This is where data about your
contact is placed to be added to the logbook after your QSO is over. Information in the ALE can be entered manually from the
keyboard or automatically from one of the Call Sign look-up services configured in HRD?s logbook module.

Changing Operating Mode

To change this window to a different operating mode click on the mode select tab in the top left corner of the QSO window,
There you will see over a dozen different digital operating modes displayed. Each of these modes is further sub-divided into
variants of the digital mode. Note our example of PSK offers three variants of PSK for you to choose from. We have selected
to most popular PSK operating mode.

After you have made your selection you will notice that there has been some subtle changes in the QSO window for operating
in PSK.

Some things, however, have not changed as they are common to all of the operating modes.

Next to the mode selection tab is a series of tool icons. In order from the left:
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Save Received Text - This allows you to save all your received text to a file in Rich Text Format in a location of your choice.

Viewer - Opens a viewer so you can view your saved received text.

Erase - Clear the receive screen.

Alarms - Manage and select user defined alarms. Help you spot desired stations.

Channels - Select to receive one, two or three channels at one time. Allows you to keep tabs on up to three different conversations at
one time. You can only transmit on the Main channel which is the top most or left most depending upon your display choice.

Options - This is another way to access Program Options that you have access through the toolbar.

Waterfall

There is one important panel missing from our display. There has to be a way to tune in the digital signals on a frequency.
That?s the job of the Waterfall.

On the tool bar click the Waterfall icon.

The waterfall is a requirement for working PSK and this version is loaded with features to make your digital contacts jump. Full
operational details can be found later in this section.

196

http://wiki.ham-radio-deluxe.com/index.php/File:Page-187-Image-365.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-187-Image-366.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-187-Image-367.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-188-Image-368.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-188-Image-369.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-188-Image-370.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-188-Image-371.png


SuperSweeper

SuperSweeper is a great tool to see what is happening on the bands. This high powered tool allows you to set alarms to alert
you of stations that you want to locate. The blue signal is caused by an alarm for stations calling CQ. The setting up and use
of SuperSweeper is discussed later in the section.

Radio Panel Thee next operational feature found on the toolbar is Radio. This allows control of your radio without switching back to Rig
Control.

You can see that you have some controls displayed when you open up the window. There are built in features.

There are several items in the radio panel toolbar that make operation easier. The << and >> icons shift your frequency up or
down in 500 Hz increments.
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The next group of icons allow to tune to preselected favorite frequencies either by selecting the frequency from the drop down
list or by using the two arrow icons to scroll through the list. You can managed the contents of this list by selecting Manager
from the drop down list.

Radio Panel Config

The last icon in the Radio panel is the config button. This allows you to cofigure buttons, drop downs and sliders that are very
similar to those you set up in Rig Control. If the item does not have a label, no function is assigned and it does not display.

To assign a function to one of the buttons, click on a button to select it and you will see a Select Button window where you can
make your assignment. Do the same for the drop downs and sliders. When you are done click on the Save button.

The remainder of the icon buttons in the toolbar should be familiar to you by now.

4.7 Main Window Tour
We now return back to our main display.

Now, let?s review selecting a mode. The most popular of the digital modes is BPSK-31 and the most used frequency for this
mode is 14.070 in the 20 meter band. At this time, tune your radio to 14.070 and set it to upper sideband, since ALL digital
modes are used in upper sideband, with maybe one exception and that?s QPSK which can be used in USB or LSB. You might
also want to tune your antenna for lowest SWR on this frequency before we go any farther.

Next, in the upper left corner of the large receive panel, you will see a small tab with a drop-down arrow. Clicking on this
brings up the Modes menu. Highlight PSK and another menu will show up with BPSK-31, BPSK-63 and BPSK-125. Click on
the BPSK-31 mode to select.
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Looking at the main display, you will also notice that the tab just above the ALE also reflects the current mode being used. We
have selected the mode so now take a close look at the Waterfall.

Waterfall

The Waterfall actually has three sections. The top gray section is the Waterfall tool bar. The black area contains audio
frequencies calibrated in HZ, and the blue area is the actual Waterfall. The reason for the name is the light colored signal
traces flow from the top to the bottom of the display just like a waterfall. The traces are actually signals from different stations.

PSK Bandwith

The bandwidth of a BPSK-31 signal is 31.25 Hz. Our waterfall is about 3000 Hz wide. Since BPSK has such a narrow
bandwidth, the use of audio off-set frequencies can be used to display many BPSK signals on the waterfall at one time. Notice
how each signal is displayed under a different audio frequency on the waterfall. In the picture on the left you see what our
cursor looks like on the waterfall. The yellow bar is about 31.25 Hz wide. There is an arrow at the top of the cursor and two
lines extending downward from the cursor. Placing he cursor on a BPSK-31 signal with the arrow in the center of the signal
and the trailing lines on either side of the signal tunes in the base frequency of 14.070 + the audio frequency off-set to allow
you to decode that signal in the Receive panel.

Go ahead and try a few on your own. It takes a little practice to position the cursor properly.

Display Check
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At this point if you are not showing any traces on your waterfall or are unable to decode the traces, go back and recheck your
sound card settings, cables, and if using a commercial audio interface, read the manufacturer?s installation instructions over
again to make sure everything is set correctly.

Once you are receiving and decoding signals its time to try to transmit using DM-780 and BPSK-31.

Transmit Panel

The Transmit panel is where you prepare text to be transmitted. This text can either be entered manually thru the keyboard or
by using one of the pre-defined macros. For this test we will be entering the text manually.

In the waterfall, place your cursor somewhere near the center of the waterfall on an area where you don?t see any signals.
Wait a short time to make sure the frequency is clear and then proceed.

Before we continue with the transmit test it is recommended you install a dummy load, if you have one. If you don?t have a
dummy load it?s best then to decrease your RF output to it?s lowest possible setting which will give you some deflection of
your power meter to indicate you are indeed transmitting.

Place your cursor inside the lower Transmit panel of the main display. Now, type in the following:

CQ CQ CQ DE (your callsign 3 times with a space between each) followed by PSE K

The transmit panel should look something like this:

Transmitting

Pressing the Send or the F4 key will transmit the string you just typed in the Transmit panel. Your transmitter should now key
and the text transmitted. As the text transmits it will show in the Receive panel and a strike-through will move through the text
in the Transmit panel. Immediately after sending the text, press the Stop or the F5 key to un-key your transmitter.

Text send from the Transmit Panel

If your transmitter keyed and you have seen deflection on your power meter, you?re in business. If the transmitter keyed and
you see no deflection of the power meter, first, go back through the audio set up and make sure you have selected the proper
Output (Transmit) device in the Program Options sound card settings. If everything is correct there, try increasing the RF
power just a bit and maybe even increasing the audio volume on the sound card you?re using. If you?re using one of the
commercial external interface devices, check the installation instructions to make sure you have everything set correctly for
the unit you?re using.

If all else fails, first contact the manufacturer or distributor for the sound card device your using. If all seems fine there contact
HRD support through one of the methods listed on the support page at https://www.ham-radio-deluxe.com

Transmit Toolbar
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Transmit Tool Bar

Clicking on the Send button OR pressing the F4 key starts transmitting data currently in the Transmit panel.

The Auto button or F2 on your keyboard will start transmitting data currently in the Transmit panel and will automatically stop
and return to receive mode when all text is sent.

The next two options are normally grayed out when in the receive mode. They are the Pause (F3) and Stop (F5) buttons. The
Pause button allows you to pause transmitted text at any point while it is send. This allows you to edit the text following the
pause, such as inserting a comment or deleting part of it, then clicking the Pause again resumes transmission where it left off
to the end of the text.

The Stop (F5) immediately stops the transmission and returns the rig to the receive mode. The Break-In is a toggle and turns
the Break-In mode ON or OFF. With this mode toggled on, text that is typed into the transmit panel is sent immediately,
however, if you pause typing while this mode is turned on, the transmitter switches back to receive. Once you start typing
again, the transmitter keys and you continue from where you stopped. This allows you to listen briefly to see if your contact is
trying to Break-In on your transmission, just like is done during CW operation when a sender pauses briefly to see if his
contact is trying to break in.

As text is being sent, an overstrike line moves thru the text in the Transmit panel. If you Pause the transmission at any point, when you
Un-pause it, the transmission continues where you left off. Pressing this icon removes the overstrike line from the sent portion of the text
making it appear to be un-sent. When you resume, the transmission begins again from the beginning of the text in the window.

The Eraser icon does just that. Pressing this icon erases all text in the Transmit Panel.

DM-780 can send the contents of text files. Clicking on this icon allows you to navigate to a folder where you have text files stored. Once
in the folder you can select a text file which will automatically be opened in the Transmit Panel where you can then transmit the contents
of the file.

Clicking on this icon allows you split frequency operation in the current passband. To do this, first select the frequency or audio
frequency where you want to transmit. Place your main cursor on that frequency and press the lock icon. An indicator will appear with a
TX inside a little box that shows the transmit frequency. This will be the frequency where your contact will receive your transmissions.

Now, move your cursor to the frequency you are receiving on. This will be your contacts Transmit frequency. When you transmit,
DM-780 will automatically shift and transmit on the frequency indicated by the TX marker on the Waterfall. In this case, the audio
frequency is 1600 for transmit and 1700 for receive, a 100 Hz split.

To clear the split and go back to normal, just click that lock icon to release it.

This icon brings up a drop-down menu that allows you to turn off or set an interval timer. This comes in handy when calling CQ. You can
set a time interval in this option to automatically send a CQ call for you at the specified time interval. Once you set a time interval, you
start sending your CQ macro. Once it starts sending you will see the Repeat icon on the tool bar becomes active. Clicking on the Repeat
icon now sets DM-780 to transmit the CQ macro, wait the preset time interval, and resend the macro again. This will continue until you
click the Repeat icon to toggle the repeat off.

This is the icon to toggle your RSID on or off. For those not familiar with RSID, it stands for Reed-Solomon ID RSID was originally
developed by Patrick Lindecker, F6CTE. The Reed-Solomon ID (RSID) is a short 16-tone MFSK transmission which identifies the mode
in use. The RSID transmission is about 180Hz wide and lasts for just less than two seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of programs with RSID support know what
mode you are using. For a full list of modes supported by this program look in the Program Options for Modes + IDs.

There are two ways to enable RSID: 1) In Program Options select Modes + Ids and check the option to show the RSID button
in the Transmit tool bar, 2)Add the tag <rsid> to the beginning of a CQ macro. The latter is most recommended since it is
rather annoying to have the RSID popup coming up EVERY time a contact transmits during a QSO. By including the tag in the
CQ macro, the RSID information only displays when the CQ is received.
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When activated, the Video ID places text in the waterfall which can be seen by the sending and receiving stations. The Video ID is
based on the Hellschrieber digital mode.

The Video ID is set up in the Modes + IDs area in the Program Options display of DM-780. Above you can see there are
several items you can have sent in the Video ID. Callsign, Mode, or both. When activated a display is seen on the Waterfall
that looks similar to the one shown above. It can be sent in a Vertical or a Horizontal display. This is an eye-catcher for
anyone sitting watching the waterfall.

This next icon toggles a mini-logbook display on the Transmit tool bar. Click once to turn it on and again to turn it off.

Last but not least, clicking on this icon activates the QSO Options panel from the Program Options menu.

Receive Panel Toolbar

We?ve gone through the options on the Waterfall and the Transmit toolbars, so now we?ll look at the Receive Panel Toolbar.

Receive Panel Toolbar

Clicking on this icon revels a drop-down menu where you can select the digital mode you would like to operate.

Click on this icon to allow you to save to a file all the text in the current receive panel.

Opens a Viewer to allow you to go back and review all text in the receive panel.

This icon erases all text in the receive panel.

Clicking on this icon allows you to manage, select and activate alarms.
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These icons move your cursor up and down the waterfall to the next active signal.

Rewind (replay) the last transmission on the current frequency selected on the Waterfall.

This icon has a drop-down menu that allows you to activate up to three receive panes (channels), along with associated channel
markers for each channel on the Waterfall. This allows you to monitor and participate in three QSOs at the same time, if you are one of
those ?Muli-taskers??..

Activates the QSO Options panel in the Program Options Menu.

Waterfall Toolbar

Looking at the Waterfall tool bar you will see buttons that control various things. On the left end you will see ZOOM. To the
right of word ZOOM you will see a left pointing arrow, the number x1 followed by a right pointing arrow. This number controls
the magnification of the waterfall. Click on the x1 will increment it to x2 and the arrows on each side will become active.
Pressing on the left arrow will now shift the waterfall to the left and pressing the right arrow will shift it to the right. The
magnification can be increased up to x4 by clicking on the number.

To the right of the word Main you will see a number. In the above picture the number is 1862. That is the audio frequency that
your main cursor is currently sitting on. On the left of this number you can see the left pointing solid red arrow. Clicking on this
arrow moves the main cursor down the waterfall in 10 Hz increments. Clicking on the left pointing chevrons, between the
arrow and the number, moves the cursor down the waterfall in increments of 1 Hz. These can be used for fine tuning in on a
waterfall signal. The arrow and chevrons on the right side perform the same function except they move the cursor up the
waterfall.

The next control is Signal. The blue arrows to the right move the cursor up or down the waterfall to the next signal detected.

The Re-cycle symbol to the right of this plays back the last transmission received from a trace on the waterfall.

AFC toggles the Automatic Frequency Control on or off.

The Decode button toggles a little receive pane on the waterfall that displays the text being received from the signal your
cursor is centered on.

The Option button brings up the Waterfall Options screen where visual changes can be made to the Waterfall.

Next is the Frequency Tool bar. When activated from the Options it displays the frequency the radio is tuned to. HRD Rig
Control must be running for this option to work.

The rest of the tool bar explains itself. There is a list of bands. Clicking on a band button brings up a drop-down list of frequencies
available on the band which are used by the mode you are in. If you change mode, the available frequencies change. Check the
frequency to change the radio frequency.

Clicking on the Faves tool activates the Favorite Frequency panel. This panel contains an editable listing of modes and
frequencies normally used by the modes in each band. Items with check marks in the Enabled column are the ones contained
in the band buttons we previously described.

The Modes icon activates a panel where you can add another tool bar to the waterfall. This would be a Modes Tool bar, and
could be displayed by individual mode buttons, such as BPSK-31, Olivia, RTTY, CW SSB, etc. It could also be configured to
just display groups with drop-down pick menus for each mode. This is a choice for the operator. Use the extra space for the
waterfall or take part of the waterfall to display this tool bar.
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Configuration Tabs

Above is the Waterfall Configuration panel. There are 4 tabs on this panel and each configure a different aspect of the waterfall. Below is
a list of the options that are configured from this tab.

Waterfall Options Center Frequency Marker

Define up to three center frequencies, normally set to the center of a narrow filter. When enabled a [C] button is displayed in
the waterfall tool bar.

 Here the Center Frequency Marker is activated and set to the center of the filter. If you are decoding a trace to the
left or right of this marker, clicking on the [C] marker tunes the radio to bring the bring the signal to center on this marker, therefore
placing the signal your decoding in the center of the narrow filter.

You must also define a Radio macro button to enable the narrow filter - or select the filter from the radio pane in DM780 or
from your radio's front panel.

Radio Macros
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It is normally convenient to display special radio macro buttons in the waterfall tool bar. Typically radio macros are used to
enable narrow or wide filters.

Various

Erase when changing frequency - erase the waterfall when the radio frequency changes.

Only update if visible - only updates the waterfall f visible - saves CPU cycles on computers with less powerful graphics cards.

Show radio frequency tool bar - shows the current radio frequency in the waterfall tool bar.

Show sound card in window title - shows the name of the current sound card selection in the waterfall title bar.

Tuning Guides

Tuning guides - channels - vertical bars displayed in the waterfall when help you position the M, A and B channels over the received
signal.

Tuning guides - mouse - vertical bars displayed at the current mouse position in the waterfall, helps you correctly select a signal.

Tuning indicator - the traditional display which helps you tune a signal correctly.

Waterfall Configuration

Waterfall Color Options

On this option panel the operator can adjust the color settings of the Waterfall to his own preference. This is strictly a trial and
error type adjustment. If you don?t like one color setting, try another until you find something that you like and is easy on your
eyes.

Waterfall color settings do not affect decoding!

The waterfall display takes the audio from the sound card and converts it to power (signal strength). If you enable the
Spectrum option you see the relative signal amplitude. Use the color schemes to highlight the signal peaks so that you can
find the signal traces.

Suggested Schemes

The best and most commonly used schemes are: Default and Scope 1
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Frequency, Mode, Speed Tab

This top section allows you to select the Mode for the Waterfall. You can display the standard Waterfall, display a Spectrum
representation, or both. You can also adjust the Passband width to your taste. You can also adjust the speed that the
Waterfall moves. The higher the speed the higher the CPU usage, so those with a slow CPU might want to select a slow
speed to avoid a possible jerky display or pauses during printing of received or transmitted text.

The center portion of the above panel adjusts the Waterfall Display Mode only, and does not affect decoding. This section
adjusts for clipping of the signal. Use clipping to shift the data so that baseline noise is at the bottom of the screen, thus giving
a larger viewing dynamic range.

The lower portion of the panel adjusts the appearance of the frequency bar of the Waterfall. You can select the background
and text color, and font for the numeric display. You can also adjust it to show either the audio frequencies or show the RF
frequency + Audio. To do the later, requires a radio connection.

Weak Signal Configuration
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Weak Signal Panel

This panel helps adjust and compensate for weak signals on the Waterfall.

Enhance / Amplify

When enabled all signals are uniformly increased in strength so that the strongest signal is at the maximum strength, similar to
your radio's AGC option.

Advanced

When enabled automatic gain is applied to all signals by using an advanced digital amplifier algorithm.

This amplifier has both gain and bandwidth, the signal is amplified by the selected gain such that the signal strength of the
strongest signal inside the bandwidth does not get clipped or cause visual overload.

Gain

The gain applied to the signal, range is 0 to 100%. The effect of gain depends to a large extent on the current Color scheme
(selected in the Colors page).

Bandwidth

The bandwidth of the amplification applied to each signal, range is 100 to 1,000Hz. Now that we have DM-780 configured, can
both transmit and receive digital modes, and have gone through some of the various tool bar options, its time to start looking
into the more advanced features of the program. This includes the use of macros to create shortcuts to use during your QSOs,
logging QSOs, using SSTV and customizing your display.

Since you should be basically up and running at this point, HRD Software LLC would like to welcome you to the fascinating
world of Digital Communications.

4.8 Main Display Configuration
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DM-780 Main Display

There are many configuration options available for the visual display of DM-780. If you will notice there is a scroll bar located
on the right side of the ALE panel. Using the scroll bar and sliding down to the bottom of the ALE reveals more control buttons
for the ALE. Many people don?t like to have to use this scroll bar so one option is to reduce the hight of the Waterfall.

Placing your cursor along the top edge of the waterfall, just below the transmit panel, clicking and holding the left mouse
button, will allow you to drag the top of the Waterfall down so you can see the options on the bottom of the ALE. Doing this,
though, brings up another problem. When you get it to the point where you can see the bottom of the ALE, the Waterfall is so
narrow it makes it hard to select the signals.

Full Screen Mode

An alternative would be to press your F11 key. This takes the display to the Full Screen mode.

 F11
? Full Screen Mode
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Now in this mode you can see the lower part of the ALE, and as you will learn later, below the three icons at the bottom a line
of text will appear when you have a call in the Callsign box indicating the worked status of that call. Plenty of room for all of
that now, but another problem has been introduced.

You have lost your tool bar and have no way of selecting any other options available.

SOLUTION: Select an empty spot on the tool bar and click your right mouse button. A menu will pop up looking like the one at
the left. Un-check each of those checked options in this menu to remove them from the tool bar. Remember, removing the
Clock from the tool bar isn?t going to hurt you, you always have the system clock on the Windows Task bar. The frequency is
displayed on the Waterfall tool bar. Everything else will now be available from the Text Menu at the top of the screen.

Now you can adjust the height of the waterfall to something easier to work with and still see the entire ALE without having to
use the scroll bar.

Multiple QSO Windows

On the Text menu at the top of the display, click on QSO and select New Window. You will see a new tab appear on the
display. The tab will be identical to the first one created. Click on this new tab. It doesn?t look like anything changed. Your still
in the BPSK-31 mode and the screen looks just like the previous tab.
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Click on the BPSK-31 tab, in the upper left corner of the Receive panel. When the dropdown selection box opens, come down
to RTTY and click on RTTY-45. You now have TWO mode tabs open on the main display.

Let?s try another. Click on QSO on the Menu and select New Window. You now have THREE mode tabs. In this new tab,
let?s select Olivia 8/500.

The tabs in your display should look like the following picture.

You can have as many mode tabs open as you like and easily switch back and forth just by clicking on the tabs. To close a tab
just click on the ?X? located to the right of the tab name.

If you a QSO and someone sends you a link a website, you don?t have to exit DM-780 to view the site. You don?t even have
to open your favorite browser. All you have to do is click on the link, in the receive panel, a browser tab will open to the
website you clicked.

Looking closely at the above picture, you can see you now have four tabs on the display. Three Mode tabs and the Browser
tab.

4.9 Digital Modes
At present, DM-780 handles 14 of the most popular digital modes used in amateur radio. These modes are BPSK, QPSK, CONTESTIA,
CW, DOMINOEX, HELLSCHRIEBER (HELL), MFSK, MT63, OLIVIA, RTTY, RTTYM, THOR and THROB and VOICE. Each mode is
subdivided into variants of the mode.
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The mode can be selected from a number of places in the DM-780 display, depending on how you customize your display.
Modes can also be selected by right-clicking on the waterfall and choosing from the popup menu.

You can select from the Modes Pane, which can be pinned to the display or by clicking on the small mode drop-down tab
located in the upper left corner of the Receive Pane.
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You will find that some modes, like BPSK and QPSK require only about 25 to 40 watts to maintain a good QSO contact, while
others require more power. You will also find that some modes, like OLIVIA and CONTESTIA, require more RF power but
perform extremely well under adverse band conditions. You can often be able to copy an extremely weak DX station when
there is a high noise level using one of these modes.

Experimenting with the different modes and variants can be a lot of fun and you can find the mode that works best for you
under even the worst band conditions.

4.10 Logging QSOs
DM-780?s integration with the Ham Radio Deluxe Logbook makes it very simple to log each QSO by using the ALE (Add Log Entry)
panel.
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Add Log Entry (ALE) panel

If you do not have Ham Radio Deluxe Logbook running and are not connected to it, this panel will be grayed out. If active, you
can manually enter a callsign in the Call field, press the TAB key on your keyboard and depending on how you have the call
lookup configured in Logbook, the call will be looked up and all information will be populated in the ALE.

Once the callsign and other information is entered in the ALE, the ?HIS TABS? will become active in the macros and when
used will be replaced with the data from the ALE window.

There is also an alternate method of entering the callsign into the ALE and automatically completing the look-up.

You can place your mouse cursor on the callsign in the Receive Pane and right-click.
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ALE Alternate Method

Using this method brings up a context menu where you can select Callsign, left-click and the call will automatically be added
to the ALE and the look-up will be performed to populate the rest of the data. This method makes logging quick and easy,
especially during contesting.

In performing this alternate method of entering a callsign into the ALE, you might have noticed another feature of DM-780.
When you hover over a callsign, a balloon will pop up indicating whether you have worked and logged the call in the past.

Worked Status Pop-up

Again, these features will only work if you have Ham Radio Deluxe Logbook running and connected to DM-780.

4.11 SuperSweeper
From the DM-780 tool bar, clicking on the SuperSweeper icon adds a tab to the main DM-780 display and brings up an outstanding
feature of the program.
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SuperSweeper Display

You can now switch between the SuperSweeper and the BPSK-31 display by clicking on the tabs just above the display
window. You can also close the active window by clicking the ?X? on the right end of the tab.

BPSK-31 ? SuperSweeper Tabs

The advantage of using the SuperSweeper window is its capability to decode multiple signals on one screen. This is a lot
different than using the main display with the waterfall or spectrum display where you can decode only the signal you have
marked with your cursor.

Modes

Modes available in SuperSweeper are selected by clicking on the drop-down mode indicator in the upper left corner of the
window.

215

http://wiki.ham-radio-deluxe.com/index.php/File:Page-209-Image-424.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-209-Image-425.png


SuperSweeper Mode Selection

In the screen shot above, you will notice the call AK4VN followed by a check mark and a red X. If you have HRD Logbook
running and are connected, when SuperSweeper recognizes a call it places it on the end of the red trace. The symbols after
the call are Work Status Indicators. The first, the green check mark, indicates you have worked the country of origin for this
call. The red X indicates that you HAVE NOT worked this operator. In the above, what we?re seeing is, the country of origin of
this call is the United States and we have worked it, but we have not had a QSO with AK4VN.

History Report

Another useful feature of SuperSweeper is the History report. Clicking on the History icon in the SuperSweeper tool bar
brings up this feature.
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SuperSweeper History

When enabled, the History logs callsigns recognized, by SuperSweeper, the time, band, continent and country of origin. It also
shows if you have worked the country, indicated by either a green check mark for worked or a red X for not worked, and
whether or not you have worked that particular call.

This feature can come in handy if you are trying to determine how the propagation on a band is running. You can find what
areas are being received the most, at your local station, and by checking the times you can see what time of day the
propagation into an area was the best from your station.

This feature can be enabled or disabled by clicking the Enable button on the History panel. You can also enable or disable the
Status, which shows at a glance how many countries, how many stations and what continents were heard by clicking on the
Status icon.

Clicking the Report icon transfers the data from the History panel to the Notepad, where you can save or print the report if you
choose to keep it for future reference. Clicking on the Erase icon clears the History.

Starting a QSO from the SuperSweeper can be done using two different methods. In the first method, while watching
SuperSweeper, and you see a callsign in light colored area on the left end of the trace, if you double-left-click on the callsign
two things will happen. First you will be taken back to the main DM-780 display. The second thing that happens is the call you
clicked on will automatically be transferred to the ALE and an automatic look-up will be done to populate the information about
the call. You will also find your cursor is on the frequency that is being used by the QSO.

QSO Connection

From here all that needs to be done, when the contact finishes his current QSO, you hit your CALL macro which puts out a
call for the station callsign appearing in the ALE call field. From there just proceed as normal to carry on your QSO with the
contact.

The second method is holding a QSO in the actual SuperSweeper window. On the SuperSweeper tool bar, clicking on the
QSO option changes the layout of the window.
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SuperSweeper QSO Display

You will now notice you have the ALE panel, a QSO RX and a QSO TX panel displayed along with the SuperSweeper.
Clicking on the red trace of any QSO will now display the received text in the QSO RX window located in the lower left part of
the window. If there is a callsign displayed in the white end of the trace, hovering your cursor over the call will bring up the
balloon to let you know whether or not you have worked that station. If you double-click on that callsign, the Call Look-up
panel will open in the display. The callsign will be transferred to the Look-up panel and details will be populated from the call
look-up service you have configured in the Ham Radio Deluxe Logbook. If you decide you would like to work this station, on
the top of the Look-up panel, click on the LOG icon. This will populate the ALE panel.

You can now make your contact and carry on your QSO just as you would do from the main DM-780 display using the QSO
TX and the QSO RX windows.

When your QSO is completed, click the ADD (F7) icon at the bottom of the ALE to save the contact to your logbook and clear
the ALE for the next contact.

4.12 Macro Manager
Macros are a great way to handle repetitive operations in the digital modes. They allow you to pre-define operating procedures
and execute them with just a click of the mouse. It?s much more convenient to just click on a macro to send a CQ call rather
than type in the call each time.

DM-780 contains a Macro Manager tool that allows you to set up and maintain an unlimited number of macro sets to handle
these procedures. When installing DM-780 for the first time you will find a default set of macro definition. This is usually a
READ ONLY file and should be kept as a template to build other editable sets. Sets can be made mode specific for CW, PSK,
RTTY or set up for contesting exchanges. The uses for macros are almost unlimited.

When you create a custom set of macros it?s recommended that you not only save the set within the DM-780 directory but
also in an external directory, such as in a folder in your Documents. In the event you have to re-install HRD from scratch,
having the macro sets saved in an external folder will eliminate the need to re-create the sets. You can just load them from the
external folder and save them back into the DM-780 program folder.

Macros can be accessed from either a tool bar located between the Receive Pane and the Transmit Pane of DM-780 or from
a macro pane which can be pinned to the display. This choice is yours.

Macro Toolbar

Between the Receive pane and the Transmit pane, just below the Transmit tool bar, you will find the Macro toolbar. Left
clicking on any one of the Macro buttons will automatically transfer the contents of the macro to the Transmit pane and
depending on how the individual macro is configured, it will AUTO SEND the contents or wait till you press the SEND button to
transmit the contents.
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From here we can send a macro by clicking on the macro button or we can edit individual macros by right clicking on the
macro button which will take you directly to the Macro Editor. For this part of the documentation we are going to use the Macro
Manager by clicking on the far right icon called Macros then click on the drop-down option Manager.

Macro Manager

Above is a screen shot of the Macro Manager with the Default macro set displayed. From the Macro Manager you can edit the
contents of individual macros, create new sets, modify the macro tool bar and edit how each macro functions.

Tool Layout

In the bottom portion of the Macro Manager you will see three columns.

Appearance

The first column manages how the tool bar appears on the main display. With a tick in the ?Button? option, the macros are
shown on the tool bar as individual macro buttons.

With the tick in the ?Popup? option, the macros are displayed as GROUPS with a dropdown menu for each group to select the
macros within that group.

The next option under appearance is ?Icons?.

If the function of a macro is set to ?Send Immediately?, an arrowhead is placed to the left of the macro
name in the tool bar.

• 

If it is set to ?Erase TX Window? after sending, there will be an ?Eraser? icon in front of the macro name.• 
If both are ticked, both icons will appear.• 
If the macro is a Radio Control macro, another icon will appear to designate the macro as a control
macro.

• 

In the Macro Manager screen you will see a column named ?GROUP?. Each macro is assigned to a group. Under the Macro
Pane heading there is a check box to display the macros in order of groups. You also see a check box for showing the macro
set title. This title is displayed on the tool bar and also at the top of the macro pane.

The third column shows First Name. When a call is looked up and the data is entered in the ALE the contacts full name
usually appears in the Name field of the ALE. By checking the box under First Name, when a macro is sent that contains the
<his: name> tab, instead of sending the contacts full name, the macro will only send the contacts first name.

 Macro Manager toolbar

Above is the Macro Manager toolbar.

The New icon opens an empty Macro Editor window.• 
Copy allows you to highlight a portion of one macro definition and paste it into another macro.• 
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Highlight a macro and click the Edit button brings up the Macro Editor and allows you to edit an individual
macro.

• 

Highlighting a macro and clicking the Delete icon deletes the macro from your list.• 
Highlighting a macro and pressing the up or down arrow on the tool bar moves the icons position up or
down in the list.

• 

Clicking on the Import icon brings up a drop-down menu of the ten macro sets in DM-780. This can be
used when creating a new macro set. You can create an empty set then Import an already created set
into the blank one to use as a template to edit the new set.

• 

Clicking the Defaults loads the Default set of macros.• 
If you have created more than ten sets of macros, you have the ability to Save these additions sets to
some location of your choice. Once the set is created click the Save As icon to save the set.

• 

The Load icon allows you to load any macro sets you have saved. These functions give you the ability to
have an unlimited number of macro sets.

• 

New Macro Sets

This next section will deal with creating a new macro set. As mentioned before, it?s always best to keep the default macro set
as a template. This can remind us of the format for each macro.

To create a new macro set, just above the window that contains the macro definitions, you will see a field called Macro Set.
This is a drop-down field which currently contains the word Default. Clicking on the drop-down arrow in the field brings up a
box containing 10 macro sets. Some of these sets may already have names assigned, which indicates there are already
macros created within the set.

Select an empty set from this drop-down menu. Usually a name like Set followed by a number is an empty set.

Let?s say for example that you select Set 4. Clicking on Set 4 will bring up an empty editor screen with Set 4 showing in the
Macro Set field. To the right of this field you will see a button that says Set Title. Clicking on the Set Title button will bring up a
box where you can enter a name for this group of macros.

In our example, let?s name this new set My PSK so type this name over the name currently in the Set Title box and click the
OK button. My PSK now appears in the Macro Set field. We are now ready to create the individual macros for this set.

We now have an empty macro set named My PSK in the Macro Manager. Since we?re new to programming macros we are
going to use the Default set as a template to make our My PSK macro set.

On the Macro Manager tool bar click the Import macro. A drop-down box will appear and from that, place your cursor on
Default and click the left mouse button. A new dialog box will pop up asking you if want to Replace My PSK with Default or
Add Default to My PSK.

Since we?re starting with a blank set it really doesn?t matter which you select. If you had macros already in this set and just
wanted to add the Defaults to those you would select the Add option, or if you wanted to replace them you would select the
Replace option.
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With the Macro Editor, we create each individual macro and set how it executes. Here is a brief explanation of the various
functions available in the Macro Editor.

Macros contain free-format text with optional tags. Tags are enclosed within angle brackets <> and contain:

Information about yourself such as your callsign and name - taken from the Tags window,• 
Information about the other station such as his callsign and name - taken from the Add Log Entry (ALE)
window,

• 

Special tags such as the date and time.• 

Example:

<his:callsign> <his:callsign> de <my:callsign>
<my:callsign>
73's and thanks for the <my:mode> QSO k

In this example <his:callsign> is replaced with the value in the Callsign field in the Add Log Entry window and <my:callsign> is
replaced with the value in the Callsign field in the Tags pane of the QSO window. (Select Tags from the QSO menu to display
the Tags pane.) The tag is replaced with the current mode (PSK31, RTTY etc.) as shown in the mode dropdown in the QSO
window.

So if HB9DRV is working GD4ELI using RTTY the actual text sent is:

GD4ELI GD4ELI de HB9DRV HB9DRV
73's and thanks for the RTTY QSO k

Adding Tags

To add a tag to the current macro:

Position the cursor in the definition field where the tag is to be inserted.• 
Make sure Tags is selected in the tab strip.• 
Double-click on an entry - the my: and his: prefixes are added automatically.• 

Options

The extra options are:

Send immediately - when the macro is selected DM780 starts sending.• 
Autostop - switch to receive when the macro is sent.• 
Start on new line - make sure the text starts on a new line.• 
Erase TX window - erase the contents of the TX window when selected.• 

Load Text from File

When you select this option the text

<file:YOUR-FILENAME-HERE>File-contents-go-here<eof>
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is added to the macro. Replace YOUR-FILENAME-HERE with the full path of the filename. the contents of the file replace the
text between the <file:...> and <eof> tags. This option is typically used for sending weather reports from automatic weather
stations.

Now we?ll create a macro that does a CQ call. The first thing is to create a title for the macro. In this case, the title will be CQ.
Type the title in the title box at the top of the editor.

The next field is ?tool bar Title?. This is the title that appears on the macro button. Since we are going to have this macro do a
CQ call two times, we will make the tool bar Title CQ X2, again without the quotation marks.

We?ll now create a Group for this macro. Let?s call this group CQ. Enter CQ in the Group field.

We want to make sure this macro is going to be Enabled on the macro toolbar, we need to place a check mark in the box to
Enable the macro. This box is just to the right of the macro title field.

In the large yellow area we can now build our macro. Place your cursor in the editor area and type CQ CQ CQ DE. Hit the
space bar after the DE and look down at the Tags list. In the My Tabs column you will see callsign. Double-click on callsign
and you will see the <my:callsign> tag displayed in the editor after the DE. Your macro will look something like this?.. CQ CQ
CQ DE <my:callsign>. Place the <my:callsign> in the macro two more times, making a space between each tag. Immediately
after entering the last tag press ENTER on the keyboard and repeat the sequence.

After entering the second CQ call, place PSE K and from the Special Tags column, double click on the Stop to place the
<stop> tag at the end of the macro. Your finished macro should look like:

CQ CQ CQ DE <my:callsign> <my:callsign> <my:callsign>
CQ CQ CQ DE <my:callsign><my:callsign> <my:callsign> PSE
K <stop>

When you?re finished entering your macro definition we can now set the macro options. For this macro, under the Macro
Options, located on the right of the upper portion of the macro editor, place a check in all four options. These options
determine how the macro is transmitted. It will start transmitting immediately when you press the macro button, it will begin on
a new line, it will automatically stop at the end of the text and erase the transmit window when finished executing.

To save the macro just click the OK button in the lower left corner of the editor and you will be returned to the Macro Manager
screen.

Now we?ll talk just a bit about some special tags used within macros. There are several of these tags that perform various
operations. Some are used in standard macros and some are used to create Rig Control macros.

Reed-Solomon IDs

This idea was originally developed by Patrick Lindecker, F6CTE.

The Reed-Solomon ID (RSID) is a short 16-tone MFSK transmission which identifies the mode in use. The RSID transmission
is about 180Hz wide and lasts for just less than two seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of programs with RSID support know what
mode you are using.

For a full list of modes supported by this program look in the Program Options for Modes + IDs.

There are two ways to enable RSID:

In Program Options select Modes + Ids and check the option to show the RSID button in the transmit tool
bar. Clicking this button will transmit the RSID at the beginning of each transmission you make.

• 

Add the tag <rsid> anywhere in the text being sent. By adding this tag to a macro, the RSID will only be
sent when the macro is executed.

• 

Insert Video ID

A special feature of DM780 is the ability to send an ID string which can be read in the waterfall - for more information select
Modes from the Program Options in the main menu and tool bar. Many thanks to Dave Freese W1HKJ for the original design
and coding in fldigi.

The Video ID bandwidth is ~ 80Hz.

When you select Insert Video ID the text

<ident:YOUR-TEXT-GOES-HERE>

is added to the macro, the <ident> tag must be at the start of the macro. Replace YOUR-TEXT-GOES-HERE with the text to
be sent, for example:

Callsign: <ident:HB9DRV>• 
CQ: <ident:CQ>• 
73: <ident:73>• 

There are two special options:

Call: replaced with the callsign in the tags window, and• 
Mode: replaced with the current mode.• 

Whatever you send - keep the text short!
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Callsign

<ident:call>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

Mode

<ident:mode>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

CQ

<ident:CQ>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

73

<ident:73>G4POP de HB9DRV 73 and thanks for this QSO

Radio Control

A radio control macro contains commands sent to Ham Radio Deluxe to configure your radio, for example to set a special
filter. The text in the definition is not added to the input (TX) window. These definitions are specific to the radio you are using.

The tag {{RADIO-CONTROL must appear anywhere in the macro definition. If you have added this by mistake just remove the
lines containing the tag.

The easiest way to add entries is to use the Radio window, as you select options in the Radio window the options are sent to
Ham Radio Deluxe and the corresponding text is added to the definition (remember to press the Connect button in the Radio
window). Only add one entry per line.

Note: Lines starting with # are treated as comments and are not passed to Ham Radio Deluxe. Blank lines are ignored.

Commands

There are four command types:

Center frequency on/off,• 
Drop down (menu) buttons,• 
Normal press buttons,• 
Sliders.• 

To simplify the command parsing any spaces in the button / slider names are replaced with a tilda (~). Slider entries contain
the radio title, this is for historical reasons.

Center Frequency

center-on• 
center-on 1750• 
center-off• 

To enable the current center frequency option in the waterfall enter center-on.

Note: The center frequency option must be enabled (checked). To specify the center frequency just add the
frequency in Hz after the center-on tag, for example center-on 1750.

To undo the center frequency option and restore the previous radio frequency enter center-off.

The center-on and center-off text must be the only entry on the line. Typically you combine these options with a filter settings,
for example when enabling the center frequency option a narrow filter is selected, when undoing a normal (wide) filter is
selected.

#++
#
# {{RADIO-CONTROL
#
# For the TS-2000
#
# Set the center frequency to 1250Hz, adjust DSP filtering
# to Low = 1000Hz, High = 1400Hz.
#
#--

center-on 1300
Set slider-pos TS-2000 DSP~low~cut 11 // DSP low cut = 11
Set slider-pos TS-2000 DSP~high~cut 0 // DSP high cut = 0

Drop down-Button

When you select an entry from a drop down button it is added to the end of the definition. Existing entries for the same drop
down button are not overwritten as a drop down button can contain unrelated commands.

Press Button

When you press a button the editor first tries to replace an existing entry for this button; if there is no entry then a new entry is
added to the end of the definition.
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5 Satellite Tracking
5.1 Introduction
If you are new to satellite tracking visit http://www.amsat.org/ maintained by The Radio Amateur Satellite Corporation (AMSAT) for
excellent articles written for new satellite users.

Ham Radio Deluxe?s Satellite Tracking support would not be possible without the help of David Taylor and his open source
satellite-tracking library. After using David?s code to get started I wrote my own library, shipped as a DLL with Ham Radio Deluxe and
based on NORAD SGP4/SDP4 Implementations by Michael F. Henry.

Note: The most important rule: it's the frequency on the satellite that is important, not the frequency on your radio. This is the most
common mistake made when using a satellite.

If you are using two radios for satellite tracking ? one for transmit, the other for receive ? read this section first, then refer to
Synchronizer on page 92. Dual radio support is arguably the most flexible way to work with satellites.

5.2 Satellites
The software requires information about the satellites you will be tracking, this information is known as Keplerian elements. Johannes
Kepler (1571 ? 1630) discovered the three laws of planetary motion in 1609 and 1619 ? a remarkable feat!

The satellites window lists the files containing the Keplerian elements used to plot the position of satellites and compute the
correct frequencies for the uplink and downlink.

The default folder is Satellites located below the folder where you have installed Ham Radio Deluxe - for example:

C:\Program Files\Amateur Radio\Ham Radio Deluxe\Satellites

To change the folder just press Select.

It is recommended that you update the data files in the Satellites folder when you start using Ham Radio Deluxe as the files
shipped in the kits will be out of date by the time you start to use them. These files should ideally be refreshed every few days.
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If you check the ?Download when Satellite Tracking starts? option then the files are downloaded every time you start satellite
tracking.

To download the latest Kepler data files press Download. The files are downloaded to the folder containing your satellite data.

To edit the list of files press Edit List. The file is Ham Radio Deluxe Satellite List.txt in the folder Satellites folder.

Example:

New satellite data files can be downloaded from the Internet, for example from http://www.amsat.org/ or from
http://www.celestrak.com/ maintained by T.S. Kelso.

The only supported file format is two-line element sets, for example:

The verbose format is not supported.

The bare NASA format elements from http://www.amsat.org/ contain all satellites of interest to radio amateurs.

Alternatively if you look at http://www.celestrak.com/NORAD/elements/ you will see many files that can be downloaded. Just
download these files and save them in the Satellites folder selected previously. For more information about the contents of
these files browse http://www.celestrak.com

All text files in the Data Folder are loaded into Ham Radio Deluxe, so you should delete old files if you no longer need them.

Select up to 100 entries from the Available list by either double-clicking on individual entries or by highlighting one or more
entries and pressing >. By pressing >> all entries (up to a maximum of 100) are moved to the Selected list.

226

http://wiki.ham-radio-deluxe.com/index.php/File:Page-225-Image-437.png
http://www.amsat.org/
http://www.celestrak.com/
http://wiki.ham-radio-deluxe.com/index.php/File:Page-225-Image-438.png
http://www.amsat.org/
http://www.celestrak.com/NORAD/elements/
http://www.celestrak.com


5.3 Observer

In the Observer window you enter your location and height above sea level in meters or feet (for users more familiar with
imperial measurements: 1 metre is 3.3 feet). You also enter an optional list of stations that are plotted on the world maps. Only
the checked [X] entries are plotted.

Enter your location either:

By entering your Maidenhead Locator in the Locator field and the pressing Convert >> or• 
By entering the Latitude and Longitude directly.• 

You also select the preferred time format; either Local (default) or UTC. Distance is displayed in either kilometers or miles.

You must press Apply to update the satellite settings.

5.4 Ground Control
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This window is used to adjust your radio's TX (uplink) and RX (downlink) frequency to compensate for the
Doppler effect (the apparent shift in frequency of a wave due to the relative motion of source and
observer). Doppler shift is calculated in accordance with Kepler's laws.

• 

Enter the satellite uplink (your TX) frequency in the Satellite TX field.• 
Enter the satellite downlink (your RX) frequency in the Satellite RX field.• 
Select the VFO you will use for TX and RX (see rest of this section).• 
If you are using a transverter select the Options tab and enter the transverter offsets.• 

When you are tuning remember that the important frequency is the satellite frequency, not the frequency on your radio. The
frequency on your radio is the satellite frequency corrected for Doppler shift.

5.4.1 Tabs

A plot of the selected satellite?s position and footprint. Use the plot offset buttons to offset the plot time.

Options

Infrequently used options are located here to avoid cluttering up the display.
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Swaps TX and RX frequencies.

Copies TX frequency to the RX.

Copies RX frequency to the TX.

Displays pass details using the default text editor, useful for programming memories in a handheld UHF/VHF transceiver.

For example:

Reloads the latest Kepler data ? see Satellites on page 129.

Doppler ? the current frequency correction.
Transverter ? if you are using a transverter enter the correct offsets here and check TX and RX as appropriate.

AMSAT.org

The satellite?s page in AMSAT.org (if available). Note: not all satellites are supported yet.
This is a useful way of getting information about satellites modes and frequencies.
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5.4.2 Kenwood TS-2000

The computer can only update both main and sub frequencies either:

In receive mode, or◊ 
In transmit mode with SAT selected.◊ 

A special solution is required when the uplink (TX) and downlink (RX) frequencies are in the same band. When you start the
TS-2000 you have an extra TX VFO option Sub+XIT which is only used for same band split operation (see below). When
selected the Sub VFO is used for transmitting, Doppler correction is applied by adjusting the XIT value.

Cross Band

In normal cross-band satellite mode (for example transmit on 70cms and receive on 2m) select:

The TS-2000 must be in satellite mode so that the computer can update the TX frequency.

Be careful with the TS-2000's TF SET button, each time you press TF-SET the uplink (TX) frequency and the downlink (RX)
frequency are swapped. So if the frequencies in Ham Radio Deluxe are the opposite of those shown on the radio just press TF
SET once.

Same Band (Split)

An example is talking to the astronauts on the ISS where the TX frequency is 145.200.000 MHz and the RX frequency is
145.800.00 MHz. You cannot use SAT mode as this is only used for cross-band operation, so you use Split mode.
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XIT will be switched on as soon as you check TX [X] updates. If you switch it off then Ham Radio Deluxe will switch it on
again.

The RX (main) frequency on the TS-2000 is set to the correct RX frequency (satellite + Doppler correction).

The TX (sub) frequency on the TS-2000 is set to the TX satellite frequency; the Doppler correction is applied by adjusting the
XIT value. When you transmit the TS-2000 displays the TX (sub) frequency +/- XIT so the frequency displayed on the
TS-2000 is the correct frequency (satellite + Doppler correction).

When you start transmitting you may hear beeps from the radio - it takes Ham Radio Deluxe a few seconds before it detects
that you are transmitting. When Ham Radio Deluxe detects transmit mode it stops updating the RX (main) frequency until you
return to receive as the frequency cannot be updated by the computer while transmitting with SAT off.

5.4.3 Yaesu

FT-847

You must select SAT mode on the FT-847 so that Ham Radio Deluxe can read and set both the TX and RX frequencies. It is
not possible to determine the state of the FT-847's SAT button so you must press the SAT button in Ham Radio Deluxe so
that it shows SAT as being enabled.

In normal cross-band satellite mode (for example transmit on 70cms and receive on 2m) select:

The FT-847 must be in satellite mode so that the computer can update the TX frequency.

When in SAT mode the FT-847 takes a long time to respond to 'Read Frequency' requests - especially if tracking is on, as a
result when you tune the FT-847 with the radio's tuning dial the displayed frequency will not update very quickly.

Other

The transmit frequency of some Yaesu radios such as the FT-817 and FT-857 cannot be changed while in transmit mode, so
it is not possible to apply Doppler correction while transmitting. If you think your Yaesu radio can be updated while transmitting
please contact the author.

5.4.4 ICOM

IC-910H

In normal cross-band satellite mode (for example transmit on 70cms and receive on 2m) select:
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The IC-910H must be in satellite mode so that the TX uses the Sub frequency. If the bands on the radio are the same as Ham
Radio Deluxe but reversed press M / S to switch the Main and Sub frequencies.

Because the IC-910H cannot display the same band on both Main and Sub Ham Radio Deluxe cannot update the frequencies
unless the correct bands are select using the radio controls.

In same-band mode:

A few notes:

The TX mode is not updated from the radio.• 
The software has to switch between Main and Sub so that the Sub VFO is updated, it is not possible to
detect the radio's current Main / Sub selection so the radio operates in main mode all the time. If you
press Sub on the radio you will see that radio switch back to Main as soon as the Sub frequency is
updated.

• 

5.4.5 Single VFO Radios

If you are using a single VFO radio such as the FT-817 then you use the same VFO for TX and RX. Use the TX (F1) button to switch
between TX and RX. When you switch to TX the transmit frequency is loaded into the radio before it switches to transmit, when you
return to receive the receive frequency is loaded into the radio after it switches to receive.

So the rule is: always use the TX (F1) button to switch between transmit and receive.

5.4.6 Linear Transponders

Check [X] the Linear Transponder Tracking option if you are using a linear transponder such as HAMSAT / VUSAT / VO-52. These
satellites receive a specific range of frequencies (typically 40 - 100 kHz) in one band, convert them to another band and amplify the
converted signal for transmission back to your planet. The converted signal is inverted - LSB becomes USB etc. - this is known as an
inverting transponder.

Do not use the satellite tracking built into your radio - let Ham Radio Deluxe do the work for you (for example on the FT-847 this is the
Tracking option). To set up the linear transponder frequencies:

As you tune your RX frequency the TX frequency will be correctly adjusted by applying [1] offsets from the center frequencies and then
[2] Doppler correction. To adjust your transmit signal so that it matches the receive frequency use the spin button to the right of the TX
center field. It will be necessary to adjust the transmit signal as your radio(s) may not be correctly aligned, also the linear transponder in
the satellite may also not be correctly aligned.

The tracking option in a radio cannot correctly compensate for Doppler, this is one reason why many QSO's drift gently across the linear
transponder's available bandwidth. Only correct computer control will ensure that two or more stations stay on the same frequency while
the satellite passes overhead. When using the linear transponder option Ham Radio Deluxe will correctly control your radio's frequencies
so that are they are both compensated for Doppler shift.
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5.4.7 Frequency Resolution

The frequency resolution is set the 1 Hz for:

All ICOM,◊ 
All Elecraft,◊ 
All FlexRadio,◊ 
All Kenwood.◊ 

All other radios are set to 10 Hz. If you have a radio that supports 1 Hz resolution and is not in the above list please contact the author.

5.4.8 Options

5.5 Schedule
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This window shows the pass schedule for the satellites selected in the Satellites window.

5.6 Current Data
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This window shows all computed information for a selected satellite. This window provides the data for the Ground Control
and DDE windows.

Press Viewer to display the data with the default text file viewer, usually Notepad.

5.7 Mutual Visibility
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The mutual visibility window answers the question 'when is a satellite simultaneously visible from two or more locations'.

The information is determined up to 99 days in the future for any stations from the list defined in the Observer page.

The satellite is considered to be visible if the elevation is the same as or greater than the selected value.

Use the Viewer option to display the data in Notepad, for example:
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5.8 Visibility
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The visibility window gives you an overview of the satellites you have selected in the Satellites window.

Select the satellites that are displayed:

All - displays all satellites,• 
Visible now - displays only the satellites which are currently visible,• 
Visible in next? - displays the satellites visible at any time in the time period you select, for example the
next 60 minutes.

• 

For each entry in this display the columns are:
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5.9 Next Passes
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This window shows up to 1,000 passes for a selected satellite. Note: do not select more than 100 passes unless you have a
very powerful computer, minimum CPU frequency of 2 GHz is recommended.

Press Alarm to add an audio alarm when a satellite is about to pass overhead. Press Plot to plot a selected pass in the Single
Pass window.

Press Viewer to display the data with the default text file viewer, usually Notepad.

5.10 Single Pass
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This window plots a single pass for the satellite selected in the Next Passes window. The elevation is plotted on the left y-axis;
time is on the x-axis. Select Azimuth, Altitude or Range to be plotted on the right y-axis.

If Popup info is checked a vertical dashed marker line is displayed which either tracks the current time or is positioned by
clicking on the chart with the left mouse button.

As the marker position changes, the azimuth, elevation, altitude and range are displayed in the marker fields.

5.11 Plot
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This window shows the position of one to four satellites above the surface of the planet.

5.12 DDE
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This window controls the DDE server. If you want to use Ham Radio Deluxe's data with another program you must start Ham
Radio Deluxe's DDE Server. Select the DDE format: currently only Nova is supported. Press Start to start the DDE server.

Main Page
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6 Rotor Control
6.1 Introduction
This program was written to provide better support in Ham Radio Deluxe and the associated satellite tracking software.

The main meatures are:

Support for NOVA and Orbitron DDE.• 
Connect to an unlimited number of rotators simultaneously.• 
Many rotator protocols supports, for example:• 
AlfaSpid,• 
EA4TX,• 
GS-232A,• 
Idiom Press,• 
Prosistel.• 
Works maps ? double-click to move the rotator.• 
Full diagnostics in the logfile.• 

Your Locator Select Options from the Tools menu and enter your locator in the Your Information pane.

6.2 Rotator Display
The same display is used for all rotators:

In the example above you see the software connected to an AMSAT IF-100 rotator which supports both azimuth and elevation
(it?s designed for tracking satellites). The world map uses the famous Blue Marble image from NASA.

6.2.1 Connecting

To connect the program to your rotator:

Make sure all cables are correctly inserted,◊ 
Start your computer,◊ 
Start this program◊ 

Select the correct rotator type from the Rotator dropdown:
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If the rotator supports more than one protocol then a Protocol dropdown is displayed, if so select the correct protocol to be
used. If in doubt consult the rotator handbook.

If a serial or parallel port is used to connect to the rotator then select the correct port from the Port dropdown.

The EA4TX/ARSWIN option communicates with EA4TX?s ARSWIN software using the DDE protocol ? ARSWIN must be
already be started.

Select the Refresh rate ? how often the rotator controller is polled for the current status. Some controllers such as the IF-100
cannot provide this information, in which case the Refresh rate dropdown is not shown.

Finally press Connect. If you experience problems look in the Logfile window.

6.2.2 Selecting a Bearing

Select a bearing by either:

Entering a callsign ? the HRD countries file is used to locate the latitude and longitude for the country.◊ 
Selecting a country from the Country dropdown.◊ 
Entering a 4- or 6-character Maidenhead locator.◊ 
Just double-clicking anywhere on the map.◊ 

Switch between short and long path bearings by pressing either Short or Long.

6.2.3 Formats

Two map formats are currently supported:

Mercator ? an aspect ratio of 2:1, and◊ 
Great Circle ? created from the Mercator image. A great circle map You can zoom the image from 100% to 1,000%.◊ 

The Great Circle map can be rotated in steps of 30 degrees. This is often desired by users in the southern hemisphere.

6.2.4 Displaying Tracks

In the Mercator map you can display the signal track and bearing at the current cursor position by selecting Show Track from the Rotator
toolbar.
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6.3 DDE Support
Supported Format

The program contains a DDE client which accepts DDE data in the Nova and Orbitron formats from external programs such as
HRD Satellite Tracking.

Before enabling DDE support:

Select either Nova or Orbitron in the DDE toolbar.• 
Make sure the Nova or Orbitron software is started.• 
Press Enable.• 

The DDE data is shown in the status bar.

You can now use the DDE data to drive the rotator ? press Track DDE in the Rotator window.

6.4 Logfile
The logfile contains all diagnostic information. For full diagnostics make sure the Full Diagnostics option is selected.
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Use the Text Viewer option to display the logfile in your default text program (usually this is Notepad) from where you can
save the logfile as a file on your hard disk.

6.5 Options
6.5.1 Appearance

Select Appearance from the Tools menu.

Skin

As you have already seen in other Ham Radio Deluxe programs you can select a skin and display theme. Select Appearance
from the Tools menu top display the Skin and Theme windows.

Image

Two images are included as resources in the executable file:

NASA?s blue marble and• 
David Taylor?s WXtrack• 

You can select an image from a file on your computer; a good site for maps is http://flatplanet.sourceforge.net/maps/ with
many great options.

Select High quality for image scaling unless you have a very low power CPU, normally CPU usage will not be a big problem.
The quality is noticeable when zooming.

Select Options from the Tools menu or press the Options toolbar button to display the general options:

6.5.2 General

Select Options from the Tools menu or press the Options button in the main toolbar.
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Your Information

You must enter your locator in this window so that the program can correctly compute bearings.

Parallel Ports

Use this window to configure your parallel ports if you are using and older rotator controller with a parallel port connection.

Main Page

248

http://wiki.ham-radio-deluxe.com/index.php/File:Page-245-Image-469.png
http://wiki.ham-radio-deluxe.com/index.php/File:Page-245-Image-470.png
http://wiki.ham-radio-deluxe.com/index.php/Main_Page

